LYRRUS INCORPORATED
PROGRAM LIMITED USE LICENSE AGREEMENT

YOU SHOULD CAREFULLY READ THE FOLLOWING TERMS AND CONDITIONS BEFORE INSTALLING
THE ENCLOSED SOFTWARE. INSTALLING THE SOFTWARE INDICATES YOUR ACCEPTANCE OF THESE
TERMS AND CONDITIONS. IF YOU DO NOT AGREE WITH THEM, YOU SHOULD PROMPTLY RETURN
THE SOFTWARE UN-INSTALLED, AND YOUR MONEY WILL BE REFUNDED.

LICENSE
Lyrrus Incorporated has developed and provides the computer software program contained on this CD-ROM (the
'Program') and licenses its use. You assume responsibility for the selection of the Program to achieve your intended results,
and for the installation, use and results obtained from the Program.

a. Permissible Uses
(i) Lyrrus Incorporated hereby grants you a personal, non-transferable and non-exclusive right and license to use the
Program under the terms stated in this Agreement. Title and ownership of the Program and the related documentation
remain in Lyrrus Incorporated.
(ii) You may use the Program only on a single CPU.
(iii) You may not transfer or assign the Program or this license to any other person without the prior written consent of
Lyrrus Incorporated.
(iv) You acknowledge that you are receiving only a LIMITED LICENSE to use the Program and related documentation
and that Lyrrus Incorporated retains title to the Program and documentation. You further acknowledge that Lyrrus
Incorporated has a valuable proprietary interest in the Program and documentation.

b. Restrictions
(i) You may not use, copy, reproduce, modify, alter, or transfer the Program or any copy or merged portion, in whole or
in part, except as expressly provided in this license. (You may make a single copy of the Program for archival backup
purposes in support of your use of the Program on the single machine.)
(ii) You acknowledge that the program contains trade secrets of Lyrrus Incorporated. In order to protect such trade
secrets, you may not decompile, reverse engineer, disassemble or otherwise reduce the Program to a human perceivable
form. You may not modify, adapt, translate, rent, lease, loan, resell for profit, distribute, network, or create derivative
works based on all or any part of the program or documentation.
(iii) You and your employees and agents are required to protect the confidentiality of the Program. You may not
electronically transfer the Program or accompanying documentation from one computer to another over a network. You
may not distribute or otherwise make the Program or documentation available to any third party, by time sharing or
otherwise, without the prior written consent of Lyrrus Incorporated.
(iv) IF YOU USE, COPY, REPRODUCE, MODIFY, ALTER, OR TRANSFER POSSESSION OF THE PROGRAM
OR ANY COPY OR MERGED PORTION, IN WHOLE OR IN PART, EXCEPT AS EXPRESSLY PROVIDED IN
THIS LICENSE, YOUR LICENSE WILL THEREBY TERMINATE AUTOMATICALLY.

TERM
The license is effective until terminated. You may terminate the license at any time by destroying the Program and related
documentation, together with all copies thereof. This license will also terminate immediately if you fail to comply with
any term or condition contained herein. Upon such termination, you agree to return to Lyrrus Incorporated, at your own
expense, the Program and related documentation, together with all copies and merged portions of the Program or related documentation in any form.

EXPORT
You acknowledge that the laws and regulations of the United States may restrict the export and reexport of the Program.
You agree that you will not export or reexport the Program or related documentation in any form without prior written
consent of Lyrrus Incorporated and appropriate United States and foreign government approval.
# Table of Contents

1. Introducing Master Tracks Pro ......................................................... 1
   Basic things you should know to use Master Tracks Pro .................... 3
      Mouse and keyboard ........................................................................ 3
      Text editing .................................................................................... 3
      Parameter editing ........................................................................... 3
      Menu and dialog ............................................................................. 4
      Master Tracks Pro techniques ....................................................... 4
         Changing tracks in an edit window .............................................. 4
         Rhythmic value scroll boxes ...................................................... 4
      Tools, pointers, and the cursor ...................................................... 5
      Parameter boxes: text and numeric ............................................... 6
   About the Master Tracks Pro manual .............................................. 7
      Chapter 1: Introducing Master Tracks Pro ................................. 7
      Chapter 2: Getting to Know Master Tracks Pro ......................... 7
      Chapter 3: Basic File Operations ............................................... 7
      Chapter 4: Recording .................................................................. 8
      Chapter 5: Playback and Track Setup ........................................ 8
      Chapter 6: Synchronization ......................................................... 8
      Chapter 8: Viewing and Selecting Information in Master Tracks Pro 8
      Chapter 8: Basic Editing ............................................................. 8
      Chapter 9: Advanced Editing ...................................................... 8
      Chapter 10: Menu and Window Reference .................................. 9
   Appendix A: Keyboard Shortcuts ................................................... 9
   Appendix B: Standard MIDI Controllers ....................................... 9
   Appendix C: Passing Filenames on the Command Line .................. 9
   Appendix D: Using MCI ................................................................. 9
   Conventions used in the Master Tracks Pro manual ....................... 10
      Procedures .................................................................................. 10
      Notes, tips, and cross-references .............................................. 10
      What is {#}? .............................................................................. 11
   How it works .................................................................................. 13
2. Getting to Know Master Tracks Pro .............................................. 13
The user interface .................................................................................. 14
Opening and Working with Windows ..................................................... 15
Common window features ...................................................................... 16
The data area ........................................................................................... 17
The Measure Ruler .................................................................................. 17
The Marker Ruler ................................................................................... 18
Control Bar .............................................................................................. 18
Follow Playback ..................................................................................... 20
The Track Editor ........................................................................................ 20
The Track Sheet ....................................................................................... 22
Track Number (Tk) .................................................................................. 22
Play-Enable (P)] ..................................................................................... 23
Record-Enable (R) ................................................................................... 23
Solo (S) .................................................................................................... 23
Loop (L) .................................................................................................... 23
Name ....................................................................................................... 23
Channel (Chnl) ....................................................................................... 24
Program Name (Prg) .............................................................................. 24
Controller (Cntlr) .................................................................................... 24
Value (Val) .............................................................................................. 25
The Song Editor ....................................................................................... 26
Piano Roll Editor ..................................................................................... 27
The note display ....................................................................................... 29
Notation Editor ....................................................................................... 29
Event Editor ............................................................................................. 31
Event data area ......................................................................................... 33
The MIDI Data windows .......................................................................... 34
Display modes .......................................................................................... 35
The Tempo Map ....................................................................................... 36
Working with the Menus .......................................................................... 36
Basic Transport Functions:
the Transport window and Remote Control Setup .................................. 38
Measure Counter ..................................................................................... 39
Locating with the Goto dialog ................................................................. 39
Current Time Indicator ........................................................................... 40
Edit/Punch Point indicators .................................................................... 40
The Big Counter ....................................................................................... 40
Transport Functions ................................................................................ 41
The Transport Controls ............................................................................ 42
  Head (Home) .................................................................................... 42
  Rewind (Left Arrow) ......................................................................... 42
  Stop (Spacebar) ................................................................................. 42
  Pause ................................................................................................. 42
  Play (Spacebar) .................................................................................. 42
  Fast Forward (Right Arrow) .............................................................. 43
  Tail (End) .......................................................................................... 43
  Record (Enter) .................................................................................. 43
  Auto Rewind (""," ) ............................................................................. 43
Remote Control........................................................................................... 44
The Conductor window ................................................................................. 46
The Master Fader ........................................................................................... 47
Important dialog boxes in Master Tracks Pro ................................................. 48
Viewing Information in Master Tracks Pro ..................................................... 49
  Current play/record location: ............................................................ 49
  Current pointer position: ................................................................. 49
  Current edit/punch points: ............................................................... 49
  Current meter, tempo, and beat value: .............................................. 49
  Track currently being edited: ............................................................. 49
  Track name: ...................................................................................... 50
  Marker locations and names: ............................................................. 50
  Current Master Volume value: .......................................................... 50
  Available memory:............................................................................. 50
  Current Port/Driver assignments....................................................... 50

3. Basic File Operations ................................................................. 51
  About Master Tracks Pro Files .......................................................... 52
  Starting a new file ................................................................................. 52
  Opening an existing file ........................................................................ 53
  Closing files .......................................................................................... 54
  Saving files ........................................................................................... 55
    Using the Save As Command ............................................................ 55
    Using the Revert to Saved Command .................................................. 56
  Using Multiple Songs ........................................................................... 57
  Using MIDI Files .................................................................................. 58
  Customizing the Program with Preferences ............................................. 60
The Preferences command ................................................................. 60
What is saved in the Preferences file ...................................................... 60
Printing from the Notation Editor .............................................................. 61
Setting up to print notation .................................................................... 62
Starting printing ...................................................................................... 63
Exit ........................................................................................................ 64
About Master Tracks ............................................................................. 64

4. Recording ................................................................................................. 65
    Setting up to record ................................................................................ 66
    Monitoring (Keyboard Thru) ................................................................. 66
    Setting Meter (Time Signature) and Tempo ........................................... 68
    The Conductor Window ...................................................................... 69
    Click (metronome) .............................................................................. 71
    Activating a countoff (Count) ............................................................... 75
    Recording waits for a MIDI note (Key Wait) ........................................ 75
    Filtering MIDI Data and quantizing while recording (Record Filter) .... 76
    Checking available memory: the Memory window .............................. 78
    Dealing with a memory shortage ....................................................... 80
    Basic Recording Procedure ................................................................ 80
    Enabling a track for recording ............................................................ 81
    Multi Track Record ............................................................................ 82
        Using Multi Track Record with a guitar controller ....................... 83
    Setting the location to start recording ................................................. 83
    Start recording .................................................................................. 84
    Stopping recording ............................................................................ 85
    Pausing recording ............................................................................. 86
    Retakes ......................................................................................... 86
    Making temporary tempo changes while recording (Offset tempos) ... 87
    Naming tracks .................................................................................. 88
    Overdubbing and recording controllers .............................................. 89
    Selective monitoring: Play-enabling and muting tracks ..................... 89
    Recording or overdubbing Volume and other controllers .................. 90
        Should controllers be on the same track as notes? ....................... 90
    The Recordable Controller Faders ..................................................... 92
        Recording the faders .................................................................... 94
    Multi Track Fader Record .................................................................. 95
    Fader Tips: ..................................................................................... 95
Editing in the Event Editor ................................................................. 235
  Moving through the Event Editor ..................................................... 236
Inserting, deleting, and editing program changes .............................. 239
  Inserting program changes .............................................................. 239
  Deleting program changes .............................................................. 241
  Editing program changes ................................................................ 241
Notepad .................................................................................................. 242
Using the Change Menu to modify data ............................................. 245

9. Advanced Editing ........................................................................... 245
  Using the Change Filter ................................................................. 247
  Quantize ............................................................................................ 247
    Quantizing entire notes or note attacks only ................................. 249
    Setting the Quantization Value ..................................................... 249
    Including notes ahead of and behind the beat .............................. 250
    Setting quantization intensity ....................................................... 251
    Swing ............................................................................................. 251
    Sliding Notes .................................................................................. 253
  Humanize .......................................................................................... 253
  A Quantize/Humanize example ....................................................... 255
  Duration ............................................................................................. 255
  Transpose ........................................................................................ 257
  Channel ............................................................................................. 260
  Velocity ............................................................................................. 260
  Pitch Bend Range ............................................................................. 264
  Thin Notes ........................................................................................ 265
Editing Meter and Tempo ................................................................. 266
  Working with the Tempo Map .......................................................... 267
  The Conductor dialog ...................................................................... 269
  Fit Time ............................................................................................ 276
    Using the Fit Time command ......................................................... 277
  Scale Time ........................................................................................ 278
The MIDI Data windows and controller editing .................................. 280
  The MIDI Data windows ................................................................. 280
  Entering MIDI data in a MIDI Data window .................................... 282
  Changing and Erasing data ............................................................. 283
  Data density and the Zoom Factor .................................................. 283
The Windows ........................................................................................ 284
  The Pitch Bend window ................................................................. 285
  The Channel Pressure window ..................................................... 285
  The Key Pressure window ............................................................ 285
  The Modulation window ............................................................... 286
  The Controllers window ............................................................... 286
  The Tempo Map Window ............................................................. 287
The Thin Continuous Data command .................................................. 288
  Selection criteria for thinning ........................................................ 289
The Continuous command ................................................................ 291
  Changing controller data values ...................................................... 293
  Mapping one controller to another ................................................ 294
The Slide Data command .................................................................. 295
The Strip Data command .................................................................. 296
Using Strip Data .............................................................................. 299

10. Menu and Window Reference ..................................................... 301
Menus ...................................................................................................... 301
  File .................................................................................................... 301
    New ................................................................................................. 301
    Open .............................................................................................. 301
    Close .............................................................................................. 301
    Close All ....................................................................................... 301
    Save ............................................................................................... 302
    Save As .......................................................................................... 302
    Revert to saved ............................................................................. 302
    Preferences .................................................................................... 302
    Notation Print Setup ...................................................................... 303
    Print Notation .............................................................................. 303
    About Master Tracks ..................................................................... 303
    Exit ............................................................................................... 303
Edit ........................................................................................................... 304
  Undo ................................................................................................. 304
  Cut ................................................................................................. 304
  Copy .............................................................................................. 304
  Paste ............................................................................................. 304
  Clear (Delete) ............................................................................... 304
  Mix Data ........................................................................................ 304
Insert Measure ................................................................. 305
Delete Measure ................................................................. 305
Select All .............................................................................. 305
Change Filter ........................................................................ 305
Erase Clipboard .................................................................... 305

Change .................................................................................. 306
Channel ................................................................................. 306
Duration ............................................................................... 306
Velocity ................................................................................. 306
Continuous .......................................................................... 306
Pitch Bend .............................................................................. 306
Conductor .............................................................................. 307
Strip Data ............................................................................. 307
Thin Continuous Data ......................................................... 307
Thin Notes ............................................................................ 307
Transpose .............................................................................. 307
Humanize .............................................................................. 307
Quantize ................................................................................ 308
Slide Data ............................................................................. 308
Fit Time ................................................................................ 308
Scale Time ............................................................................ 308
Key Signature ......................................................................... 308

Windows ................................................................................... 309
Track Editor (F1) ................................................................. 309
Notation Editor (F2) ............................................................ 309
Piano Roll Editor (F3) .......................................................... 309
Event Editor (F4) ................................................................. 309
Master Fader (F5) ............................................................... 309
Pitch Bend (F6) ................................................................. 309
Channel Pressure (F7) .......................................................... 309
Key Pressure (F8) ............................................................... 309
Modulation (F9) ................................................................. 309
Controllers (F11) ............................................................... 309
Velocity (F12) ................................................................. 309
Tempo Map ......................................................................... 309
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Songs</td>
<td>310</td>
</tr>
<tr>
<td>Song Play List</td>
<td>310</td>
</tr>
<tr>
<td>Open Song Set</td>
<td>310</td>
</tr>
<tr>
<td>Save Song Set</td>
<td>310</td>
</tr>
<tr>
<td>Select open sequence</td>
<td>310</td>
</tr>
<tr>
<td>Layout</td>
<td>311</td>
</tr>
<tr>
<td>Show/Hide Grid</td>
<td>311</td>
</tr>
<tr>
<td>Show/Hide Markers</td>
<td>311</td>
</tr>
<tr>
<td>Show/Hide Device Names</td>
<td>311</td>
</tr>
<tr>
<td>Show/Hide Velocity</td>
<td>311</td>
</tr>
<tr>
<td>Show/Hide Program Changes</td>
<td>311</td>
</tr>
<tr>
<td>Zoom In (+)</td>
<td>312</td>
</tr>
<tr>
<td>Zoom Out (-)</td>
<td>312</td>
</tr>
<tr>
<td>Options</td>
<td>313</td>
</tr>
<tr>
<td>Follow Playback</td>
<td>313</td>
</tr>
<tr>
<td>Multi Track Record</td>
<td>313</td>
</tr>
<tr>
<td>Key Wait</td>
<td>313</td>
</tr>
<tr>
<td>Punch In</td>
<td>313</td>
</tr>
<tr>
<td>Auto Rewind</td>
<td>313</td>
</tr>
<tr>
<td>Click (Metronome)</td>
<td>313</td>
</tr>
<tr>
<td>Count</td>
<td>314</td>
</tr>
<tr>
<td>Thru</td>
<td>314</td>
</tr>
<tr>
<td>Play MCI</td>
<td>314</td>
</tr>
<tr>
<td>MCI Close All on Stop</td>
<td>314</td>
</tr>
<tr>
<td>Setup</td>
<td>315</td>
</tr>
<tr>
<td>Sysex</td>
<td>315</td>
</tr>
<tr>
<td>Remote</td>
<td>315</td>
</tr>
<tr>
<td>MIDI Setup</td>
<td>315</td>
</tr>
<tr>
<td>Sync Setup</td>
<td>317</td>
</tr>
<tr>
<td>Click Setup</td>
<td>318</td>
</tr>
<tr>
<td>Thru Setup</td>
<td>319</td>
</tr>
<tr>
<td>Chase Controllers</td>
<td>319</td>
</tr>
<tr>
<td>Record Filter</td>
<td>319</td>
</tr>
<tr>
<td>Punch Setup</td>
<td>319</td>
</tr>
<tr>
<td>Info</td>
<td>320</td>
</tr>
<tr>
<td>Memory</td>
<td>320</td>
</tr>
<tr>
<td>Markers</td>
<td>320</td>
</tr>
<tr>
<td>Notepad</td>
<td>320</td>
</tr>
</tbody>
</table>
Master Tracks Pro is the newest in Passport Designs’ line of MIDI sequencing programs for Windows. It continues in the tradition of Master Tracks Pro, the best-selling and highly acclaimed sequencer first introduced in 1987, but adds new features and flexibility for today’s MIDI artist. Master Tracks Pro is a versatile 64-track MIDI sequencer, with advanced recording, editing, performance, and synchronization capabilities, and is as at home in a small home studio as it is in a state-of-the-art audio/video post-production facility.
Master Tracks Pro lets you take an open-ended approach to composing. It gives you up to 64 separate MIDI tracks, each one of which can address any of the 16 MIDI channels. The program can address up to 16 output ports on your computer separately, giving you the ability to use 256 discrete MIDI channels (using multiple MIDI interfaces). With a MIDI keyboard, MIDI guitar, wind controller, or other electronic instrument, you can record musical data in real time, at any tempo you wish, slow or fast, even one note at a time. Music can also be entered using your computer’s mouse and keyboard, while viewing it graphically, as music notation, or as alphanumerical lists. Master Tracks Pro can even print music notation.

Your music can be edited and played back as quickly and flexibly as editing text in a word processor. Individual events, portions of tracks, or entire tracks can easily be duplicated, combined, modified, or rearranged using highly intuitive graphic tools, to build complete compositions. Recording and playback can be synchronized to time code from film, video, or multitrack audio tape for audio or video post-production work, including not only music composition, but sound effects editing as well. In addition, useful utilities, such as a System Exclusive bulk dump feature and keyboard control mapping for controlling Master Tracks Pro’s functions from your MIDI controller are included in the program.
Introducing Master Tracks Pro

Basic things you should know to use Master Tracks Pro

Master Tracks Pro uses many of the standard conventions of the Windows environment. There are also a few techniques used in Master Tracks Pro that are extensions on some of the basic Windows ideas. You should be familiar with the terms and techniques listed here before using Master Tracks Pro. If any of this is unfamiliar, refer to your Windows documentation.

Mouse and keyboard

- click
- double-click
- drag
- shift-click, option-click, etc.
- hold and press (Ctrl+P, Alt+S, etc.)
- click-hold
- keyboard equivalents for executing commands

Text editing

- placing the insertion point
- I-beam pointer
- selecting text (character, word, etc.)
- cut/copy/paste
- basic text editing (insert, delete)

Parameter editing

- radio buttons, check boxes, scroll bars
- typing in values
- using the Tab and/or arrow keys to move between parameters
- parameter fields: the various boxes for parameter entry that may be contained in a single dialog or window
Menu and dialog

- using key equivalents to drop down menus and choose commands
- file open/save
- OK/Cancel buttons
- confirmation dialogs ("Are you sure?")
- pressing the Enter key to accept the default selection (especially OK)
- pressing the Enter key to complete an entry and accept the values shown

Master Tracks Pro techniques

In addition to these standard Windows techniques, the following Master Tracks Pro techniques are used throughout the program.

Changing tracks in an edit window

Master Tracks Pro has several different edit windows that display a track’s worth of data in different ways. Each of these windows allows you to select which track is displayed.

- Click on the "Track = " button in the Control Bar and select the desired track. [Chapter 8, Viewing & Selecting Data for Editing, "Viewing Different Tracks"]

Rhythmic value scroll boxes

A number of Master Tracks Pro functions require the selection of a rhythmic value. By "rhythmic value", we refer to the notation-related duration of a note, i.e. whole note, half note, quarter note, etc. (Note that is possible in Master Tracks Pro for the actual
duration sounded for a note to be different than its representation in notation, as in the case of a staccato note.)

Master Tracks Pro's rhythmic value scroll boxes display the notational representation (or "icon", if you will) of a note, that is, it shows a quarter note as it would appear in a score, not as a number. The desired value is selected using the box's scroll bar to change the displayed rhythmic value until the desired one is shown. In many cases, a box to the left of the rhythmic value scroll box will show the numerical equivalent of the note in Master Tracks Pro clocks.

![Rhythmic Value Scroll Boxes](image)

**Tools, pointers, and the cursor**

As with Windows draw programs and many other graphically-oriented programs, Master Tracks Pro enables you to perform many operations in windows by redefining the function of a mouse action. This is usually done by clicking on an icon in the Control Bar to select a different mode. The most common icons are the pencil (inserting events), eraser (deleting events), and arrow (for selecting events).

![Tool Icons](image)

To make it clear which mode you are in at any time, clicking one of these icons changes the appearance of the cursor when you move
it into the data area of a window. The word "pointer" is used more or less interchangeably with "cursor" to indicate when the cursor has a particular appearance.

Parameter boxes: text and numeric

Setting parameters in Master Tracks Pro is most often accomplished by entering values into the designated box. Often, a function is enabled with a check box or radio button, and applicable parameters are entered in boxes just to the right of the check box/radio button and accompanying legend.

Some parameter boxes accept text, which can be edited using all the standard methods. Others accept only numbers within a specified range. A few can accept entries in any of several forms, for example, many pitch parameters allow entry of a pitch as a letter followed by the octave number or as a MIDI note number.

[Pitches from C-2 to G8]
About the Master Tracks Pro manual

The chapters of this manual fall into three main sections: introductory, a user's guide, and reference information.

The task-oriented organization of the Master Tracks Pro will usually lead you in a logical progression through the information you need for most typical uses. However, don’t forget that the Table of Contents and Index can be used to find information on specific items or topics.

The introductory chapters orient you to Master Tracks Pro: what it can do, and how it is structured.

Chapter 1: Introducing Master Tracks Pro

Summarizes Master Tracks Pro’s capabilities, required skills standard to Windows, skills particular to Master Tracks Pro, and use of the manual.

Chapter 2: Getting to Know Master Tracks Pro

An overview which discusses the basic way of viewing and using Master Tracks Pro, and describes the function of each window and its important features.

The bulk of the manual is a user’s guide, which is task-oriented. This means that these chapters have been organized according to the way you are likely to work and the operations you will want to perform, rather than by describing each window and menu. Most of your use of the Master Tracks Pro manual will be in these chapters.

Chapter 3: Basic File Operations

Discusses opening, closing, and saving files, using multiple files (Songs), configuring and saving Preferences.
Chapter 4: Recording

Details the procedures for setting up to record (meter, click, countoff, record-enable, etc.) and recording, including punch-in and fader recording.

Chapter 5: Playback and Track Setup

Discusses setting track parameters in the Track Sheet portion of the Track Editor, including program names, methods of playing back some or all of a song, markers, and Song Play Lists.

Chapter 6: Synchronization

This chapter covers the use of Master Tracks Pro in systems that use MIDI sync or MIDI Time Code to synchronize devices.

Chapter 8: Viewing and Selecting Information in Master Tracks Pro

Describes the many ways Master Tracks Pro lets you look at data in its various windows, and how to select data for editing.

Chapter 8: Basic Editing

Discusses fundamental features like Undo, Cut/Copy/Paste, inserting and deleting measures and notes, editing individual notes and so forth, detailing the particulars of how these work in Master Tracks Pro.

Chapter 9: Advanced Editing

The heart of Master Tracks Pro is its advanced editing capabilities, which are discussed in this chapter. Change menu commands, including Quantize and Transpose, meter and tempo editing, including the Tempo Map and the Conductor command, and the MIDI Data windows and controller editing are all discussed.
The Reference chapter provides extremely brief descriptions of each window and menu command in Master Tracks Pro, along with cross-references to more detailed discussions. Use this when you need to quickly find out about a specific command or window function.

The Appendixes give important additional information that is too specific to fit appropriately in the User’s Guide or Reference section.

Chapter 10: Menu and Window Reference

Gives short description of each command on each menu and each window in Master Tracks Pro, along with cross-references to the detailed discussions in the User’s Guide.

Appendix A: Keyboard Shortcuts

Lists the keyboard equivalents available for Master Tracks Pro commands.

Appendix B: Standard MIDI Controllers

A list of standard function assignments for MIDI Continuous Controllers.

Appendix C: Passing Filenames on the Command Line

Describes how to pass data file name to Master Tracks Pro on the DOS command line.

Appendix D: Using MCI

This chapter explains Master Tracks Pro's ability to use the Windows Media Control Interface.
Conventions used in the Master Tracks Pro manual

Procedures

Step-by-step procedures are given throughout this manual in a "bullet list" form like this:

• First do this

• Then do this

• Finally do this

Sometimes there may be more than one way to accomplish a step. This is indicated as follows:

• First do this

• Then do this

OR

• do that

Notes, tips, and cross-references

To make it as easy as possible to absorb the Master Tracks Pro manual and find information that you need, sometimes pieces of information are separated out from the main body of the text.

Notes are important information that should not be ignored! Sometimes these are warnings, other times qualifying statements or explanations of a crucial nature.

Tips
Tips give useful hints about ways to use Master Tracks Pro features to accomplish common tasks.
In a manual of this size, it is important to give cross-references to make it easy to find all of the information on a given topic. Cross-references are used liberally in this manual and appear with the chapter number and name, followed by the section in the chapter, like this:

[Chapter X, Cross-Referencing,"Where Is It?"]

What is {#}?

Sometimes in the manual it is necessary to refer to a legend onscreen which has a parameter box in the middle of it. The symbology "{#}" simply indicates "a box to be filled in with the appropriate number".
Getting to Know Master Tracks Pro

How it works

On the most basic level, Master Tracks Pro is similar to a fancy multitrack tape recorder. Like a tape machine, Master Tracks Pro enables you to record one or more tracks of music at a time, listen to previously-recorded tracks as you overdub new ones, and play all of the recorded tracks back as an ensemble. But, unlike a tape recorder, you can edit individual events on each track to make changes or fix mistakes. In addition, because you are recording MIDI data and not actual sound, you can change a piece’s tempo without changing its pitch, or change the instrumentation of a track without changing its notes, which would be impossible on a tape deck. With 64 tracks available, Master Tracks Pro provides much greater flexibility than most tape machines.

Master Tracks Pro uses dynamically-allocated tracks. This means that the various tracks in a given musical piece can be of any length, and that length is alterable. This is particularly useful in building compositions out of looped (repeating) tracks, because it allows each loop to be a different length.

Master Tracks Pro allows you to alter discrete portions of a track or tracks after you’ve made a recording. This is similar to the ability to mark and alter a block of text in a word processor. Regional selections are made in Master Tracks Pro the same way they are in most other Windows programs: by pointing, dragging, clicking, shift-clicking, etc. After selecting a block of musical data, you then have a wide variety of editing functions to choose from.
In addition to editing individual notes and regions, tracks as a whole can be edited. And they can be mixed together with other tracks in a variety of ways to form compositions of various lengths, even very long pieces. Sections of songs can easily be moved between one song and another, allowing you to create new compositions based on a number of existing pieces.

Last, but certainly not least, you can view, edit, and print out each track as traditional music notation. If you use a sequencer for writing compositions that will be performed by live musicians, this makes it simple to work out the whole piece and then print out parts for the performers.

Master Tracks Pro can record, display, and edit the entire range of MIDI pitches, from C–2 (read $C_{minus 2}$) to G8. Middle C is C3.

The user interface

Master Tracks Pro follows the typical conventions for using your computer’s keyboard and mouse to control Windows programs. If you have used Windows even a little and know your way around a few other Windows programs, you’ll be able to learn Master Tracks Pro easily and quickly.

Master Tracks Pro’s many program functions and commands are organized logically into a number of different windows and menus where you work with your songs. In general, large sections of a song can easily be edited, measure by measure, in the Track Editor, while edits to a resolution of less than a measure can be made in the Piano Roll, Notation, or Event Editors.

The MIDI Data windows enable you to edit MIDI data other than notes, such as pitch bend, controllers, and tempo.

Basic editing functions (cut/copy/paste, insert/delete, etc.) are performed directly in the Editors and MIDI Data windows, while more sophisticated editing can be performed in the dialogs opened by the Change menu commands.
Opening and Working with Windows

Master Tracks Pro lets you have several windows on the screen at the same time, but only the front-most window will be active. Selecting a window from the Windows menu immediately makes it the active window, whether or not it was previously open. A window that is already open can be made active by pointing anywhere in it and clicking the mouse. You can move windows around to convenient locations on the screen, and size them according to your preferences.

When Master Tracks Pro is started up for the first time, the Track Editor, Transport and Conductor windows will appear. If you find a particular arrangement of windows useful, you can save that arrangement as the default arrangement at startup.

To customize the appearance of Master Tracks Pro at startup:

• Open, size, and place the windows you would like to see at startup as desired.

• Choose the "Preferences" command from the File menu and click "Yes" in the confirmation dialog that appears.

To open any of the Editor or MIDI Data windows:

• Choose the desired window from the Windows menu. When the window opens, it will appear at the same size and position as when it was last opened.

OR

• Use one of the keyboard shortcuts listed on the Windows menu.

The Piano Roll and Notation Editors can also be opened directly from the Track Editor. When a window is open, a check mark appears next to its name in the Windows menu.
To open the Piano Roll Editor from the Track Editor:

- Double-click in the Track Editor on the track and measure you wish to edit. The Piano Roll Editor will open at that measure.

To open the Notation Editor from the Track Editor:

- Hold down the Ctrl key and double-click in the Track Editor on the track and measure you wish to edit. The Notation Editor will open at that measure.

To open the Transport or Conductor windows:

- Choose the desired window from the Info menu.

In fact, the Transport window cannot be closed, but it may become hidden from view by other windows. Selecting it from the Info menu brings it to the front and makes it the active window.

Common window features

Each window offers its own set of features, but there are a number of items which appear in most or all of the Editors and MIDI Data windows.
Every Editor and MIDI Data window has some portion of the window devoted to control functions. The main area of the window, however, is called the **data area**. The data area is located below the Measure Ruler and Control Bar. In the Editors (except the Event Editor) and MIDI Data windows, the horizontal axis represents time. The vertical axis may represent tracks (in the Track Editor), pitch (in the Notation and Piano Roll Editors), or values (in the MIDI Data windows), depending on the window. The Event Editor is a chronological list, hence time is along the vertical axis and there is no horizontal axis.

**The Measure Ruler**

Along the top of all of the Editors (except the Event Editor) and MIDI Data windows is a set of markings showing the measure locations in the song. This is called the **Measure Ruler**. The Measure Ruler lets you see at all times where you are working in the song. Additionally, the Measure Ruler enables you to:

- Click over a specific measure in the Measure Ruler to select the entire measure in the track. In the Track Editor Measure Ruler this selects a measure across all 64 tracks and the Tempo Map.

- Drag over a group of measures in the Measure Ruler to select them.

The Track Editor’s Measure Ruler numbers every fourth measure by default (4, 8, 12, 16, etc.), with short vertical marks appearing for other measures.

To change the numbering scheme on the Measure Ruler:

- Press "0" or any of the number keys from 3 through 9 on your computer’s keyboard. The number you press will become the multiple of the bars that are numbered. For instance, pressing 3 numbers measures 3, 6, 9, etc.; pressing 5 numbers measures 5,
10, 15, etc., and so on. Pressing 0 numbers every 10th measure. The measure-numbering scheme is not saved with the song; but it is saved in the Preferences file. [Chapter 3: Basic File Operations, “Customizing the program with Preferences”]

**The Marker Ruler**

Just above the Measure Ruler you will see a small button with a yellow triangle pointing right. This is called the Marker Well and the area above the Measure Ruler is the Marker Ruler. Markers may be placed in a song for purposes of locating or simply to indicate a point of some significance. For more information on using markers, see [Chapter 5: Playback and Track Setup, "Markers"]

- Click on the Marker Well and drag to any location in the Marker Ruler to place a marker there.

**Control Bar**

Perhaps the most significant common item in the Editors (except the Track Editor) and MIDI Data windows is the strip along the top of the window known as the **Control Bar**. The Control Bar displays important information and contains buttons that perform very basic functions like selecting the active track or editing mode. The Control Bar varies somewhat from window to window, but many functions are available on the Control Bar in most or all windows. Here are the most common functions found in the Control Bar:

![Control Bar Diagram]
• The **Track Number** button ("Track = {#}") indicates which track is currently being displayed and edited in the window. Click on this button to see and work on a different track.

• The **Track Name** button displays the name given to the track currently being displayed in the window. Click on this button to rename the track.

• The **Current Position Indicator**, found in all of the Control Bars except the Event Editor’s, displays the exact current position of the pointer when it is in the data area of the window. As the mouse is moved, this indicator is constantly updated. The resolution to which it displays the current position depends on the zoom level [Chapter 7: Viewing & Selecting Data for Editing, "Zoom In and Zoom Out"], but, when zoomed in, it is capable of displaying the position down to the clock, making it the best method of precise placement or selection.

• The **MIDI Channel** button found in most Control Bars, shows the channel currently selected for inserting events. Click on this button to choose a different channel for new events you insert.

  *Note: The setting of the MIDI Channel button is independent of, and overridden during playback by, the Channel setting in the Track Sheet portion of the Track Editor.*

• The **tool palette** found in all of the Control Bars except the Event Editor’s, consists of three buttons that set the editing mode of the pointer. The **eraser** allows events to be deleted, the **pencil** allows events to be inserted, and the **arrow** allows events to be selected.

  One of these tools is always in effect, but they are mutually exclusive; that is, only one can be active at a time. Click on the tool you want to use to make it active.

• Many Control Bars also contain buttons for setting various **note parameters**, such as note-on and note-off velocity, note rhythmic value (including setting tuplets), etc.
Follow Playback

The "Follow Playback" command sets all the Editors (except the Event Editor) and MIDI Data windows to follow the Measure Counter when Master Tracks Pro is recording or playing back. When playback (or recording) is initiated, open Editor and MIDI Data windows will automatically scroll so that the measure currently being played is always visible and highlighted in the Measure Ruler. (In the Track Editor, the measure currently playing is also highlighted in the data area.)

To enable open windows to follow playback:

• Choose the "Follow Playback" command in the Options menu.

The Track Editor

The Track Editor allows you to see and name all the tracks in your song. The left half of this window is called the Track Sheet.

In the Track Sheet you can:

• Choose tracks to play or record.

• Solo one or more tracks for listening.

• Set tracks to loop.

• Make MIDI port and output channel assignments for each track.

• Choose a name and initial MIDI program number for each track.

• Set an initial volume or other controller value for each track.

• Record MIDI continuous controller moves into each track.

• See the current value of the track Volume Settings
In the right half of the window, called the **Song Editor**, you can:

- See a graphic display of the song in units of measures, with a grey bar showing where the end of the song falls.

- Insert and delete measures.

- Select regions for editing or changing on a single track or group of tracks on a measure-by-measure basis.

- Place and display markers that allow you to quickly find specific locations in a song.

- Move sections of music within a song or build new songs from segments of other songs.

- Modify the data in a variety of ways using the commands in the Edit and Change menus.
The Track Sheet

The basic operation of the Track Sheet is simple. To change any item in the window, just click in its box. For settings that are either on or off, an icon in the box indicates the setting is on, while an empty field means that the setting is off. At the top of the Track Sheet, above the settings columns, is a legend displaying the current Master Volume setting ("Master Volume = {#}%").

The settings columns are (from L to R):

Track Number (Tk)

- Clicking the column heading hides the Track Sheet, allowing the Song Editor to use the entire Track Editor window. Clicking again makes the Track Sheet visible again.

- A track can be moved to a different row in the Track Sheet by clicking in the Track Number column and dragging to the desired position.

- A tracks’ track sheet information can be copied from one track to another by shift-clicking in the Track Number column and
dragging to the desired destination track. This only copies the Track Sheet information (Track Name, etc.), it does not copy the Song Editor data.

Play-Enable (P) [Chapter 5: Playback and track setup, "Play-enabling and muting tracks"]

- Click in this column to enable a track to be heard in playback.
- If a track is play-enabled, clicking in this column mutes it.

Record-Enable (R) [Chapter 4: Recording, "Basic Recording Procedure"]

- Click in this column to enable a track for recording.
- Shift-click in this column to enable fader recording for the track.

Solo (S) [Chapter 5: Playback and track setup, "Soloing tracks"]

- Click in this column to hear a track alone during playback or recording, i.e. all tracks not soloed are muted. Click again to unsolo it. Multiple tracks may be soloed at the same time; Ctrl-click to unsolo all tracks.

Loop (L) [Chapter 5: Playback and track setup, "Looping"]

- Click in this column to cause the track to loop back to the beginning after playing through to the end. Click again to disable looping. Each track loops independently according to its length.

Name [Chapter 4: Recording, "Naming Tracks"]

This column has two states: collapsed and expanded.

- Click the column header to expand the column; click again to collapse it.
- Click in this column to enter or change the Track Name.
Channel (Chnl) [Chapter 5: Playback and track setup, "Setting a track's playback channel"]

- Click in this column to assign the output port and MIDI channel over which the track will play.

*Note: This setting overrides the MIDI channel information that is stored with the individual events in the track. Setting a track’s MIDI Channel to “-” (dash) disables this override, allowing each event in the track to play on its original recorded channel. This is useful for playing back Type 0 MIDI files (Single Track, multi-channel files). When a track’s channel is set to “-” the Track Sheet Program and Controller settings have no effect.*

Program Name (Prg) [Chapter 5: Playback and track setup, "Setting the Initial Column”]

This column has two states: collapsed and expanded.

- Click the column header to expand the column; click again to collapse it. In the collapsed state it shows only the selected program number; in the expanded state it shows the program name.

- Click in this column to open the Choose Instrument dialog and select a device and program that will be sent whenever playback is started from the beginning of the song. You can also choose the type of MIDI Device you are using so that the Program Names that are displayed will correspond to the program names on your MIDI device.

*Note: This setting has no effect if the track’s channel is set to “-”*

Controller (Cntlr) [Chapter 5: Playback and track setup, "The Controller column”]

This column has two states: collapsed and expanded.

- Click the column header to expand the column; click again to
collapse it. In the collapsed state it shows only the number of the selected controller; in the expanded state it shows the program name.

- Click in this column to select a controller to be used for fader recording or for sending an initial value whenever playback is started from the beginning of the song.

Value (Val) [Chapter 5: Playback and track setup, "The Value column"]

This column has two states: collapsed and expanded.

- Click the column header to expand the column; click again to collapse it. In the collapsed state it shows only the initial value for the controller selected in the Controller column; in the expanded state it shows a Fader control.

- Click in this column when collapsed to enter an initial controller value that will be sent whenever playback is started from the beginning of the song.

OR (In expanded mode)

- Set the Fader to an initial controller value that will be sent whenever playback is started from the beginning of the song. When faders are set to Volume (controller 7), this creates an initial mix for your song.

- Use the Fader to overdub controller gestures into the track using the Fader Recording feature.

*Note: This setting has no effect if the track’s channel is set to “-”*
In the Song Editor, you can:

- Record in real time.

- Select measures across one or more tracks for Edit or Change menu operations.

- Insert, delete, cut, copy, and paste measures.

- Place and display markers at measure downbeats.

The Song Editor is bordered along its left side by a column containing the track numbers, and along the top by the Measure Ruler. Recorded tracks appear on the screen as a horizontal row of rectangular boxes, each box representing a measure. Solid boxes contain MIDI data (which may or may not include notes), while hollow boxes are measures that contain no MIDI data.
The wide gray vertical bar at the end of the data area represents the end of the Tempo Map [Chapter 9: Advanced Editing, "Editing Meter and Tempo"] for the song. Even if the tracks you’re looking at are completely empty of MIDI data, and no measure boxes are on the screen, the gray bar will still appear at the measure where the Tempo Map ends. Tracks can have different lengths, but the Tempo Map is always as long, or longer, than the longest data track.

You can scroll through the data in the Track Editor using the scroll bars as you do with other Windows programs. Scroll vertically to look at other tracks, and scroll horizontally to look at earlier or later measures.

**PianoRoll Editor**

In the Piano Roll Editor you can:

- See and edit MIDI note data on a track graphically

- Insert (using the mouse), move, stretch, copy, and erase individual notes

- Record in real time or step entry mode
• Select regions of notes for Edit and Change operations with a resolution down to a single clock (1/240th of a quarter note)

• Edit note parameters numerically.

• Place and display markers with sub-measure resolution.

• Name tracks.

• Select whether edit operations affect all MIDI data or Note data only. (Non-note data is not displayed in this window but it can be edited.)

The Piano Roll Editor contains a graphic display of one track’s note events. The data area is divided horizontally by a grid of solid lines, heavy gray lines, and light gray lines to make it easy to accurately determine the position of notes in the window. The black lines indicate octaves ("C"), the heavy gray lines indicate the note division between “E” and “F”, and the light gray lines delineate the remaining "white keys".

The light gray lines can be hidden to give you a somewhat “cleaner” screen with the Hide Grid command in the Layout menu. [Chapter 7: Viewing & Selecting Data for Editing, "View Filtering"]

Vertical gray lines indicate measure downbeats. The "hash marks" between measure lines in the Measure Ruler indicate beats. Remember that this reflects the number of beats per measure as determined by the current meter. The window usually has a measure boundary at its left edge.

In addition to the Marker Ruler, the Piano Roll Editor also offers a similar well and ruler for program changes. Located at the bottom of the window, the Program Change Well [Chapter 8: Basic Editing, "Inserting, deleting, and editing program changes"] works just like the Marker Well to allow creation and editing of program changes in the track.
The note display

The note data itself is displayed as a sideways “piano roll”. Each note is represented as a small horizontal rectangle, or block. In addition to other viewing methods, all note parameters can be displayed and edited numerically by double-clicking the note with the Arrow tool to open an Edit Note dialog.

- The vertical position of the block reflects the note’s pitch. The pitch can be determined by referencing the piano keyboard at the left edge of the window or by moving the pointer to the note and reading the pitch indicator box in the Control Bar.

- The horizontal position of the block shows the note’s position in time. The start time of a note can be determined by moving the pointer to the left edge of the note and reading the position display in the Control Bar.

- The horizontal length of the block represents the note’s duration. You can estimate the duration of the note by comparing it against the markings in the measure ruler.

Notation Editor

In the Notation Editor you can:

- See and edit note data as traditional music notation.

- Insert (using the mouse), move, copy, and erase individual notes.

- Record in real time or step entry mode and immediately see the recording transcribed into notation.

- Select regions of notes for Edit and Change operations with a resolution down to a single clock (1/240th of a quarter note).

- Edit note parameters numerically.
• Place and display markers with sub-measure resolution.

• Name tracks.

• Select whether edit operations effect all MIDI data or Note data only. (Non-note data is not displayed in this window but it can be edited.)

The Notation Editor displays a track of your song as a single, continuous, two-stave system of music notation. Mechanical notation considerations such as beaming of notes are performed automatically. Functionally, the Notation Editor is virtually identical to the Piano Roll Editor; the primary difference is the visual presentation. The Measure Rulers and Marker Rulers in the two Editors are the same, and the Control Bars almost exact duplicates. Notes are selected, cut, pasted, moved, and individually edited with the same techniques.

A horizontal scroll bar allows you to move through time in the Notation Editor, while fitting a high or low passage onto the Grand Staff is accomplished by setting one of the window’s Setup parameters to show a different octave.
In the Notation Editor, notes inserted with the mouse or in Step Entry mode have exactly the duration indicated by the note’s rhythmic value. There is no Articulation feature, such as is found in the Piano Roll Editor.

The appearance of the notation can be configured in a dialog of setup parameters. These include the split point, which is the dividing line that determines which notes will be shown on the upper (treble clef) staff and which on the lower (bass clef) staff, the smallest rhythmic value that will be displayed, and whether or not the initial key signature and meter will be displayed. The key signature shown in any portion of the song can be set with the Change Key Signature command. [Chapter 7: Viewing & Selecting Data for Editing, "Viewing in the Notation Editor"] The key signature is a display feature only, it does not affect the MIDI data in the track.

The contents of the Notation Editor can also be printed out to provide parts to players. The "Notation Print Setup" command in the File menu allows a text header to be added, as well as setting the number of measures that will appear in each system (line of notation).

Event Editor

In the Event Editor, you can:

• See and edit all MIDI data on a track in an alphanumeric list displaying all parameters.

• Insert, delete, move, and alter individual events of any type with great precision and resolution down to a single clock (1/240th of a quarter note). This includes program changes and controller events, as well as notes.

• Selectively filter the types of events available for viewing and editing.

Tip: Adjusting the split point can often improve the look of a passage that may be mostly played higher or lower than the range surrounding the default split point of C3.
• Select regions of data for Edit menu operations.

• Name tracks.

The Event Editor is different than any of the other Editors. For a start, information is not presented graphically, but alphanumerically. This means that exact values for every event are visible at all times, as opposed to the Notation and Piano Roll Editors, for instance, which require double-clicking a note to bring up the Edit Note dialog for a precise display of all values.

Secondly, the Event Editor can display events of all types, not just notes, and edits all types with equal ease. Changing a parameter of any event requires only clicking on it to select it and entering the new value. The Event Editor does not display either text or MCI markers.

The Control Bar in the Event Editor is dominated by the Event Insert buttons, which are the strip of icons in the top row on the
right. Each of these icons represents the type of event that is inserted when the icon is clicked. The "Goto" button provides a locating mechanism to make it easy to skip around in a large list of events, while the "Filter" button lets you set which types of events you want to see and edit.

**Event data area**

Each row in the Event Editor shows the data for a single event. The data is presented in four columns (from L to R):

- The Event column displays an icon, matching one of the Event Insert icons, that indicates the type of event.

- The Measure column shows the exact start time of the event in measures, beats, and clocks.

- The Channel column shows the MIDI channel to which the event is assigned. This setting is often overridden on playback by the Channel setting in the Track Editor.

- The Data column shows the value of the event.

For a note, the Data column is itself subdivided into four columns showing (L to R) pitch, note-on velocity, note-off velocity, and duration in measures, beats and clocks.

For a controller event, the Data column is subdivided into two columns showing (L to R) the controller number and the value.

For program change, pitch bend and channel information the Data column shows the value. For key pressure the Data column displays both the value and the note.

As the Event Editor is a vertically-oriented chronological list, the vertical scroll bar allows you to move through time in the Event Editor.
The MIDI Data windows

The MIDI Data windows are a collection of six windows, virtually identical in their layout and operation, which enable easy direct graphical editing of non-note MIDI data. Although it is possible to edit all types of data in the Event Editor, a graphical approach is often more intuitive for continuously changing values like pitch bend or volume.

In the MIDI Data windows, you can:

- See and edit continuous data in a graphical environment.
- Draw and erase continuous data as shapes.
- Insert and delete individual events.
- See a "ghost" display of notes behind the continuous data being edited to aid in accuracy in editing.
- Select regions of notes for Edit and Change operations with a resolution down to a single clock (1/240th of a quarter note).
- Record in real time.
- Place and display markers with sub-measure resolution.
- Name tracks.
There are six MIDI Data windows, each showing and editing only one type of data. The Controllers window, however, can be set to display and edit data for any MIDI Continuous Controller. Only one MIDI Data window can be open at a time, with the currently open window being indicated by a check mark next to its name in the Windows menu.

Like the Notation and Piano Roll Editors, the MIDI Data windows all have Control Bars (albeit comparatively simple ones), Measure Rulers, and Marker Rulers. A horizontal scroll bar lets you move through time. The vertical axis represents the value for the type of event. For all except pitch bend, the vertical axis represents a range from 0 to 127. Pitch bend can be positive or negative, so its range is from -128 to +127.

Display modes

The MIDI Data windows allow you to view MIDI events in a window as vertical lines (sometimes called “skyline” mode), or as points. You toggle between skyline and point modes by pressing any character key on your computer’s keyboard (but not Tab, Shift, Enter, Space Bar, etc.) when a MIDI data window is active. The mode setting remains in effect for any MIDI Data window that is opened subsequently, until you change it by pressing a key again.

The six MIDI Data windows are:

- Pitch Bend: allows you to display and edit pitch bend data.
- Channel Pressure: lets you work with MIDI channel pressure data, also called “mono aftertouch”.
- Key Pressure: displays and edits MIDI key pressure data, also called "polyphonic aftertouch".
- Modulation: displays and edits MIDI modulation data (Controller #1), which usually corresponds to the mod wheel on your synthesizer.
• Controllers: lets you enter and edit data for any MIDI controller, numbers 0 through 127. (Remember, Modulation is Controller #1, not #0.) The "Ctrl #" button in the Control Bar lets you select the controller number you wish to see and work with. A list of standard MIDI Controller assignments appears in [Appendix B: Standard MIDI Controllers] at the end of this manual.

• Velocity: displays and edits note-on velocities of notes in a track.

The Tempo Map

The Tempo Map window [Chapter 9: Advanced Editing, "Editing meter and tempo"] is essentially another MIDI Data window, but with a different purpose. It shows the time signature (meter), beat unit, and a graphic representation of the tempo of a song from moment to moment. You can insert, erase, and edit individual tempo changes, and select regions for editing. The Tempo Map is also affected by the Change Conductor and Fit Time commands found in the Change menu. The Tempo Map’s vertical axis represents tempo settings. It is labeled with values between 10 and 300, which is the range of tempo settings in 4/4 time when the Click value is set to a quarter note. The true indication of a tempo value in the Tempo Map is displayed by the Current Position Indicator in the Control Bar. The Tempo Map does not have skyline and point display modes.

Working with the Menus

Many of Master Tracks Pro's operations are accessed from the menu bar. The commands on the menu are discussed in detail in the User's Guide portion of the manual, and summarized in [Chapter 10: Menu and Window Reference]. Here is a brief description of the menus:

• File menu: Basic file operations (Open, Close, Print Notation, Save, Revert). Also the Preferences command and Notation Print Setup.
• Edit menu: Basic editing commands (Cut, Copy, Paste, Mix, Clear, Undo, Select All), Insert and Delete Measure commands, Change Filter command.

• Change menu: Advanced editing commands for modifying or remapping musical data. Includes: Transpose, Quantize and Humanize, Fit Time and Scale Time, Key Signature and Conductor (time signature and tempo), remapping Channels and Controllers, etc.

• Windows menu: Opens the main windows.

• Songs menu: Enables creation of Song Sets and Play Lists (collections of songs). The Song Menu also contains a menu item for each open song, with the current song indicated with a check mark.

• Layout menu: Configures the display by showing or hiding the Grid, Device Names, Program Changes, etc. Also contains Zoom In and Out.

• Options menu: Switches important basic functions like Keyboard Thru, Countoff, Metronome Click, and Multi Track Record.

• Setup menu: Allows configuration of many features, including: MIDI, external synchronization, metronome Click sound, and control of Master Tracks Pro from a MIDI controller. Also accesses Sysex bulk dump feature.

• Info menu: Opens or makes active windows with status information about Master Tracks Pro, including: the Transport window, Markers, Notepad (for attaching notes to tracks or markers), MCI Status, and available Memory.

Some of the menu commands can also be performed using icons found within the windows or keyboard equivalents. A list of key equivalents is found in [Appendix A: Keyboard Shortcuts].
Basic Transport Functions: the Transport window and Remote Control Setup

Master Tracks Master Tracks Pro is designed to work much like a multitrack tape deck. Consequently, Master Tracks Pro’s Transport window provides tape deck-like controls that enable you to play, record, fast forward, rewind, and stop the song, as well as two counters to tell you where you are in the song. Unlike a tape deck, however, Master Tracks Pro can also locate instantly to the beginning or end of a song.

*Note: Only basic transport sections are described in this section. The remaining Transport window functions are described elsewhere in the User’s Guide and in the Reference Section.*

The Transport window cannot be closed. It may, however, become obscured by other windows during the course of a session.

To bring the Transport window to the front:

- Choose the "Transport" command from the Info menu.
Measure Counter

The Measure Counter (marked "Meas Beat Clock") at the lower left displays your current position in the song in measures, beats, and “clock pulses” (sometimes called "ticks" or "PPQ"), which are the smallest divisions of a beat in Master Tracks Pro. One clock pulse is 1/240th of a quarter-note. Notice that, since a clock pulse (or, more simply, just "clock") is derived from a beat, the amount of time this represents will depend on the tempo. As the song plays (or records), the Measure Counter increments.

To move to any location in a song using the Measure Counter:

- Click on the measure, beat, or clock field in the Measure Counter, press the Backslash “\” key or the vertical bar “|” key.

OR

- With the Measure Counter as the active window, press the Tab key to select the measure field.

- Type the number on your computer’s keyboard. Use the Tab key and the left and right arrow keys to move between fields of the counter.

- Click the Fast Forward or Rewind buttons.

Locating with the Goto dialog

Another way to set the Measure Counter and locate to a desired spot is to use the Goto dialog. The Goto dialog is available while any window is active, and lets you enter the desired location directly in measures, beats, and clocks.

To locate with the Goto dialog:

- Press the "." button on your computer keyboard to open the Goto dialog.
• Type the desired location, in measures, beats, and clocks. Click "OK" to locate to that point. The Measure Counter will indicate the new location.

**Current Time Indicator**

The Current Time Indicator displays your current position in the song in hours, minutes, seconds, and frames, normally representing elapsed time from the beginning of the song. The number of frames in each second is determined by the SMPTE Format setting in the Sync Setup window. [Chapter 6: Synchronization]

When synchronizing Master Tracks Pro to an external timecode source, you may choose to set a nonzero Start Time for the Song. In that case, the Current Time Indicator uses the Start Time as its initial value, adding elapsed time to it as it counts.

**Edit/Punch Point indicators**

The In and Out indicators to the left of the Punch button show the current start and end points for any punch-in recording or editing operation. These indicators are for display only and cannot be set in the Transport window. The in and out points are set by selecting a region in an Editor or MIDI Data window, or by using the Punch Setup Dialog. Once Punch In has been enabled these indicators will become fixed and will no longer follow the selected region.

**The Big Counter**

Although not actually part of the Transport window, the Big Counter is simply an oversize display of the Measure Counter and Current Time indicator, intended to be seen easily from several feet away. The Big Counter can be set to show one or both indicators.
To open the Big Counter window:

- Choose the "Big Counter" command from the Info menu.

OR

- Hold the Ctrl key on your computer keyboard and press "B".

To select the indicators shown in the Big Counter:

- Click one or both of the check boxes at the top left of the window. The "Measure" box, when checked, causes the Measure Counter to be displayed. The "Time" box, when checked, causes the Current Time indicator to be displayed. Unchecking a box causes that indicator to not be shown.

Transport Functions

Along the top of the Transport Window are nine screen “buttons” which, for the most part, act just like their counterparts on an actual tape deck, providing basic transport functions for Master Tracks Pro. To “press” one of these buttons, simply click on it.

In addition, the Remote Control Setup window (see below) enables you to operate primary transport functions directly from your MIDI controller.

The following sections describe the transport functions. Key equivalents, when available, are indicated in parentheses after the button's name.
The Transport Controls

Head (Home)

Immediatly resets the Measure Counter to the beginning of the song.

Rewind (Left Arrow)

Click this button once to decrease the Measure Counter by one measure. Click and hold to make the counter count down in one-measure increments. This button does not work during Playback.

Stop (Spacebar)

Stops playback and recording and sends an “All Notes Off” command on all MIDI channels to make sure no notes are left “hanging”. If the Auto Rewind function is on, the song automatically rewinds to wherever you last started playback. [Ch. 5: Playback and track setup, "Setting the playback point"]

Pause

Pauses playback or recording without exiting the play or record mode. Clicking the Pause button again resumes playback or recording from the point where the song was paused.

Play (Spacebar)

Begins playback from the point currently indicated by the Measure Counter. Only tracks in the song which are play-enabled in the Track Editor [Chapter 5: Playback and track setup, "Play-enabling and muting tracks"] will sound in playback.
Fast Forward (Right Arrow)

Click this button once to increase the Measure Counter by one measure. Click and hold to make the counter count up in one-measure increments.

Click and hold while the song is playing to speed up playback and “scan” your song.

*Note: The Right Arrow key equivalent does not function when a song is playing.*

Tail (End)

Immediately resets the Measure Counter to the end of the song.

Record (Enter)

Begins recording on any record-enabled track(s) from the point indicated by the Measure Counter. Clicking the Record button with no tracks record-enabled produces an error message.

Auto Rewind (",")

If Auto Rewind is on and you stop recording or playback, the Measure Counter is reset to the point where recording or playback started. Auto Rewind can also be selected from the Options menu.

To enable Auto Rewind from a menu:

- Choose the "Auto Rewind" command from the Options menu.
Remote Control

In the heat of creating or performing it can be awkward to have to remove your hands from your MIDI controller and reach over to the computer keyboard to operate Master Tracks Pro’s transport functions. The Remote Control feature allows you to define certain notes to act as control keys that perform the basic transport functions.

The following functions can be controlled remotely: Play, Stop, Record, Rewind, Fast Forward, and Pause.

*Note:* Typically, notes at the very top or very bottom of the keyboard (or other controller’s range) are used for this purpose.
To assign a note to remotely control a transport function:

- Choose the "Remote" command from the Setup menu to open the Remote Control Setup dialog.

- Click the "Use in Transport" check box to enable remote transport control.

  *Note: If "Use in Transport" is not enabled, no remote transport controls will function.*

- Click the check box of the transport function you wish to remotely control.

- Click in the text box to the right of the transport function's name to select it.

- Type in the note name (A-G), followed by a "#" if an accidental is needed, and the octave number, e.g. "G#0"

  OR

- Type in the MIDI note number (between 0 and 127)

  OR

- Play the note on your MIDI controller.

- Repeat for as many transport functions as you wish to control remotely. Click OK to confirm your settings.
The Conductor window

The Conductor window displays current meter and tempo settings, including a temporary change in the tempo, called an "offset tempo". It also provides access to the Change Conductor dialog, in which tempo and meter changes can be made.

To open the Conductor window or bring it to the front:

- Choose "Conductor" from the Info menu.

There are only three items in the Conductor window:

- The tempo and beat indicator in the lower right corner shows the original stored tempo for the song, as well as the rhythmic value that currently represents a beat. Clicking on the indicator clears the tempo offset, returning it to the current tempo value.

- The Offset Tempo scroll bar across the top of the window allows the tempo to be temporarily offset while playing or recording by dragging the scroll bar to the desired tempo. The legend above the scroll bar ("Offset Tempo = {#}") indicates the actual tempo at which the song is currently playing or recording.

- The Meter (time signature) indicator in the lower left shows the current meter of the song. As meter changes occur, the indicator updates to show them. Clicking on the indicator opens the Conductor dialog.
The Master Fader

The Master Fader provides a controller that affects all tracks simultaneously. Most commonly, it is used to control volume of all the tracks.

The Master Fader can be used in real time ("Live" mode), in which case it controls the MIDI volume of all tracks, or recorded for automation ("Record" mode), such as fade-outs. Although the Master Fader only affects volume in Live mode, in Record mode it actually controls whatever controller is currently selected in the "Cntlr" box in the Track Sheet of any fader-record-enabled track.

Automated control of subgroups is achieved simply by enabling the tracks you want in a group for fader recording and performing a record pass with the Master Fader in Record Mode.

In Live mode the Master Fader simply acts as a Master Volume control. This Master Volume setting appears on the Track Sheet and is saved with the song.

To open the Master Fader:

- Choose the "Master Fader" command from the Windows menu.

OR

- Press F5 on your computer's keyboard.
In addition to the windows, there are many dialogs in Master Tracks Pro. Here are brief descriptions of a handful of the most important ones:

- **MIDI Setup (Setup menu):** This dialog is where the connection is established between Master Tracks Pro’s 16 "logical" ports (A-P) and the physical MIDI interface ports in your computer. Record and sync port assignments are also made in this dialog. [Chapter 10: Menu and Window Reference, "Setup"]

  *Note: If you don’t hear anything when you start playback, the MIDI Setup dialog is one of the first places to check.*

- **Sync Setup (Setup menu):** Allows external synchronization to be configured and enabled. Selection of SMPTE format, SMPTE Start Time (sync offset), freewheeling value, and Sync Out port are also performed in this dialog. [Chapter 6: Synchronization]

- **Thru Setup (Setup menu):** Selects port and channel for keyboard thru feature. [Chapter 4: Recording, "Monitoring (Keyboard Thru)"]

- **Change Conductor (Change menu):** Enables creation and modification of tempo and meter changes. [Chapter 9: Advanced Editing, "Editing meter and tempo"]

- **Change Filter (Edit menu):** Allows you to perform sophisticated, rule-based selection of data for editing. [Chapter 7: Viewing & Selecting Data for Editing, "The Change Filter"]

- **Memory (Info menu):** Shows important status information having to do with the amount of free memory available and how much memory is currently being used by the clipboard and score. [Chapter 10: Menu and Window Reference, "Info"]
Viewing Information in Master Tracks Pro

Sequencing often involves looking at information about the program and your music. Master Tracks Pro shows you pertinent information in a variety of places. Here is a quick summary of where vital information can be found in Master Tracks Pro:

**Current play/record location:**

- Measure Counter (Transport window)
- Current Time indicator (Transport window)
- Big Counter window (Info menu)

**Current pointer position:**

- Current Position Indicator (Control Bar of Notation and Piano Roll Editors, MIDI Data windows, Tempo Map window)

**Current edit/punch points:**

- In and Out indicators (Transport window)

**Current meter, tempo, and beat value:**

- Conductor window
- Tempo Map Control Bar

**Track currently being edited:**

- "Track =" button (Control Bar of MIDI Data Windows and Editors - except Track Editor).
Track name:

- Name column, Track Sheet portion of Track Editor
- Control Bar of MIDI Data Windows and all Editors except Track Editor.

Marker locations and names:

- Marker Ruler of MIDI Data Windows and all Editors except Event Editor.
- Markers window (Info menu)

Current Master Volume value:

- Master Volume indicator (Track Sheet portion of Track Editor)

Available memory:

- Memory window (Info menu)

Current Port/Driver assignments

- MIDI Setup dialog
The File menu has a variety of commands that let you manage your song files. Generally these commands work just as they do in most other Windows applications, so if you’ve had any previous experience with Windows, you’ll already be familiar with how to use them.

*Note: In Master Tracks Pro, a "sequence" is also called a "Song", and is stored in a sequence "file". These terms are used interchangeably throughout this manual, and they are equivalent.*

The File menu also includes the “Preferences” command, which allows you to set up the program the way you like, and store that setup on your Master Tracks Pro working disk or hard disk. These settings are loaded every time you start up Master Tracks Pro. Preferences can always be changed once the program is open and, if you like the new settings better, saved in place of the old Preferences.

Master Tracks Pro lets you read and write two different types of song files: files created by Master Tracks Pro itself, and MIDI files. Master Tracks Pro can read files created with Passport MIDI Workshop, Passport’s other Windows sequencing program, and the notation programs Encore and MusicTime. MIDI Files are an industry standard format for storing MIDI sequences. If you own any programs that support this format, you will be able to share song files with these programs. We will discuss dealing with MIDI Files later in this chapter.
About Master Tracks Pro Files

A Master Tracks Pro file is a single sequence, either in its temporary form in your computer’s memory, or stored more permanently on a disk. To work with a Master Tracks Pro file you must either open (load) an existing sequence file from disk or start a new one. A file is "open" when you’re working with it in your computer’s active memory. When you finish working, you "close" the file. This removes it from memory, and you can only work on it again by reloading (opening) it from the disk.

The number of files that can be open at one time is limited only by the amount of memory you have, but only one file can be “active” for working at a time. The name of the active file appears at the top of the Transport window. The names of all open files appear on the Songs menu, and you can choose which file you want to be active from that menu. You can also play multiple open files one after the other using the Song Play List feature on the Songs menu. See [Chapter 5:Playback and track setup, "Song Play Lists and Song Sets"] for more details.

*Be sure to save your song files frequently while you work with them*, so that you don’t lose your work because of a power failure, glitch in the fabric of the universe, or other problems with your system. You can store files on any disk or drive in your system, as long as there is enough space, using options in the Save As dialog.

Starting a new file

To create a brand new song:

- Choose the "New" command from the File menu

OR

- Hold down the Ctrl key on your computer’s keyboard and press "N".
When the new file is opened, any windows you had open remain on the screen in the same position, but all the existing data disappears. Master Tracks Pro titles the new file “Untitled”, followed by a number, until you rename it using the “Save As” command. (The program will let you save a file with the name “Untitled {#}”, but it’s probably not a good habit to get into). Every time you open a new file it is given a unique number so that no two open files have the same name.

**Opening an existing file**

- Choose the "Open" command from the File menu.

**OR**

- Hold down the Ctrl key on your computer's keyboard and press "O".

As with the new file, the open windows remain onscreen, but become filled with the data of the file just opened.

The Open command can open a song in either of the following file formats:

- MasterTracks Pro (uses the ".mts" file extension)
- Type 0 or Type 1 MIDI file (uses the ".mid" file extension)

MIDI files are discussed in more detail below.

*Note: You can open more than one file with this command. See "Using Multiple Songs" later in this chapter.*
Closing files

Use the Close command in the File menu to end work on a particular file without leaving the program or closing any other files. The name of the active song always follows the word "Close" in the menu.

To close a file:

- Choose the "Close {active song name}" command.

If you’ve made any changes in the song since it was last saved, choosing the Close command will bring up a confirmation dialog ("Are You Sure?") that offers you the choice of saving or discarding the changes.

- Click the "Yes" button to save changes made since the song was last saved. Click the "No" button to discard changes, leaving the song on disk as it was.

If there are other files open, the file in the song list just above the file you are closing will become active. If you are closing the first file in the list, the next file below it becomes active. All the windows you’ve been using will remain on the screen, but they will show data for the newly active file. If no other file was open, the windows will be empty and the title bar on the Transport window will say “Untitled {}”.

To close all open files at once:

- Choose the “Close All” command from the File menu.

All open files will close, with a confirmation dialog appearing for each file that has been changed since the last time it was saved.

- Click the "Yes" button in the confirmation dialogs to save changes
made to the song named in the dialog since the last Save operation. Click "No" to discard changes.

OR

• Click "Close All and Ignore Changes" in any confirmation dialog to discard changes to all songs (not just the one named).

Note: Double-clicking in the upper left corner of the Track Editor window merely closes that window, it does not close the file. Don’t be confused.

Saving files

The "Save" command in the File menu stores the currently active song onto a disk. If the file is new and has never been saved, the Save item will be grayed. In this case, use the "Save As" command, discussed below.

To save a file to disk:

• Choose the "Save" command from the File menu

OR

• Hold down the Ctrl key on your computer’s keyboard and press "S". Master Tracks Pro will save the current version of the song to the same disk file that it came from, without any further action on your part, overwriting the existing file of the same name.

Using the Save As Command

The "Save As" command in the File menu lets you save a new file for the first time, save a previously-saved file with a new name or to a different folder or disk, or save a file in a different file format. This command is especially useful when you want to store different
versions of a file as you work on it, so that you have the option of coming back to earlier versions later on.

To save a file with the "Save As" command:

• Choose the "Save As" command from the File menu.

• Choose the file format in which you want to save the song from the "Save File as Type" drop-down menu.

• Type in or edit the name shown in the "File Name" box at the top of the dialog, being careful to include the correct file extension.

If you’re saving a previously saved file, the current name of the file appears in the file name field. If the song has never been saved before, "Untitled {#}" will appear in the name field.

• Use the "Directories" box and the "Drives" drop-down menu to locate the disk and folder where you want the song file stored.

• Click the "OK" button to save the file.

The Save As command can save a song in either of the following file formats:

• MasterTracks Pro (uses the ".mts" file extension)

• Type 0 or Type 1 MIDI file (uses the ".mid" file extension)

MIDI files are discussed in more detail below.

Using the Revert to Saved Command

The "Revert to Saved" command in the File menu reloads the last saved version of the currently active file. If the file has never been saved, this command is disabled. Use this command when you’ve made changes that you know you don’t want to keep in a song.
This is particularly useful after an unsuccessful experiment or mistaken change made to a song.

To revert to the last saved version of a file:

- Choose the "Revert to Saved" command from the File menu. A warning dialog will appear asking you to confirm that you want to discard all changes made since the last time the file was saved.

- Click the "Yes" button to discard all changes and reload the last saved version of the file. Click "No" to cancel the Revert command and return to the current version of the song.

Using Multiple Songs

To open multiple songs, or “Songs”:

- Use the "Open" command in the File menu, as described above, to open each file.

As each file is opened, it becomes the “active” song and its name is added to the Songs menu.

To see the complete list of active Songs:

- Pull down the Songs menu. Each open song is listed at the bottom of the menu. The active song—the one you can listen to and edit—is denoted on the menu by a check mark.

To make an open song active:

- Choose the name of the song you wish to make active from the Songs menu. Songs on the Songs menu that are not active are still open.

Note: You cannot select a different song to be active while the active song is playing.
Using MIDI Files

The Standard MIDI File is an industry-wide format that has been adopted by most software manufacturers. It allows you to exchange song files between various programs from different manufacturers. You can create MIDI files on Master Tracks Pro and play them with other programs, such as other sequencers or notation programs, or you can use MIDI files created with other programs in Master Tracks Pro.

MIDI Files are typically about 35% smaller than Master Tracks Pro files with the same amount of musical information, and thus take less room on your disk and less time to transmit by modem.

To save the active song as a MIDI File:

- Choose the "Save As" command from the File menu. This will bring up a dialog asking you to name your file. MIDI files can be identified by the extension ".MID".

- Click in the box below the "Save File as Type" legend to drop down the menu of file format choices.

- Select "MIDI Type 1 *.mid" to store the song as a Type 1 MIDI File, or "MIDI Type 0 *.mid" to store the song as a Type 0 MIDI File.
Channel assignments in MIDI Files are given on a note-by-note basis: notes are assigned to the channel shown in their Master Tracks Pro track’s "Chnl" column in the Track Sheet. If a Master Tracks Pro track has no Channel assigned to it (Chnl column shows a "-"), the notes in it are given their original, recorded channel assignments.

A Type 1 MIDI File saves the song in multiple tracks, and is the more commonly used of the two types of MIDI File. Each track has multichannel capability, just as in Master Tracks Pro, and is stored with its name.

A Type 0 MIDI File puts all of the song data on a single track.

To open a MIDI File into Master Tracks Pro:

• Choose the "Open" command from the File menu. Use the Directories box and the Drives drop-down menu to locate the directory containing the MIDI file you want to open.

• Double-click on the name of the file you wish to open. The MIDI File will open exactly as if it was a song file and its name will appear in the Songs menu. A Type 0 MIDI File is "exploded" onto separate tracks when opened, that is, data from each channel is split out onto its own track, with all tracks set to Port A.

Just as with Master Tracks Pro files, you can’t open the same MIDI File twice. Once open, there is no difference between working with a MIDI File and working with a file created by Master Tracks Pro.

To save a MIDI File as a Master Tracks Pro song you must use the "Save As" command. As with Master Tracks Pro files and the "Save" command, you can save a MIDI File in either MIDI File format with the same name under which it was opened. The new version replaces the earlier version.
Customizing the Program with Preferences

The Preferences command

Once you’ve been working with Master Tracks Pro a while, you will develop arrangements of windows and settings of various program parameters that you find particularly useful. These settings can be saved as defaults in a “Preferences” file.

To save program settings and window arrangements as Preferences:

• Choose the "Preferences" command from the File menu. A confirmation dialog will open.

• Click the "OK" button to save your preferences. Preferences are saved in a file called "prefer.mtp" in the Master Tracks Pro directory.

The next time you start Master Tracks Pro, the program will read the Preferences file as it loads, and will come up on the screen with the windows you want open at the positions and sizes you chose. In addition, the settings of many of the functions in the menus and windows will be as specified in the Preferences file.

What is saved in the Preferences file

When you choose Preferences from the File menu, the program takes a “snapshot” of the current positions and sizes of any open windows on the screen, and also records the following data elements:

• In the Edit menu: Change Filter settings.

• In the Layout menu: Show/Hide Grid, Show/Hide Markers, Zoom resolution, Show/Hide Velocity, Show/Hide Program Changes.
• In the Options menu: Everything except the Punch-In state.

• In the Setup menu: Remote Setup, MIDI Setup, Sync Setup, Click Setup, Thru Setup, Chase Controllers, and Record Filter parameters.

• In the Choose Instrument Dialog: The default device.

• In the Transport window: Auto, Thru, Metronome, Count In, and Sync settings.

• In the Track Editor: the Measure Ruler numbering scheme (every third bar is numbered, or every fourth bar, etc.).

**Printing from the Notation Editor**

One of the major reasons for Master Tracks Pro's Notation Editor is to allow you to print out your songs. Only one track can be printed at a time: the track currently showing in the Notation Editor.

To print from the Notation Editor:

• Check that the settings in the Notation Editor Setup dialog [Chapter 7: Viewing & Selecting Data for Editing, "Viewing in the Notation Editor] are as you wish, the Notation Editor is the active window, and the track you wish to print is being displayed.

• Choose the "Notation Print Setup" command from the File menu and configure the settings in the dialog that opens.

• Choose the "Print Notation" command from the File menu, configure the settings, and click the "OK" button to print the notation.
Setting up to print notation

- Choose the "Notation Print Setup" command from the File menu to open the Notation Print Setup dialog.

- Click one of the radio buttons in the "Select Measures Per System" portion of the dialog to set the number of measures that will appear in each line of the notation.

- Click in the check box(es) marked "Line 1" and/or "Line 2" to enable one or two lines of text to be printed at the top of each page.

- Click the "File Name" button to place the name of the active song into Line 1, if you wish.

- Click the "Track Name" button to place the name of the track currently showing in the Notation Editor into Line 2, if you wish.

OR

- Type the text you want to appear in the Line 1 and Line 2 boxes.

- Click the "Set Font" button to open the Font dialog.

- Click in the Font list on the name of the font you wish to use for text to select it. Use the scroll bar, if necessary, to move up and down the list. The currently selected font appears in the box above the list.
• Click in the Font Style list on the style you wish to apply to the text to select it. The currently selected font style appears in the box above the list.

• Click in the Size list on the font size you wish to use for the text to select it. Use the scroll bar, if necessary, to move up and down the list. The currently selected font size appears in the box above the list.

• Click the "OK" button to close the Font dialog.

• Click the "OK" button to close the Notation Print Setup dialog.

Starting printing

• Choose the "Print Notation" command from the File menu to open the Print dialog.

• Click the "All" radio button in the Print Range portion of the dialog to print the whole track.

OR

• Click the "Measures" radio button in the Print Range portion of the dialog to enable printing of a specified range of measures.

• Type the number of the first measure you want printed in the "From" box and the last measure you want to print in the "To" box.

• Click in the "Print Quality" box to drop down the menu of available print resolutions and click on the desired resolution to select it. If only one resolution is available, no menu will appear.

• Type the number of copies you wish to print into the "Copies:" numeric box.
• Click in the "Print to a File" and/or "Collate Copies" check boxes if you wish to enable these options.

• Click the "Setup" button if you need to adjust additional printer settings.

• Click "OK" to start printing.

**Exit**

The Exit command in the File menu closes all of the currently open files and exits Master Tracks Pro.

**To exit Master Tracks Pro:**

• Choose the "Exit" command from the File menu.

OR

• Hold the Ctrl key on your computer keyboard and press "E".

If any changes have been made to the open files since they were last saved, you will be given the opportunity to save the files before they’re closed.

**About Master Tracks**

Choosing the "About Master Tracks" command in the File menu displays the About Dialog which contains User Registration and Serial Number information. Pressing the "V" key causes the version information to be displayed. You will need to know this information if you ever want to contact Passport’s Technical Support department.

Click anywhere in the dialog to close it.
This chapter starts by explaining those settings that should be defined before recording (though not all are necessary), then goes on to describe the recording procedure itself. Finally, some advanced recording features and considerations are discussed.

In practice, recording and playback are intertwined aspects of the same process. Information on playback and some important track setup features is given in the next chapter.

Master Tracks Pro offers many options and tools for recording. It can record all kinds of MIDI data, but can use the Record Filter to keep certain types of data (such as aftertouch) from being recorded. If you want to separate various types of data after the recording is already complete, the Strip Data command [Chapter 9: Advanced Editing, “The Strip Data command”] can be used. Master Tracks Pro also has great flexibility in dealing with multichannel data. Data from all 16 MIDI channels can be recorded simultaneously onto a single track, as you might with a guitar controller, or you could use Multi Track record to record each channel’s data to its own track. If you record to one track, you can use the Strip Data command afterwards to move the data for each channel onto its own track. The Record Filter can also be used to allow data from only one channel of multichannel MIDI data to be recorded.

Master Tracks Pro is capable of working with multiport interfaces such as the MIDI Time Piece 2, or with multiple single port interfaces. Up to 16 ports are supported, for a total of 256 available MIDI channels. Naturally, Master Tracks Pro’s multiport functions cannot work if your interface is not properly installed. A driver must be assigned in the MIDI Setup dialog [Ch 10: Menu and Window Reference, “Setup”] for each port.
Setting up to record

Before recording, there are a number of important things to be set up, such as: monitoring, defining meter and tempo for the sequence, choosing a Click sound, selecting a countoff (if desired), and so forth. This section explains how to prepare these settings.

**Important Note:** Make sure that you have chosen the correct Port and Driver for your input device before recording. (See Chapter 10: Menu and Window Reference, “Setup”)

**Monitoring (Keyboard Thru)**

Since you'll want to hear what you're playing as you record, it is generally desirable to pass MIDI data coming in to Master Tracks Pro from your controller through to your interface’s MIDI Outs to play your MIDI sound source. Master Tracks Pro’s Thru feature performs this function.

**Tip:** Pressing the Tab key alternately selects the Port and Channel parameter boxes.

**Warning:** Depending on your setup, if you are using a synthesizer or sampler keyboard as your controller, you may want to turn off Local Control (a MIDI feature found in most synthesizers) before using Thru. Otherwise, each key stroke might sound two notes: one played directly by your keyboard, and one being played back by Master Tracks Pro’s Thru setting.

To switch Thru on and off:

- Click the “Thru” button in the Transport window to toggle Thru on and off.

**OR**

- Choose “Thru” from the Options menu to toggle Thru on and off.
When Thru is on, the port and channel display of the "Thru" button will be in red, and the MIDI data you send to your computer will be echoed out one of the MIDI Out ports on your computer’s MIDI interface.

To set up Thru:

- Choose “Thru Setup” from the Setup menu or double-click the Thru button in the Transport window to open the Port and Channel Select dialog.

Each lettered row of the matrix represents one port, and each column one MIDI channel. The leftmost column, labelled "-", indicates multichannel Thru.

The currently selected Port and Channel are also indicated in the parameter boxes at the top of the window. The column on the far right displays the driver selected for each port. This setting cannot be edited in this window.
All incoming data will be routed to the selected output Port and Channel, regardless of the Port and Channel from which it originated. If Port “A” is selected, for example, then data will be sent out whichever of your PC’s output ports has been designated as Port A; if the letter is “B”, the data will go out Port B, etc. When the "-" column is selected instead of any of the channel columns, all data will pass Thru to the specified Port on the same channel(s) on which it came in.

*Note: Thru data can only be sent to one destination at a time.*

- To pass MIDI data "Thru" to a Port and Channel, click at the intersection of the appropriate row and column, or type the desired Port and Channel values into the parameter boxes.

*Note: When a track is record-enabled in the Track Editor, the Thru button automatically assumes its port and channel assignments. In Multi Track Record mode (discussed below), however, the Thru box will remain at its current setting regardless of changes in the Track Editor, and Thru is set up in the Port and Channel Select dialog as usual.*

**Setting Meter (Time Signature) and Tempo**

Master Tracks Pro offers great flexibility in setting meter and tempo. Each measure in a sequence can have its own time signature and Click value, and you can have as many tempo changes as you like, up to one every clock pulse (there are 240 pulses per quarter note). Further, tempo can be manually changed "on the fly" as the sequence is recording or playing.

Tempo changes can be made in one of three ways:

- Using the Conductor window

- The Change Conductor dialog [Chapter 9: Advanced Editing, “The Conductor dialog”]
• The Tempo Map [Chapter 9: Advanced Editing, “Editing Meter and Tempo”], a special track in each sequence which stores all meter and tempo changes.

Note: This section discusses only setting meter and tempo for recording. For further explanation of Master Tracks Pro's meter and tempo features, see the sections referenced above.

The Conductor Window

The Conductor window is where your sequence’s tempo and meter are displayed.

To open the Conductor window or bring it to the front:

• Choose “Conductor” from the Info menu.

The button in the Conductor window’s lower left corner shows the current time signature, while the lower right button displays the Beat (rhythmic) value that is used for the metronome, Measure Counter, Measure Rulers and the current tempo in beats per minute. These settings reflect the values at the current position of the Measure Counter. If the meter and tempo stay the same throughout a piece, then these values will not change regardless of the Measure Counter position. But if there are tempo or meter changes, they will be reflected in this window as the sequence plays or as you change the Measure Counter.
To set an initial meter and tempo for the sequence with the Change Conductor dialog:

- Click the time signature button in the Conductor window to open the Change Conductor dialog.

OR

- Choose “Conductor” from the Change menu to open the Change Conductor dialog.

*Note: Don’t confuse this command and its dialog with the Conductor command on the Info menu, which opens or brings forward the real-time Conductor window on the screen."

At the top of the dialog you define the range of measures that will be affected by the change you specify. For a new sequence in which you are about to record the first track, these will be set to "From measure 1 to 1."
To set the meter:

• Click the box next to the words "Set Meter to"

• Click on the meter-setting boxes immediately to the right, and enter the new meter, one box at a time. The upper number (beats per measure) can be anywhere between 1 and 16; the lower number (beat value) must be 1, 2, 4, 8, 16, 32, or 64.

*Note: It is usually most convenient, though not necessary, to set the value in the "and Beat to" box at the same time as setting the meter. This “Beat” value is discussed more fully in the next section.*

To set the tempo:

The five commands beneath the meter and click settings are different options for setting or changing the tempo. Only one of these commands can be selected at a time.

• With the Change Conductor dialog still open, click the radio button next to the words "Set all tempos to".

• Type the initial tempo for the sequence into the data box.

When the meter and tempo are both set correctly, click the "OK" button or press the Enter key. The new meter and tempo will be displayed in the Conductor window.

*Note: The tempo indication in the Conductor window is actually the tempo in beats per minute, and so is affected by the setting of the Beat value, as described in the Click section below.*

Click (metronome)

When enabled, Master Tracks Pro’s Click sounds while recording or playing. It can be set to use your computer’s internal speaker or play a sound on your MIDI sound source, and will play at any
rhythmic value. The rate of the Click is tied directly to the current Beat value displayed in the Conductor window.

The rhythmic value selected interacts with both the meter and tempo. For example, with a meter of 4/4 and a Beat value of a quarter note, the Click will sound on each quarter note. If the Beat value is changed to an eighth note, it will sound twice for each quarter note. Choose a value which is easiest and most appropriate to work with. In 6/8 time, for example, it is more common to set the Beat value to a dotted quarter note (two clicks per measure) than to a quarter note (three clicks per measure).

The tempo indication in the Conductor window is actually the tempo in beats per minute, not quarter notes per minute. This means that changing the Beat value "scales" the tempo indication. This becomes clear by example. In the figure below, the only difference between the three versions of the Conductor window is that the Beat value was changed. When Master Tracks Pro is put into Play or Record, the middle setting will cause the metronome click to be twice as fast as the one on the left, and half as fast as the one on the right. The point is that all three of these settings are actually at the same tempo or speed. A passage of quarter notes will sound the same in all three cases. The metronome will sound faster or slower, but only because it is playing different note values. Even so, the measure click still occurs at the same rate.

The Click is affected by all tempo, and Beat value changes.
To turn the Click on and off:

- Click the "Click" button in the Transport window

OR

- Choose “Click” from the Options menu. The Click button turns yellow to indicate that the Click is enabled.

Click the button or select the menu command again to turn it off.

To set the Beat value:

- Click the meter button in the Conductor window or choose “Conductor” from the Change menu to open the Change Conductor dialog. (If you are setting the meter and tempo at the same time you may already have this dialog open.)

- The box to the right of the words "and Beat to" is the Beat value. Click the up or down arrows in the scroll bar to step the Beat value up or down, or drag the scroll box until the desired value is displayed.

- When the Beat value is set correctly, click the "OK" button or press the Enter key. The new setting will be displayed in the Conductor window.

To choose a Metronome Click sound:

The Metronome Click can use either your computer’s internal speaker or an external MIDI device to sound the Click. The Click Settings dialog defines which one will be used and, if MIDI is selected, what outgoing MIDI data will serve as the Click.

- Choose “Click Setup” from the Setup menu or double-click the Click button in the Transport window. This opens the Click Settings dialog.
• Click the "Internal Speaker" button to use your computer's speaker, or the "MIDI" button to use an external MIDI device.

• Now you must define the Click parameters in the Assign Click area. The first row in the Assign Click area, “Bar Click”, determines the MIDI note that will be sent on the downbeat of each measure. The next row, “Beat Click”, determines the note sent on each of the other beats in the measure.

When using "Internal Speaker", only the duration and pitch settings have any affect. Once you have set these, click the "OK" button to confirm your choice and close the Click Settings dialog. If you chose "MIDI", you can also set the Port, Channel and Velocity that the MIDI notes will use for the Click.

Type in the Port, MIDI channel, note name, note-on velocity, and duration for each type of Click. The duration is in arbitrary values from 1 to 8; 1 is equal to about 10 milliseconds, and 8 about 120 milliseconds.

When all the parameters are set correctly, click the "OK" button to close the window.

*Note: Most drum machines don’t respond to note durations. If you are using a drum machine to play the Click, the duration may be of no importance.*
Activating a countoff (Count)

When Count is enabled, you get one measure of clicks as a countoff before Master Tracks Pro starts to play or record. The number of beats in the countoff is determined by the meter of the first measure in the sequence. There are no Count settings.

To enable the countoff:

• Click the "Count" button in the Transport window.

OR

• Choose “Count” from the Options menu.

Both of these are toggles: when the button or the menu command is selected for the first time, Count is turned on, clicking the button again or selecting the menu command again turns it off.

Recording waits for a MIDI note (Key Wait)

When Key Wait is on, recording and playback does not begin immediately when you press either button. Instead, Master Tracks Pro waits until it receives a MIDI note before starting to record or play.

The Record or Play button will flash quickly while Master Tracks Pro is waiting.

To enable Key Wait:

• Choose “Key Wait” from the Options menu.
Filtering MIDI Data and quantizing while recording (Record Filter)

As it is recording, Master Tracks Pro can record selectively: recording only the MIDI data you wish, while filtering out any MIDI data that you don’t want. It can also quantize incoming notes while recording. Both of these functions are defined in the Record Filter dialog.

Settings in the Record Filter dialog are saved in the Preferences file.

To filter MIDI data while recording:

- Choose the “Record Filter” command in the Setup menu to bring up the Record Filter dialog.

Tip:
Some keyboards continuously generate Channel Pressure and Polyphonic Key Pressure (often referred to as “aftertouch”), despite the fact that they are not assigned to affect the sound. A MIDI controller sending out this data can fill your the available memory very quickly. Filtering this data can conserve memory in those instances.

The top section of the dialog performs the filtering function. The seven most common types of MIDI data (pitch bend, channel pressure, key pressure, modulation, program changes, notes, and controllers) are listed, each with a check box. When the box for a
data type is checked, that type of data will be recorded. If the box is unchecked, it will be filtered. The default setting is for all types to be checked, meaning that they will be recorded.

Additionally, a channel filter is available, which filters out any data that is not on the specified channel.

• Click the types of data you wish to filter to uncheck the boxes. Click unchecked boxes to re-enable recording of that data.

• Click the radio button that is marked "Data Only on Channel" to enable the channel filter. Enter the number (1-16) of the channel you wish to record in the parameter box to the right. Data on all other channels will be ignored.

• Click "OK" to confirm your settings and close the dialog.

To quantize while recording:

The bottom section of the Record Filter dialog performs record quantization. The record quantization function works similarly to the Quantize command on the Change menu [Chapter 9: Advanced Editing, “Quantize”], although it is somewhat simplified.

You can select a quantization factor using the duration icons, by typing in clock numbers, or by setting up a “tuplet”.

You can also specify how far ahead or behind the beat notes must be to get quantized one direction or another. The default setting of 35% means that notes 35% or less ahead of the beat will be moved to the next beat, while notes more than 35% ahead will be moved to the previous one.

• Click the check box marked "Quantize to" to enable record quantization.
• To define the basic quantize value you may:

1) Type the value in clocks into the parameter box to the right of the "Quantize to" legend.

OR

2) Click the up and down arrows or drag the scroll box of the note duration icon box on the right.

• Click the "Tuplet" check box if you wish to enable tuplet quantize values. Type the tuplet ratio to which you wish to quantize in the two parameter boxes to the right.

• Type a "strength" value in the "Include notes up to" parameter box if you want a value other than the default.

Note: The "strength" value is active whenever record quantizing is enabled.

Checking available memory: the Memory window

The Memory window helps you keep track of how much RAM the program is using for song files at any one time and gives a good indication of memory usage in Windows' "protected mode" environments (standard mode, enhanced mode).
To open the Memory window:

- Select the “Memory” command from the Info menu. Once onscreen, the Memory window will stay open until it is closed.

The Memory window lists the size, in kilobytes, of:

- **Free Memory:** This is the total amount of free memory available to Windows. Remember that when running in enhanced mode this figure also includes virtual memory that is not directly available to Master Tracks Pro. When in enhanced mode, the “Largest Block” figure is a better indicator of actual memory available for Master Tracks Pro data.

- **Score Size:** The amount of memory currently used by all open songs.

- **Clipboard Size:** The amount of memory currently used by the Clipboard.

- **Largest Block:** This is the size of the largest block of contiguous free memory. There may actually be additional free memory available in other, smaller blocks.

- **Record Buffer:** This is the size of the temporary buffer used for recording incoming MIDI events. When not recording, this figure defaults to 1 K, the amount needed to handle the MIDI Thru and step record functions.

The temporary record buffer used by Master Tracks Pro during recording can be as large as 1 megabyte if you have enough free memory. This allows you to record multi-track sequence dumps or long real-time pieces in a single pass.

*Note: The Record Buffer’s size can never be more than half of total free memory or 1 MB, whichever is least.*
Dealing with a memory shortage

If you encounter a memory shortage, here are a few things you can do:

- Close any sequences you are not currently working on.
- Use the Strip Data or Thin Continuous Data functions to eliminate or thin out controller, pitch bend, and/or pressure data wherever possible.
- Clear the Clipboard by choosing Erase Clipboard from the Edit menu. This frees up any memory used by the Clipboard for use in the sequence.
- Close any other applications running at the same time as Master Tracks Pro.

Basic Recording Procedure

The basic recording procedure consists of three steps:

1) Record-enable the track(s) you wish to record.
2) Set the location where recording should begin.
   
   Both of these are accomplished in the Track Editor.
3) Start Master Tracks Pro recording and stop it when finished.
   
   Recording can be initiated in the Track, Piano Roll, or Notation Editors.
   
   Recording replaces all data on the record-enabled track(s) between the point recording begins and where it is stopped. Data outside the record start and end points are unaffected.

Tip:
It’s a good idea to get in the habit of deactivating a track’s record enable right after recording it to avoid recording over it accidentally, although you can always Undo an accidental Record pass.
Any Record operation can be cancelled with the Edit menu’s “Undo” command [Chapter 8: Basic Editing, “Edit Undo”]. Since Master Tracks Pro erases existing material on a track that is being recorded, it is not necessary to use Undo before performing retakes.

**Enabling a track for recording**

A track is enabled for recording using the "R" (Record) column on the left of the Track Editor. Only one track can be selected for recording at a time, unless Multi Track Record is enabled.

**To record-enable a track:**

- Make the Track Editor the active window

- Click in the R (Record) box for the track. A red dot (•) appears in the Record box to indicate that the track is selected. (If Punch mode has been selected, a “button” icon will appear instead of the dot).

When you start recording, all incoming MIDI data will be recorded on that track. As mentioned earlier, the port and channel number in the Thru box will automatically change to match the port and channel of the track selected for recording (shown in the track’s Chnl column [Chapter 2: Getting to Know Master Tracks Pro, “The Track Editor”] near the center of the Track Editor). If you don’t select a channel, MIDI data will be echoed on the same channel(s) it is coming in on.

*Note: Channel data is always recorded. The Chnl settings affect playback only.*

**To disable a track from recording:**

- Click on the Record box of the record-enabled track. The record icon disappears. Enabling a different track will also disable a track’s record function.
Multi Track Record

Master Tracks Pro has a special mode for recording multiple tracks at once (for example, from a guitar controller with each string set to a different channel, or from two or more keyboards connected to a MIDI merger). It is called, logically enough, Multi Track Record mode. In this mode, you can select as many tracks to record as you wish. The incoming data is routed automatically so that the data from each port and channel is recorded on a track assigned to that port and channel in the “Chnl” column of the Track Editor [Chapter 2: Getting to Know Master Tracks Pro, “The Track Editor”].

Note: Multi Track Record is the only instance where the Chnl setting of a track has any effect on how data is recorded to it.

To use Multi Track Record:

- Choose “Multi Track Record” from the Options menu to enable multitrack recording.

- Record-enable the tracks on which you wish to record by clicking in the Record (“R”) column on the left of the Track Editor. With Multi Track Record enabled, you can click as many tracks as you like up to Master Tracks Pro’s maximum of 64 tracks.

To record-disable all tracks in Multi Track Record:

- Hold down the Control key while clicking on any active box in the Record column of the Track Editor.
Using a "safety" track in Multi Track Record:

For safety’s sake, and convenience when editing the tracks, we recommend using an additional track to record the entire performance.

- Set the channel on the safety track to “–”. All MIDI data coming into the designated port will be recorded on that track, regardless of channel.

- Turn Thru on, and set its channel to “–”. This lets you monitor the entire multichannel source.

An example: Using Multi Track Record with a guitar controller

Say that your guitar controller is set to transmit on channels 6 through 11, and is coming in port A. You would do the following:

- Turn on Multi Track Record

- Set track 1 on Master Tracks Pro to record on channel A6, track 2 to record on channel A7, and so on, through track 6 recording on channel A11. (See Multi Track Record figure on previous page.)

Each string will now be recorded on its own track.

Setting the location to start recording

The location where Master Tracks Pro will begin recording can be set to the measure in the Track Editor or to the clock in the Piano Roll and Notation Editors. The record start point can be set to the clock in the Track Editor using Punch mode.

Note: When starting recording on a clock between beats, recording starts at the specified time, but the Measure Counter will not start incrementing until it reaches the next beat.
With the Auto Rewind function on:

- With the Auto Rewind function on, recording will always start from the last play or record start location.

Setting the record start point in the Track Editor:

- With Auto Rewind off, click at the desired start point in the Song Editor portion of the Track Editor. The Measure Counter will jump to the beginning of the measure you clicked and recording will start from that point.

Setting the record start point in the Piano Roll and Notation Editors:

- With Auto Rewind off, click just before the beat on which you wish recording to start in either the Piano Roll or Notation Editors. The Measure Counter will jump to where you clicked and recording will start from that point, although the Measure Counter will not start incrementing until the next beat after that point.

Start recording

With everything set up, recording can be initiated in one of three ways.

To start recording:

- Click the Record button in the Transport window.

OR

- Press the Enter key on your computer keyboard.

OR

- Press the note on your MIDI controller defined as the Record key in the Remote Control Setup dialog [Chapter 2: Getting to Know Master Tracks Pro, “Basic Transport Functions: the Transport
window and Remote Control Setup”). Of course, Remote Control of Transport functions in general, as well as of the Record function specifically, must be enabled.

When Master Tracks Pro starts recording, the Record button in the Transport window turns red, the Play button green, and the Measure Counter and Current Time Indicator begin incrementing.

*Note: If the Count button is on, Master Tracks Pro will play one measure before it starts recording. If the Sync button reads "EXT" or "MTC" rather than “INT”, Master Tracks Pro will not start recording until it receives the indicated external synchronization source. [Chapter 6: Synchronization] If you are not using an external sync source, click the Sync button until it says "INT" and try recording again.*

**Stopping recording**

Recording can be stopped in one of three ways.

**To end recording:**

- Click the Stop button in the Transport window.

OR

- Press the Spacebar on your computer keyboard.

OR

- Press the note on your MIDI controller defined as the Stop key in the Remote Control Setup dialog (which can be the same one you assigned to Play) [Chapter 2: Getting to Know Master Tracks Pro, “Basic Transport Functions: the Transport window and Remote Control Setup”].

The Stop button will turn red, the Record and Play buttons gray, and the counters will stop.
When you have finished the first pass recording a new track, the program automatically play-enables the track, and the triangular Play icon appears in the track’s Play box. [Chapter 5: Playback and Track Setup, “Playback”]

Pausing recording

Master Tracks Pro can temporarily pause recording without exiting the record mode.

To pause recording:

- Click the Pause button in the Transport window or press the note on your MIDI controller defined as the Pause key in the Remote Control Setup dialog.

To resume recording from where it was paused:

- Click the Pause button or press the key again to resume recording from the pause point.

Retakes

If you don’t like a performance and wish to try it again, simply repeat the record procedure above. If you record over an existing track, you will erase it. You may use choose “Undo” from the Edit menu if you simply want to discard your take.

If you want to keep your first take and try another, record-enable a new track and mute the first take [see discussion of muting below].
Making temporary tempo changes while recording (Offset tempos)

The tempo scroll bar in the Conductor window allows you to make temporary changes in the tempo, even while a sequence is playing or recording. This tempo change is not recorded as part of the sequence, and is called an “offset tempo”. You can see the current offset tempo setting in the top of the Conductor window, while the “stored” tempo setting for the sequence is shown at the bottom. If a tempo change occurs in the Tempo Map while there is a tempo offset, the new tempo will be offset as well, by the same factor.

![Conductor window with offset tempo settings]

To change the offset tempo with the scroll bar:

• Drag the scroll box to a new value

OR

• Click anywhere in the scroll bar itself. The scroll box will move rapidly toward that location, causing a corresponding rapid change in the offset tempo setting.

• Click one of the arrow controls at either end of the scroll bar to change the offset tempo in 1-beat-per-minute increments. Click-holding on an arrow causes the offset tempo to count up or down.

Note: The offset tempo scroll bar only affects tempo when the program is in Internal sync mode. If you are using “Ext” or “MTC” sync, the scroll bar will have no effect.
To remove a tempo offset:

- Click in the Beat value field in the lower right of the Conductor window. The tempo will jump back to the stored tempo with no offset.

Naming tracks

Each track can have a name, which you can use to describe the music in the track, or to remind yourself which instrument and/or sound you’ve chosen to play the track. Track names are entered and displayed in the Name column of the Track Sheet. Track names are saved with the sequence file. Even a track with no MIDI data can have a name, so you can leave memos for yourself on them (although the Notepad function is better designed for this [Chapter 8: Basic Editing, “Notepad”]).

The Name box can be expanded (to show the complete name) or contracted (to save space) as needed.

To name a track:

- Click on the Name box of the track you wish to name. The Enter Text dialog appears. Type in the name of the track. You can use any combination of characters.

- When the track name is properly entered, click on OK or press Enter to close the window.

To expand or collapse the Name column:

- Click the heading box of the Name column.
Overdubbing and recording controllers

Overdubbing is the process of recording an additional track while monitoring some or all previously played tracks.

Selective monitoring: Play-enabling and muting tracks

Overdubbing and punching in both require the ability to selectively monitor existing tracks. You can choose any combination of tracks in your sequence to play back. The Play ("P") column on the left of the Track Editor is an on-off switch for track playback; You can only play tracks that are play-enabled in the Play column.

Tracks can be play-disabled (muted) and re-enabled during playback or recording. Newly recorded or pasted tracks are automatically play-enabled. Tracks containing no MIDI data, not surprisingly, cannot be set to play.

To play-enable a track:

- Click in the Play column of tracks you wish to hear. A green triangle will appear to indicate that the track is play-enabled. (If a track is already play-enabled, this will mute it.)

To play-disable (mute) a track:

- Click in the Play column of play-enabled tracks you wish to mute. The green triangle becomes “hollow” and turns red.

To perform an overdub:

- Play-enable and mute the existing tracks until you hear the desired combination.

- Record-enable a new track.

- Set a record start point and begin recording.
If you want to overdub a second line on the same MIDI channel as an existing track, assign another track to that channel and record your second pass on the new track. If you like, you can merge them later.

**Recording or overdubbing Volume and other controllers**

The use of volume, pitch bend, and other MIDI controllers can greatly enhance your sequences. Master Tracks Pro provides numerous ways to record and edit controller information. The method you choose is a matter of personal style and the particular task you have at hand. The Recordable Controller Faders and Master Fader offer simple ways of incorporating continuous controller messages into your sequences, though they are not the only ways: every track is capable of recording controller data just the same as note data.

Like note data, controller information can be recorded as a sequence runs or manually entered in an edit window, then edited as needed. Performing controller gestures while the sequence runs has the obvious advantage of allowing you to hear the effect of the gesture as you record it, while manually entering it offers greater precision, especially for a quick gesture.

**Should controllers be on the same track as notes?**

Controller information can be recorded onto the same track as note data or onto a separate track. Recording onto the same track means that controller data and the note data to which it applies move simultaneously in cut and paste operations. It also keeps things conceptually simple to have pitch bends, modulation, etc. on the same track as the notes it affects.

Recording onto the same track is accomplished either by performing controller moves at the same time as note data is recorded, or by using the Recordable Controller Faders in the Track Editor [see below] to overdub and merge controller data with existing data on a track. The Recordable Controller Faders can also be used to
punch-in on controller data in a track without erasing note data. (Normal punch-in recording would replace all data, including notes, in the affected area.)

Using the Strip Data command [Chapter 9: Advanced Editing, “The Strip Data command”] after recording, a simple cut and paste operation can separate controller data to its own track.

Recording or moving controller data onto a separate track makes it easier to apply the same controller gestures to different takes of a part, simply by muting and unmuting the different takes while leaving the controller data track unmuted. It is also the method to use if you want to overdub controller moves using a physical fader, such as a slider on your keyboard.

The only way to record controller and note data to separate tracks in real time is using Multi Track Record [see above]. This requires that your instrument be able to transmit continuous controller data on a different channel than note data. Failing that, controller data must be overdubbed if you wish to perform gestures and have the data on a separate track from notes. Either your physical controller or the Recordable Controller Fader for the destination track can be used for this overdub.

To record controller and note data to the same track simultaneously:

- Set up and record on a track as normal, performing controller gestures as you play.

To record controller and note data to separate tracks in real time:

- Set your MIDI instrument to send note and continuous controller data on different MIDI channels.

- Set Master Tracks Pro for Multi Track Record and record-enable two tracks, one for notes, one for controller gestures.

- Record as usual.
To overdub controller data to a separate track using a physical controller:

- Check that the note data track is play-enabled.
- Record-enable a different track for the controller data.
- Record as usual. You may also punch-in on the controller track.

The Recordable Controller Faders

Master Tracks Pro's Recordable Controller Faders are an onscreen method of recording controller gestures into a track. The most common use of Master Tracks Pro's faders is recording MIDI volume messages for level automation, but they can be set up to generate any of the 128 basic MIDI continuous controllers. (MIDI Volume is a useful part of the MIDI specification that allows a device’s overall volume to be controlled externally. It should not be confused with MIDI velocity, which is a measure of how fast a key is struck.)

When a fader is moved, the data it generates is sent out that track’s port and channel assignment, whether or not Master Tracks Pro is recording it.

*Note: Pitch Bend is a distinct MIDI message, separate from the family of continuous controllers. The Recordable Controller Faders cannot be used to generate Pitch Bend messages.*

To show or hide the Recordable Controller Faders:

- Click on the heading box of the Value column in the Track Sheet portion of the Track Editor. The column expands to become a set of faders that can be used to set an initial controller value (typically start volume) and in real time while the sequence is running to record and/or transmit controller gestures for each of the tracks. (Setting initial values is discussed in [Chapter 5: Playback and Track Setup, “Setting up Tracks”].)
• Click the heading box again to hide the faders and show the initial values for the tracks.

To show or hide the names of the faders' current controller assignments:

• Click on the heading box of the Controller column in the Track Sheet portion of the Track Editor. The column expands to show the full name of the controller currently assigned to each channel's fader.

• Click the heading box again to show only the controller numbers.

To set up the faders:

• Click in the Controller (Cntlr) column of the track for which you wish to record fader moves to open the Change Controller Number dialog.

![Change Controller Number dialog](image)

• Use the scroll bar to select or type the number of the controller you wish the fader to generate. If the Controller box was expanded to show the full name before you clicked it, any standard assignment (volume, pan, etc.) for a given controller number will be shown when you type in the number.

• Click OK to confirm your choice or Cancel to leave the assignment as it was.
Master Tracks Pro's special Fader Record mode allows it to actually merge new controller information with existing data (notes and other controllers) in a track. This means that controller gestures can be overdubbed and punched-in after an initial recording pass.

*Note: Fader recording only occurs if the track is assigned to a single MIDI channel (that is, you cannot enter Fader Record on a track while the channel box says ",-"). If a channel is not assigned before recording, Fader Record may appear to work, but the data will not be recorded. If more than one track is set to the same MIDI channel, the faders for those tracks will automatically be "ganged" (moved simultaneously).*

Multiple passes can be recorded on a track with the fader assigned to a different controller each time. Thus, a track's fader can be used to record volume, panning, and modulation, for example, into the track.

*Note: MIDI Volume is defined in the MIDI specification as Continuous Controller #7. Some MIDI instruments do not respond to MIDI volume commands and, therefore, will not be affected by a fader sending this message. See your instrument's manual for more information.*

To enable Fader Record for a channel:

- Check that the faders are currently visible.

- Check that the track on which you intend to record is assigned to any single MIDI channel (that is, a number shows in the Channel box).

- Hold down the Shift key while record-enabling the track whose fader you wish to record. A special fader record icon will appear in the box.
• Start Master Tracks Pro recording and move the fader as desired. Controller messages will be recorded into the track.

**Note:** As with recording notes, recording fader moves erases any existing data with the same controller number as the fader. If, for example, the track already contains MIDI volume changes, they will be recorded over.

**Recording controller changes in “normal” (MIDI) record mode replaces all existing data on the recorded track with the controller moves.**

**Multi Track Fader Record**

You can use the Multi Track record feature to record multiple tracks of controller changes in a single pass in either “fader” or “normal” record mode. There is no special procedure, simply enter Multi Track mode and follow the fader recording procedure above. You may have some tracks in Fader Record and others in normal MIDI Record, if you wish.

**Fader Tips:**

• If multiple tracks are assigned to the same channel, moving a fader on any of those tracks will affect all of them.

• The faders will appear “grayed out” on tracks that have not been assigned to any MIDI channel. If a track has no initial or recorded value for the assigned controller, the fader will be “grayed out” until you click on it and drag it to an appropriate position.

• On playback, enabling Follow Playback on the Options menu causes the faders to follow the changes of the controllers to which they’re assigned as the sequence plays.
The Master Fader

In addition to the Recordable Controller Faders there is a Master Volume Fader. The Master Fader scales existing track volume or controller settings.

There are two operating modes for the Master Fader:

• "Live" - This is the default mode, in which the Master Fader scales the volume settings of all tracks in real-time, but is not recorded.

• "Record" - In this mode, the Master Fader affects all Record-enabled or Fader Record-enabled tracks, scaling the current settings of whatever controller is selected in a track’s “Cltr” column in the Track Sheet by the Master Volume percentage shown just above the Track Sheet. These changes are recorded into the track.

The Master Fader can also set an initial volume for all tracks. In this instance, the Master Fader scales the initial volume setting for a track.

*Note: Since the Master Fader scales existing fader levels, it will have no effect if no initial fader value has been set for a track.*

To make the Master Fader visible:

• Choose "Master Fader" from the Windows menu

OR

• Press F5 to make the Master Fader appear.

To record Master Fader changes:

• Enable Record or Fader Record (Shift-click) on the track you wish to have affected by the Master Fader. In Multi Track Record, multiple tracks can be enabled.

• Click the Record button in the Master Fader window to enable Master Fader recording.
• Start Master Tracks Pro recording and use the mouse to move the Master Fader as desired. The changes will be recorded into the tracks.

**Notes on Master Fader recording:**

• *Because the Master Fader scales existing fader settings, all faders will reach zero at the same time if the Master Fader is faded to zero, and fade back to their initial settings if the Master Fader is raised to 100%.*

• *Recording with the Master Fader retains relative levels between tracks, but overwrites existing data for the controllers selected on those tracks.*

• *When entering Master Fader Record mode, the Master Fader is always set to 100%. If you wish to start from a different value, move it to that value before starting to record. For example, to record a fade-in, move the Master Fader to 0 after clicking its Record button but before clicking the Transport window’s Record button.*

• *When the Record button in the Transport window is pressed, the faders on all Fader Record-enabled tracks will jump, if necessary, to reflect the current scaling value of the Master Fader.*

**To set an initial volume for all tracks with the Master Fader:**

• With Master Tracks Pro stopped and the Master Fader in Live mode (i.e. with its Record button not enabled), position the Master Fader to the desired overall volume level.

• Use the “Save” command in the File menu to save the Master Volume setting with the song.

The default value for a song for which the Master Volume has not been set or has been set to 0 is 100%.
Entering controller data in an edit window

Controller data can also be manually entered, as well as edited, in the Event Editor or MIDI Data windows. In the MIDI Data windows, controller gestures can be graphically drawn with a pencil tool. For more information on these techniques, see [Chapter 10: Advanced Editing, “The MIDI Data windows and controller editing”].

Punch-in

Punching in is when a defined section of a track is rerecorded, replacing the original take in that section. Once a section has been defined, Punch mode enabled, and Master Tracks Pro started in Record, recording only takes place in the defined area, regardless of where Master Tracks Pro is started or stopped.

The In and Out points in the Transport window define a section for punch-in recording. A section of a track designated for recording (or editing) is called a "region". Punch-in and -out points can be set in any data window.

Punch-in cannot be activated unless at least one track has been record-enabled in the Track Editor. When activated, a “button” appears as the record-enable indicator in place of the dot that is normally displayed (unless you are in Fader Record mode, as described above).

There are four steps to punch recording:

1) Record-enable the track (or tracks in Multi Track Record) on which you wish to record.

2) Set the Punch-In and -Out points to define the region for recording.
3) Enable Punch mode as described below.

4) Start Master Tracks Pro recording.

After you have clicked on Record or pressed the Enter key, the track(s) selected for recording will start to record only when the Measure Counter passes the punch-in point. The track(s) will stop recording (and go back to Play) when the counter passes the punch-out point. If you start recording between the two punch points, recording starts immediately.

To set Punch points:

• In the Track Editor or any edit window, drag with the mouse across the area you wish to record. As you drag, the region will be highlighted. When you release the mouse button, the region is defined.

OR

• Double-click the Punch button or select Punch Setup from the Setup menu to open the Punch Settings dialog. Type in the values you desire and click OK to confirm them.

The Punch Settings dialog can also be useful to confirm or edit the punch points after dragging to select a region.
To enable and disable Punch mode:

- Click the Punch button in the Transport window. The button icon will go from gray to red and blue to indicate that Punch mode is enabled and the record-enable icon in the track’s Record column will change to a special punch-enable icon. Click the button again to disable Punch mode.

**Step-Time Entry and inserting notes with the mouse**

It is often desirable to enter notes without performing them as the sequence runs. One of the beauties of MIDI sequencing is that it is possible to create music that you may not be able to actually play in real time, perhaps because the passage is particularly difficult (such as a very complex polyrhythm), or simply because your controller is a keyboard but you’re not a keyboard player.

Master Tracks Pro offers two very flexible methods of non-real-time entry in the available in the Piano Roll and Notation Editors: step-time entry and entering notes with the mouse. Both of these methods are covered in detail in [Chapter 8: Basic Editing]. It is also possible to enter individual notes in the Event Editor, though the technique is somewhat different. This, too, is discussed in Chapter 9.

Step-time and mouse entry are both performed with the following basic steps:

- Select a track for entry.
- Engage the desired entry mode (step-time or mouse).
- Select the point where entry should begin.
- Choose a rhythmic value (and, in mouse entry, other note parameters) for note entry.
- Enter the note.
The difference comes in how the pitches are entered: in step-time entry they are played on your MIDI controller, while mouse entry lets you point to the desired pitch with the mouse and click to enter it. Notes entered with step-time or mouse entry can, of course, be deleted or individually edited.

Often, it is useful to go back and forth between these two methods, perhaps in conjunction with real-time entry. This flexibility is what makes Master Tracks Pro so powerful and fast to use.

**Recording with an external synchronization source**

Master Tracks Pro can record while locked to MIDI Time Code (MTC) or MIDI Clock and Song Position Pointer. A full discussion is found in [Chapter 6: Synchronization].

- If you are using MTC, be sure you have selected the proper SMPTE format in the Sync Setup dialog brought up the Setup menu command.

- Click the Sync button in the Transport window until the correct source is displayed: "MTC" for MIDI Time Code or "EXT" for MIDI Clock and SPP.

When Master Tracks Pro is put into record, the Record button will turn red and the Play button green, but the program will wait until it receives valid sync information before starting to record.

**Sysex**

Sysex is a feature that allows you to send and receive MIDI System Exclusive (sysex) data, such as synthesizer patches, to and from the MIDI devices in your system. You can store this data in files on disk, and then retrieve it at any time to send to your instrument. Since each instrument has a different System Exclusive data format, you can only do “bulk dumps” with Master Tracks Pro.
That is, you can store and send data as one continuous file which cannot be edited.

Notes on Sysex:

- **Master Tracks Pro only supports System Exclusive transfers to and from MIDI devices that do not require “handshaking”.** Consult your owner’s manual to see if your particular device requires handshaking.

- **The largest block of sysex data that Master Tracks Pro can handle at one time is slightly less than one megabyte in size. This is fine for most patch dumps but may not be enough for larger chunks of sysex data such as sample dumps.**

- **If your computer runs at 25 MHz or less, you should run Windows in Standard mode when using the Sysex feature.**

Receiving System Exclusive Data

Before you can receive System Exclusive messages from your synths or other MIDI devices, you’ll need to know how to send them from the devices. Consult your owner’s manuals for instructions.
To receive System Exclusive data:

- Choose Sysex from the Setup menu to open the System Exclusive dialog.

- Click on the Port Selection button at the bottom of the dialog for the port from which you wish to receive the System Exclusive messages.

- Click on the Receive button in the dialog. The Status box will say "Waiting to receive messages". Master Tracks Pro will remain in Receive mode until the Stop button is clicked.

- Instruct the transmitting device to start sending.

Master Tracks Pro will now record any system exclusive data it receives into its sysex buffer. You may send sysex dumps from a number of different devices, one at a time, to the buffer while Master Tracks Pro is in Receive mode. These may then be stored as a single file, enabling all the programs from the devices in your studio to be stored in a single file.

To assist you in recording multiple system exclusive messages in a single file, the program displays a count of the number of messages it receives. In addition, each time a new message is received, the program attempts to identify the System Exclusive ID byte sent with the message. If it is successful, it will display the manufacturer’s name in the dialog’s Memo field. You can receive up to 512 separate system exclusive messages in one file.

- Click the Stop button when you’ve finished sending system exclusive data from the device(s) to Master Tracks Pro.

- Click in the File Name field and type in a name.

- Type any notes you may have about the data into the Memo box.
Note: After receiving sysex from a device, it is useful to make a note of the device’s channel number in the Memo area of the Sysex dialog. Master Tracks Pro records the Device ID of the source, which is usually the MIDI channel on which the sysex is received, and sends it on that channel when transmitting it. The receiving device will not "see" the data if it is not set to this channel. Therefore, it is important to remember the channel.

• Click on Save to save the data to a file on disk.

• Type a file name into the standard file dialog that opens. The extension ".SX" is used for Master Tracks Pro Sysex files. Click OK to save the file.

• Click the Quit button to close the Sysex dialog. If the buffer contains messages that have not been saved, Master Tracks Pro will prompt you to save or discard them.

To send System Exclusive data:

• Choose Sysex from the Setup menu to open the System Exclusive dialog.

• Click on the Port Selection button at the bottom of the dialog for the port to which you wish to send the System Exclusive messages.

• Click the Open button and use the standard file open dialog that appears to select the sysex file you wish to send.

• Prepare the device to receive System Exclusive. Consult the device's owner's manual for this procedure.

Note: Master Tracks Pro uses the Device ID received with the sysex data as the channel on which sysex data is sent. The destination device must be set to this channel to receive the data.
• Click the Send button in the dialog. The entire file will be sent. The status box will indicate that sysex data is being transmitted. Most devices will also give an indication that they are receiving sysex messages.

• Repeat the procedure as often as needed. When you’ve finished your System Exclusive operations, click the Quit button to close the Sysex dialog.

**Loading and Sending multiple messages**

Since Master Tracks Pro records the Device ID (which is typically the transmitting channel) of incoming sysex data and uses it to determine the channel on which that data will be transmitted, it is possible to record multiple sysex dumps with different channels into a single file.

To save all of the patches associated with a particular sequence:

• Set each MIDI device to a different channel

• Put Master Tracks Pro into Receive Sysex mode as described above.

• Dump the contents of each device consecutively while the “Receive” button is highlighted in the Sysex dialog.

• Save all of this information as one file, as described above.

To reload all your equipment with the patches for the sequence:

• Set each MIDI device to the proper receive channel and enable it to receive sysex using the procedure described in its owner's manual.
• Open and send the desired sysex file as described above.

*Remember:* Make a note of each device's channel number so that when you send the sysex data back at a later date, the right devices will be sent the right data.
This chapter discusses Master Tracks Pro’s playback features and setting up and working with tracks in the Track Editor.

**Setting up tracks**

**Moving tracks**

In the Track Editor, you can reorder the tracks freely. This can be useful for grouping all of your drum and percussion tracks together, lining the tracks up in order of channel number, or any number of other reasons.

To move a track in the Track Sheet:

- Click and hold the mouse button down on the track number at the far left side of the Track Sheet. A box will appear around the entire track to show that it is selected.

- Drag the track up or down to its new position. If there is already a track in the new position, it will be pushed aside to make room for the track you are moving. All of the track’s data in the Track Sheet and Song Editor will move with it.

Master Tracks Pro always fills in track slots the best it can. If, for example, you move Track 1 to the Track 9 slot, Tracks 2 through 9 will get pushed up one position. If you move Track 11 to the Track 3 slot, Tracks 4 through 10 will get pushed down.
Copying track parameters

Master Tracks Pro allows you to copy the Track Sheet parameters of a track (name, channel, program, record/play status, etc.) to another track without affecting the destination track’s MIDI data. This can be an effective tool for quick re-orchestration of complex files.

To copy track parameters to a different track:

• While holding down the Shift key, click and hold the mouse button down on the track number at the far left side of the Track Sheet. A box will appear around the entire track to show that it is selected.

• Drag up or down to the destination track and release the mouse button. The Track Sheet parameters will be copied to the new track. If the destination track contains no data, it will not be play-enabled. It will, however, become play-enabled as soon as you put any data in it.

Note: If the source track is record-enabled (a “•” appears in the “R” box), then the destination track will become record-enabled and the source track will be record-disabled (unless Multi-Track Record mode is on).

Setting a track’s playback channel

The Chnl (Channel) box on each track contains its current MIDI channel setting for playback. To use this feature, you need a little background on the way the program handles MIDI channel information.

Master Tracks Pro supports multiple-channel tracks. In normal (MIDI) record mode you can record any combination of channels within a single track. Each recorded note has a channel assigned to it, defined by the transmitting channel of the device used to
perform the data (i.e., the master controller or keyboard). When you mix or merge tracks, the channel identity of every note is retained, so that within a single track you can have notes assigned to many different channels.

If a number between 1 and 16 is entered into a track's Channel box, all data on the track will be played on that MIDI channel, regardless of the channel assignments that were recorded. It is important to note, however, that this only affects playback: recorded channel assignments are unchanged.

If a dash (“–”) appears in the Chnl column, the track is unassigned, and will play back exactly as recorded, each note playing on the same MIDI channel on which it was received.

In Multi Track Record mode, the Port and Channel assignments apply to incoming as well as outgoing data. Only MIDI data received on the assigned MIDI channel and port (as set in the Channel column) will be recorded on a track. If you want all MIDI data coming in a port to be recorded, enter a “–” instead of a channel number.

To set a track's channel assignment:

- Click in the track’s Chnl box in the Track Sheet to open the Port and Channel Select dialog. The dialog's rows represent ports and the columns MIDI channels.

- Click at the intersection of the row and column representing the desired port and channel number or type the values in the Port and Channel boxes at the top of the dialog. Enter a dash (“–”) or click in the leftmost column to play the track’s MIDI data on the channel(s) on which it was originally received. Click "OK" to confirm your choice and close the dialog.

*Note: Remember that in normal Record mode, the Transport window’s “Thru” setting follows the channel and port of any record-enabled track.*
Anote on the ports

Master Tracks Pro can support up to 16 ports, provided you have a compatible multiport interface, such as the MIDI Time Piece II, MIDI Express PC, 8Port/SE, or MQX-86, or several separate interfaces. This effectively gives you up to 256 discrete channels for MIDI playback. The Port designation in the Track Editor denotes to which software port a track will be assigned. Translating these settings into a hardware port (i.e., which physical port corresponds to which software port) is the job of the MIDI Setup dialog box, selected from the Setup menu. See [Chapter 10: Menu and Window Reference, “Setup”] for more details.

Setting the Initial Program

A “program” is the MIDI term for an individual “setup” or “patch” on a MIDI device, which is stored in that device’s memory. On a synthesizer or sampler, a program is customarily equivalent to a particular sound (e.g., trumpet, bells, dog bark), while on a drum machine a program may be a particular song, and on a MIDI effects device it may be a particular pre-programmed
effect (e.g., long reverb, flange, distortion). Each program in a device is identified by a number, and each MIDI Program Change message contains a number. Sending a Program Change message to the device causes it to recall the program whose number corresponds to that in the message.

*Note: Although MIDI technically defines 0-127 as the available program numbers, Master Tracks Pro (as well as many devices) uses 1-128 for greater ease of understanding. Some devices use altogether different numbering schemes, frequently to organize programs into banks. For example, Roland devices often number programs 11-18, 21-28, 31-38, etc. It is necessary to determine the correspondence between the device’s numbering scheme and the MIDI program number in order to know which program change to send to recall a specific desired program from memory. In the case of a Roland device with the bank numbering scheme named above, MIDI program change 9 would recall memory 21.

Further, some devices have the ability to arbitrarily map incoming program changes to device memories. This must also be taken into account to know which program change number to send. Check your device’s manual for more information on this.

Although Master Tracks Pro allows you to record program changes at any point in a track, the Program column in the Track Sheet also enables you to set up an initial program change for each track. When playback is started from the beginning of the song, the initial program change is sent on the track’s assigned channel before any notes play. This insures that your devices will have the right sounds (or effects) for playback every time.

The Program Change function in the Chase Controllers dialog (see later in this chapter) enables initial program changes for all tracks to be sent before the song starts to play, regardless of where in the sequence playback begins. However, if there are other program changes in the sequence, the latest program change prior to your starting point will be sent for each track.
The Prg (Program) column

The Prg column can be displayed in either of two states: collapsed or expanded. When the Prg (Program) column is in its collapsed state, it displays only MIDI program change numbers from 1 to 128. In its expanded state, the Prg column can show the actual program name as stored in the device, through the use of the Device dialog discussed below. The Device dialog is also used to choose a track’s initial program change.

To change the Prg column between the collapsed and expanded states:

- Click on the Prg column heading box. The column will expand if it was collapsed, or collapse if it was expanded.

If the Program column for a track is showing the default value, “–” (in the collapsed state) or “None” (if it is expanded), no program change is sent when the song begins. In this case, your instrument will remain set to whatever program it was already on, until it receives a program change from within the sequence (if there are any).

**Note: An initial program change can only be sent if the track is assigned to a specific channel. If the track’s Chnl assignment is “–”, no program change is sent because the software has no way of knowing on which channel it should be sent.**

The Device dialog

The Device dialog, available only when the Prg column is in its expanded state, lists the Program Names for a specific device (MIDI instrument) on each track, and is used to assign an initial MIDI program to a track. Lists of program names (factory presets) for several popular devices, including General MIDI, are supplied with Master Tracks Pro. You can also create your own lists of program names to add custom or new instruments to the list.
To open the Device dialog:

- Click in a track’s Prg box to open the Device dialog.

In the Device dialog you can see a drop-down list box displaying the current device (the default is “Generic”), a list of the programs available for that device, the program name and MIDI program number of the current program (if one is selected) and a button labelled “Device Operations” for customizing the lists. There is also a check box for copying the current device to all of the tracks in your song.

To select a different program for the current device:

- Click on a name in the program list. When the name is selected, the corresponding MIDI program change is transmitted in real time. The program number and name will be displayed in the boxes at the top of the dialog.

OR

Double-clicking a program name in the Device dialog will select it and close the dialog.
• Use the Tab key to make the name list active. Your computer’s arrow keys will now move the selection around the list.

OR

• Type the program number in the Number box at the top of the dialog. The name will appear in the Name box and the corresponding program will become highlighted in the list.

To set an initial program change for a track:

• Click in the Program column for the track to open the Device dialog.

• Select the desired program in the Device dialog as described above. Click OK to confirm your choice. The Program column will show the number (when it is in the collapsed state) or name (when it is in the expanded state) of the selected program.

To change a program name:

• Select a program from the list using one of the methods listed above. The program name will appear in the “Name” box at the top of the dialog.

  
  Number: 101  Name: Brightness

• Type in a new name or edit the existing name in the Name box. Click "OK" or select another name from the list to enter the new name.

To audition programs:

• Select a program from the list using one of the methods listed above.

• Click the Play button at the bottom of dialog to start playback of the song using the selected program.
To make the track name the same as the selected program:

- Click in the “Copy Program Name To Track Name” check box below the program number and name.

  **Copy Program Name To Track Name**

To select no initial program change:

- Click the “None” radio button located between the Device Name box and the Program Name list.

To select a different device:

- Click the arrow at the right of the Device Name box. The Device list will drop down.

  ![Device List]

- Click on the name of the device you wish to assign to that track. Use the scroll bar, if necessary to see devices in the list that are not visible. When you click on a name, the drop-down list will close and the corresponding program names will appear in the program list.

OR

- Use your computer’s up and down arrow keys to move the selection up and down the list. Press the Enter key to confirm your choice.

**Tip:** Choosing “Preferences” from the File menu will cause the current device to be chosen by default when you open new files.
To add a new device:

- Click the Device Operations button.
- Click “Add New Device” in the drop-down menu that appears to open the Add New Device dialog.
- Enter the name of the new device and an abbreviation for it. Click “OK” to confirm your choice and return to the Device dialog.

The abbreviated device name will appear with the program name in the Prg column in its expanded state whenever you choose a program for that device, unless you have chosen Hide Device Names in the Layout menu.

- Use the program name editing procedure described above to enter program names for the new device.

OR

- Clone an existing device as described below.

To delete a device:

- Select the device you wish to delete from the Device Name drop-down menu, as described above.
- Click the Device Operations button
- Click “Delete Current Device” in the drop-down menu that appears. Master Tracks Pro will bring up a dialog to confirm that you are sure you want to delete that device.
• Click "OK" to delete the device.

*Note: The Generic and General MIDI devices cannot be deleted.*

To rename a device:

• Select the device you wish to rename from the Device Name drop-down menu, as described above.

• Click the Device Operations button

• Click “Rename Current Device” in the drop-down menu that appears to open the Rename MIDI Device dialog.

• Type in a new name and abbreviation or edit the current ones. Click "OK" to confirm your choice.

To clone a device:

If you have two or more of the same MIDI device, you will probably want to differentiate between them on the Track Sheet. The Clone feature allows you to create multiple copies of the same device.

• Select the device you wish to clone from the Device Name drop-down menu, as described above.

• Click the Device Operations button

• Click “Clone Current Device” in the drop-down menu that appears to open the Clone Active Device dialog.

• Enter the name of the clone device (for example: If you are cloning the Korg M1, you may want to name the clone “Korg M1 #2”). Click “OK” to confirm your choice and return to the Device dialog.
Note: Remember to change the device’s abbreviated name, so that you can differentiate between multiple copies of the same device in the Track Sheet.

To save a device file:

Your custom device setups can be saved to and loaded from disk. This enables you to easily transfer them to other computers running Master Tracks Pro, load only those devices utilized in the current song, or load your device setups into future updates of Master Tracks Pro.

• Click the Device Operations button.

• Click “Save Device File”. The standard Windows file save dialog will appear.

• Locate the place where you wish to save the file and enter the desired name. Click "OK" to confirm your choice and save the file.

To load a device file:

• Click the Device Operations button.

• Click “Load Device File”. The standard Windows file open dialog will appear.

• Locate the file you wish to load. Click "OK" to confirm your choice and load the file.

To select a device for a different track:

The Track button allows you to change tracks for device selection without leaving the Device dialog.

• Click the “Track = (#)” button in the upper right corner to open the Select Track Number dialog.
• Type in or use the scroll bar to select the number of the track for which you wish to assign a device. Click "OK" to confirm your track.

Bank-specific Device files

The MIDI specification includes a Bank Select message to facilitate working with devices with sounds that are stored in banks. Master Tracks Pro allows you to associate MIDI device files with a specific MIDI bank number. The default device files that are setup when the program is installed do not contain any bank information but several bank-specific files are copied into the devices directory during installation. You can add one or more of these files to your list of devices by using the Load Device option in the Program Change dialog.

Once a bank specific file has been added to your list of devices, the bank number associated with that device will be automatically placed in the bank number field of the Device dialog.

We have provided starter files for banks 0 through 9 named BANK0.INI through BANK9.INI. These files are set up to correspond to the alternate banks that are available on Roland GS style MIDI gear. If you have different MIDI gear, you can edit the program names to correspond to the alternate banks that are available on your gear.

If you need to setup device files for banks greater than 9, or for additional devices using banks 0-9, you can add the bank number to any existing device file manually by using the Windows Notepad application or other text editor.

To select a bank for a device:

• Type the desired bank number into the “Bank” numeric box to the left of the Track button at the top of the dialog.

OR
• Use the Windows Notepad (NOT the Notepad opened from Master Tracks Pro’s Info menu) or another text editor to open the .ini file for the device you want to have a bank select number.

• Anywhere below the line that says “[DEVICE]”, type “BANK={#}”, with {#} being the desired bank number. These bank numbers can refer to either normal or Roland GS style banks.

Note: If you are using Roland GS gear it is up to you to select the Roland GS check box in the Device dialog to ensure that the bank messages are inserted and sent out correctly.

Copying a device to all tracks

The “Copy Device To All Tracks” check box changes the program names of all tracks to the program names of the currently selected device. The program numbers are not changed, nor is the actual MIDI Program Change message that is sent.

To copy a device name to all tracks:

• Click the “Copy Device Name to All Tracks” check box just above the Program Name list. The selected device will be copied to all tracks.
This action is made clear by an example:

Say that track 1 is set to Korg M1 program 1 (“Universe”) and that you are currently selecting a program for track 2, which is set to the General MIDI device. Before closing the Device dialog, you click the “Copy Device To All Tracks” check box. When the dialog closes, the device for track 1 (and all other tracks) will be changed to General MIDI. The program number for track 1 will stay at “1”, so track 1 is now set to General MIDI program 1, “Acou Grand”.

Note: If you have two tracks assigned to the same MIDI channel and port, make sure that you send an initial program change on only one of them. Sending two program changes on the same channel at the same time will yield unpredictable results.

Showing and hiding device names in the Prg column

To hide device names from appearing in the Prg column:

Sometimes the Prg column can appear somewhat cluttered with all the device abbreviations at the beginnings of the names.

• Choose the Hide Device Names command from the Layout menu to remove device abbreviations from the Prg column.

To show device names in the Prg column:

• Choose the Show Device Names command from the Layout menu. This command is only visible if device names are currently hidden.

To exit the Device dialog and return to the Track Sheet:

• After making all device selections, click the "OK" button to return to the Track Sheet.
The Controller column

The Controller (Cntlr) column allows the selection of a MIDI continuous controller for each track. An initial value of the selected controller can be set in the Value column, discussed below, which is sent when playback begins. The most common use of this feature is to set an initial volume (controller #7) value for the track. The Cntlr column can also be used to select controllers for recording with the graphic faders.

The Cntlr column, like the Prg column, has collapsed and expanded modes. In the collapsed mode, only the MIDI Continuous Controller number is displayed. By general agreement between MIDI manufacturers, the functions of some controller numbers have been given standard assignments, such as volume, pan, sustain pedal, and so forth. Expanded mode will show the name of any controller with a standard assignment. [Appendix B: Standard MIDI Controllers]

To change the Controller column between the collapsed and expanded states:

- Click on the Cntlr column heading box. The column will expand if it was collapsed, or collapse if it was expanded.

To set a controller number:

- Click in the Cntlr box of the track for which you wish to assign a controller to open the Controller Number dialog.

- Type in or use the scroll bar to select the desired controller number.
• Click anywhere in the scroll bar or use the Tab key to make the scroll bar active and use the up and down arrow keys to increment or decrement the controller number.

If the column is in the expanded mode it will display the names of any controllers with standard assignments. Click "OK" to confirm your assignment.

The Value column

Like the Prg and Cntlr columns, the Value (Val) column has two modes. The collapsed (numeric) mode lets you view the initial controller value as a number. The expanded (graphic) mode lets you view and record controller changes in a track with a graphic Recordable Controller Fader. For information on recording controller changes, see [Chapter 9: Advanced Editing, “The MIDI Data windows and controller editing”].

When playback is started at the beginning of a song, the initial controller value displayed in the Val column is transmitted for each track for the controller indicated in the track’s Cntlr column over the channel indicated in its Chnl column. As with initial program changes, initial controller values can be sent when starting playback from any point within the song if the “Controllers” item in the Chase Controllers dialog (see below) is enabled.

MIDI Continuous Controllers can have values between 0 and 127. If the Val column is set to a dash ("-"), no initial value will be sent for that track.

Note: As with the Prg parameter, if the track has no channel assignment, no initial controller value will be sent, regardless of the settings of the Cntlr and Val parameters.
To change the Value column between the collapsed and expanded states:

- Click on the Val column heading box. The column will expand if it was collapsed, or collapse if it was expanded.

To set an initial controller value with the Val column collapsed:

- Check that the desired controller number is showing in the Cntlr column for the track and that Master Tracks Pro is stopped.

- Click in the Val box of the track for which you wish to set an initial controller value to open the Controller Value dialog.

- Type in or use the scroll bar to select the desired value. Click "OK" to confirm your assignment.

To set an initial controller value with the Val column expanded:

When the Val column is expanded, the value is shown as the position of the fader and there is no numerical indication. Therefore, setting an initial controller value is only recommended if you wish to play the instrument while you set the value by ear.

- Check that the desired controller number is showing in the Cntlr column for the track and that Master Tracks Pro is stopped.

- If the Val column is not in expanded mode, click the column header to make the Recordable Controller Faders appear.

- Drag the fader to the desired position. The value is now set.

To set the initial volume for a track:

- Set the Cntlr number for the track, as described above, to “7”.

- Set the Value, as described above, to the desired initial volume.
Playback

There are three steps to play a song back:

- Play-enable the tracks you want to play and check that the MIDI channel for each track agrees with the MIDI device that you intend to play it on.

- Locate the Measure Counter to the point in the song where you want to begin playback.

- Start playback.

Play-enabling and muting tracks

You can choose any combination of tracks in your song to play back. The Track Sheet’s “P” (for Play) column will display a small triangle if a track is play-enabled. Newly recorded or pasted tracks are automatically play-enabled. Tracks that are not play-enabled, even if they contain MIDI data, will not play. Tracks can be muted and reenabled during playback and recording. Tracks that contain no MIDI data, not surprisingly, cannot be set to play.

To play-enable a track:

- Click in the Play column box that corresponds to the track you wish to play-enable. A small triangle will appear to indicate that the track is enabled.

To play-disable (mute) a track:

- Click in the Play column box that corresponds to the track you wish to mute. The triangular Play icon will become “hollow”.

Setting the playback point

The point at which playback starts (playback point) is determined by the Measure Counter. When Auto Rewind is enabled, playback always starts from the last Play or Record start point. When it is disabled, the playback point can be set with any method of setting the counter.

To enable or disable the Auto Rewind function:

• Click the “Auto” button in the Transport window to enable the Auto Rewind function. Clicking again disables it.

OR

• Choose “Auto Rewind” from the Options menu to enable or disable the Auto Rewind function. A check mark appears next to the command when Auto Rewind is enabled.

OR

• Press the “,” (comma) key on your computer keyboard to enable and disable Auto Rewind.

To set a play or record start point for Auto Rewind:

• With Auto Rewind disabled, set the Measure Counter to the desired start point.

• Click the “Auto” button in the Transport window to enable the Auto Rewind function. Playback or recording will always start from the designated point until it is changed.

To set the playback point of a song in the Transport window:

• Click the Head or Tail button to locate to the beginning or end, respectively, of the song.
OR

- Click the Fast Forward or Rewind button once to move the counter (and, therefore, the start point) forward or backward, respectively, by one measure. Clicking and holding on one of these buttons causes the counter to increment for as long as the mouse button is held down.

OR

- Click on the Measure Counter and enter the desired start point. Press Enter to confirm your setting.

To set the playback point of a song in an Editor:

This feature is useful when you want to hear just a part of a song for editing purposes. You can also use it as an alternative to the fast forward and rewind buttons on the Transport window.

*Note: In the Piano Roll, Notation and MIDI Data Editors, it is necessary that the arrow pointer in the Control Bar be selected before setting the playback point.*

- With the Auto Rewind function off, place the cursor (by pointing and clicking) at the point from which you want to start playback. (You may need to scroll the display to see the desired start point.) The Measure Counter will reset itself to this measure and the next time you click Play or Record, the song will start from this point. Enable Auto Rewind to make the sequencer start from this point every time.

In the Song Editor, the start point can only be placed at the beginning of a measure. In the Piano Roll, Notation and MIDI Data Editors, it may be placed with resolution down to a single clock by watching the pointer position display while placing the start point.
**Note:** The resolution to which the start point can be placed is affected by the zoom level. Zoom in if you are unable to locate the pointer position display to the point you need.

**Chasing Controllers**

Master Tracks Pro’s “Chase Controllers” command overcomes the offset problems that often occur with program change and controller data when starting and stopping playback at different points in a song. If playback is stopped in the middle of a controller gesture, the MIDI device receiving the controller data will continue to use the last valid controller value it received until it receives another.

If, for example, the gesture is a pitch bend, resuming playback at a different point in the sequence would result in all pitches sounding with an offset equal to the last valid pitch bend value. If the controller in question is Volume (controller 7) and playback is stopped at the end of a song containing a fade-out, resuming playback in the middle would produce no output until another volume message is encountered. The same is also true of program changes: stopping playback and starting again elsewhere could leave the MIDI device playing the wrong sound.

Enabling Chase Controllers causes the program to look backwards over the entire sequence when playback is started at a point other than the beginning, to find any program changes, controller changes, pitch bends, and/or aftertouch commands occurring on each track prior to the play start point (including the initial program changes and volume settings in the Track Editor window). For each type of message enabled in the Chase Controllers dialog, the most recent message found on each track is sent out before playback begins, updating all MIDI devices to their proper state. If there are messages from several controllers in a track, the most recent message for each controller number is sent out.
The Chase Controllers command opens a dialog that allows chasing to be enabled, as well as select the types of data that will be chased. Controller data can be further selected by selecting all controllers to be chased or specifying up to four controller numbers to either be chased or ignored. Typically, all data is selected for chasing.

To enable controller chasing:

- Choose “Chase Controllers” from the Options menu to open the Chase Controllers dialog. [fig23]

- Click in the check box marked “Enable Chasing” to turn the function on.

- Click in the check boxes for all the data types you wish to have chased. When a box is checked, chasing is enabled for that type. Click “OK” to confirm your selection.

The Chase Controllers dialog offers three options for MIDI continuous controllers: chasing all, chasing only selected controllers (up to four), or excluding selected controllers from chasing (up to four).
To enable chasing for all controllers:

- Click the “Controllers” check box.

- Click the “All controllers” radio button immediately below the “Controllers” check box.

To enable chasing of selected controllers only:

- Click the “Controllers” check box.

- Click the “Only controllers” radio button.

- Type up to four controller numbers that you wish chased into the numeric boxes to the right of the “Only controllers” legend.

To exclude selected controllers from being chased:

- Click the “Controllers” check box.

- Click the “All controllers except” radio button.

- Type up to four controller numbers that you do not wish chased into the numeric boxes to the right of the “All controllers except” legend.

Starting playback

You can start playback in one of three ways:

- Click on the Play button in the Transport window.

OR

- Press the Space Bar on your computer’s keyboard.

OR
• In the Remote Control Setup dialog [Chapter 2: Getting to Know Master Tracks Pro, “Basic Transport Functions: the Transport window and Remote Control Setup], assign a key on your MIDI keyboard to start playback.

Once you start the song with one of these controls, the Play button becomes highlighted and the song will normally begin to play immediately. (Once play begins, scrolling in any window has no effect on what you hear.) However, there are two conditions under which it will not play:

• If the Count button is highlighted, you will get a one measure count-in before the song starts, either from your PC’s speaker or over MIDI, depending on how you have configured the Click Settings (Options menu). If you don’t hear anything at all during the count-in, it may be that you have assigned the click to a MIDI channel that has no receiving device assigned to it.

• If the Sync button (lower-right corner of the Transport window) is set to “MTC Sync” or “EXT Sync”, the program will wait for an external MIDI timing signal of one kind or another before starting. Click on it once or twice until it says “INT Sync” (If you have already tried to start the song, you will have to click on “Stop” or press the Space Bar again before you can change this parameter).

During playback, you can change the tempo of the music by using the scroll bar in the Conductor window to set an Offset Tempo [Chapter 5: Playback and track setup, “Making temporary tempo changes”]. You can also switch between windows while the song is playing, examine data, and even edit in any part of any track without interrupting playback.
Setting the display to follow playback:

You can set Master Tracks Pro to scroll through the sequence data during playback in all Editors except the Event Editor. The advantage of turning Follow Playback off is that you can freely examine and work on different sections of the track while it is playing, without the window constantly resetting itself to show the current measure.

- Choose Follow Playback from the Options menu. In the Track Editor, a vertical highlight bar will move along the track data as the song plays, to indicate the measure that is currently playing. In the Notation, Piano Roll and MIDI Data Editors, a highlight moves in the measure ruler near the top of the window to show the measure currently playing.

Previewing notes

You can “preview” what individual notes will sound like on the track. Besides reminding you what a particular track sounds like before you enter data into it, this feature is very useful for drum machines or samplers with split keyboards, in that you can look for a sound associated with a particular pitch easily without going to your keyboard or recording any data.

To preview notes in the Piano Roll or Notation Editor:

- Position the pointer over a note in the data area you want to hear.

- Click the right mouse button to sound the note. The pointer turns into a hand, with one finger pointing up as the note plays on the MIDI channel indicated for the track in the Track Editor, at the velocity shown in the Piano Roll Editor’s velocity box. The note will continue to sound for as long as you hold the mouse button down.

You can re-trigger the note by releasing and pressing the right
mouse button. Click-dragging the mouse will cause each note the pointer passes over to sound.

Soloing tracks

The Solo command gives you an easy way to play back one or more selected tracks without having to individually mute all the other tracks. You may solo as many tracks as you wish; all tracks not soloed are muted.

To solo a track:

• Click in the “S” (Solo) column of the Track Sheet for the track you wish to solo. A small diamond will appear in the box. Repeat for any other tracks you wish soloed. To turn solo off, just click on the box again; all tracks will play again.

To turn Solo off for all tracks:

• Hold down the Control key while clicking in the Solo box of any currently soloed track.

Looping

Each track in a Master Tracks Pro sequence can be looped independently. A looped track plays from the playback point to the end, then jumps back to the beginning, repeating this process continuously for as long as the song is playing. Because a track can only end on a measure boundary, a looped track always plays to the end of its last measure before jumping back, even if there is no MIDI data in that measure. Empty measures at the end of a track can be trimmed, if desired, as described in [Chapter 8: Basic Editing, “Deleting measures”].
Looped and unlooped tracks can play at the same time; unlooped tracks will play linearly without jumping back to the beginning.

To turn looping on and off for a track:

- Click in the “L” (Loop) column of the Track Sheet for the track you wish to loop. A U-shaped arrow will appear in the box. Repeat for any other tracks you wish looped. To turn looping off, just click on the box again.

To turn looping off for all tracks:

- Hold down the Control key while clicking in the Loop box of any currently looped track.

Note: You must start playback at a point within the looped track to hear it. If playback starts at a point after a track has ended, you will not hear that track, even if the track is set to loop.

Tips on using loops

Individual tracks can be looped during playback. This feature is especially useful with short repeating sections such as bass or drum parts. Loops encourage speed and spontaneity in music-making and also save memory. Use them to work out your ideas.

To take advantage of this feature, record the part you want to loop, then edit it if necessary. Trim the loop using the Cut command (not Clear) to get the proper number of measures to loop. A track can end previous to the end of the sequence (which is indicated by the gray vertical bar). A track ends where there are no more filled or hollow measures present on the track in the Track Editor. Turn on the track’s loop control and let the part play back. You can lay down other parts or even other loops against it by recording on other tracks.

Remember that the loop is only stored in memory once, and always jumps back to the beginning of the sequence. If data in a
looped track starts at measure 6, then each time the track loops it will play five measures of silence, because the loop includes the first five (empty) measures.

If playback is started in the middle of a sequence, a looped track will play to the end and then loop back to the beginning, but if you start playback past the point where the looped track ends, the track will not play back at all.

Once your song or song section is complete, you can copy and paste the looped part into the track until it can play to the end of the sequence without looping. This will give you the flexibility of Master Tracks Pro’s song structure, and it will also let you create subtle variations in the loop each time it plays using the Change menu or other regional editing commands. Once you have copied your looped part you can append as many copies of it as you like by repeatedly selecting Paste or Mix Data. The insert point automatically moves to the end of each paste.

Master Tracks Pro’s loop feature requires you to play a looped track to the end of the last measure, but it is still possible to loop a phrase that ends in the middle of a measure by re-barring the last measure of the track.

Let’s say you’re working in 4/4 time but you want the track to loop a two-and-a-half-bar phrase. Here’s how to do it:

• Select measure 3 (which should be the last bar of the track) and choose Conductor from the Change Menu. [Chapter 10: Menu and Window Reference, “Editing meter and tempo”]

• Click in the circle next to Set Meter and set the meter to 2/4 time. Measure 3 will now become a 2/4 measure, and measure 4 can be Cut from the track. Your track will now loop where you want it to.

One popular looping technique is to loop several tracks of different
lengths. This can be used for simple convenience, such as having a four-bar drum track loop twice for every time through an eight-bar looped keyboard track, or to create complex cyclic relationships, such as looping a four-bar and a six-bar track, which will then coincide every twelve bars.

**Toggling track settings with keyboard shortcuts**

When working in an Editor other than the Track Editor, you can toggle the record-enable, play-enable, solo, and loop functions of the track currently showing in the active Editor using shortcut keys. These commands *only* affect the track currently showing in the Editor:

- **Play-enable:** Shift+P
- **Record-enable:** Shift+R
- **Solo:** Shift+S
- **Loop:** Shift+L

**Markers**

Master Tracks Pro provides “markers” that let you identify points in your song to which you want to be able to locate quickly, or at which you wish to trigger an MCI event, such as playing back a WAV file. (For information on MCI events and using markers with them, see [Appendix D: Using MCI].) Markers are particularly useful for designating structural divisions in a song (verse, chorus, bridge) from which you might want to start recording or playback.
Master Tracks Pro markers look and act like Tab stops in a word processing program. Markers are displayed at the top of the Track Editor’s Song Editor, the Piano Roll Editor, and the MIDI Data windows, just below the window’s title bar, on another horizontal bar called the “marker ruler”.

Markers can be hidden from view with the “Hide Markers” command in the Layout menu, but they are still active even when hidden.

In the Song Editor, markers can only be placed at the beginning of a measure. In the Piano Roll, Notation and MIDI Data Editors, they may be placed with resolution down to a single clock by watching the pointer position display while placing the marker.

Note: The resolution to which a marker can be placed is affected by the zoom level. Zoom in if you are unable to locate the pointer position display to the point you need. A marker placed within a measure will appear at the start of the measure when viewed in the Track Editor.

Unless they are locked, markers maintain their musical position (in measures, beats, and clocks) when any operation affecting timing, such as a Conductor or Tempo Map change, is performed. If, for example, a ritardando (a slowing of tempo) is added in the Tempo Map, any markers in the affected area would maintain the same measure and beat position, but would occur later in minutes and seconds from the beginning of the song, since the tempo is slower.

The Markers window

The Markers window (opened by the “Markers” command in the Info menu) shows all of the markers in a song in chronological order, with each marker’s name, musical location (measure/beat/clock), and real-time location (hour/minute/second/frame). Markers can be added, deleted, renamed, repositioned, and locked in this window. Locking a marker can be useful when you are working with film or video and need to line up specific visual events with musical events.
To hide markers from view in all windows:

• Choose the “Hide Markers” command from the Layout menu.

To display markers in all windows:

• Choose the “Show Markers” command from the Layout menu.

Placing and naming markers

When the marker ruler is visible, you’ll see a small box at its left end containing a hollow triangle. (In the Track Editor, the triangle is at the left end of the Song Editor portion of the window.) This box is called the “marker well”. A marker is placed by dragging it from the well to the location you wish to mark, or by adding it in the Markers window.

To place a marker:

• Click on the marker well and drag to the location you wish to mark. Another triangle, the marker you’re placing, will appear and follow the pointer as you drag.

• After dragging to the desired location, release the mouse button. The Marker Name dialog will appear.

• Enter a name for the marker of up to 80 characters, if you wish. Click the “Add MCI Event” button if you want to trigger an MCI event at that time. [Appendix D: Using MCI]Click "OK" to confirm your entry.
• Choose the “Markers” command from the Info menu to open the Markers window.

• Click the “Add Text” (or “Add MCI” for an MCI event) button. A new entry will appear in the list and the marker will be visible in the Editors. The new marker will have the Measure and Time numbers of the last marker already on the list.

• Click in the Measure, Time, and/or Name fields and edit the values as desired. The list will rearrange itself as needed to maintain chronological order.

The marker now appears in the marker ruler (and the Markers window), with its name to its immediate right. In the Track Editor, a dashed vertical line appears below the marker, extending through the track data indicators to help you see exactly where the marked measure is in your song.

To delete a marker:

• Drag the marker to the marker well or anywhere to its left. The marker will disappear.

OR

• Choose the “Markers” command from the Info menu to open the Markers window.

• Click in the Name field of the marker you wish to delete to select it.

• Click the “Delete” button.

Note: There is no confirmation dialog for the “Delete” button! Once you click that button, the selected marker is gone!
To move a marker:

- Drag the marker to the new location.

OR

- Choose the “Markers” command from the Info menu to open the Markers window.

- Click in the Measure or Time field of the marker you wish to move and edit the value as desired. The Tab and left and right arrow keys can be used to select the units (measure, beat, hour, second, etc.) for editing.

When you enter a new value in the “Measure” column, the “Time” column is automatically recalculated, and vice versa. The marker will also automatically reposition itself into its proper chronological spot on the list.

*Note: When a song is playing, markers can be moved within any of the data windows, but they cannot be moved in the Markers window.*

To rename a marker:

- Double-click on the marker to open the Marker Name dialog.

- Enter the new name or edit the existing one as desired. Click "OK" to confirm your entry.

OR

- Choose the “Markers” command from the Info menu to open the Markers window.

- Click in the Name field of the marker you wish to rename to select it.

- Enter the new name or edit the existing one as desired.
Importing markers

Markers can be imported into a song from a MIDI File. A Master Tracks Pro marker is equivalent to a MIDI File’s “text event”. When a MIDI File containing text events is loaded into Master Tracks Pro, they will show up as markers, and can be treated as if they were created within Master Tracks Pro.

Locating to markers

To locate to the next marker:

- In any Editor except the Event Editor, press the Tab key on your computer's keyboard to locate to the next marker in the ruler. The Measure Counter will be set to the marker’s location, and the window will scroll so that the marker is at the extreme left of the window. If the marker is within a measure, the left edge of the window will move to the beginning of the measure that contains the marker.

*Note: Pressing Tab will have no effect if the active window is not an Editor that displays markers, or you are on (or past) the last marker in the song.*

*Also, if Auto Rewind is enabled in the Transport window, the data in the window will move, but the Measure Counter will not advance.*

To locate to the previous marker:

- In any Editor except the Event Editor, hold down the Shift key on your computer’s keyboard and press the Tab key to locate to the previous marker in the ruler. The Measure Counter will be set to the marker’s location, and the window will scroll so that the marker is at the extreme left of the window. If the marker is within a measure, the left edge of the window will move to the beginning of the measure that contains the marker.

If you are on (or before) the first marker in a song, pressing Shift+Tab will send you to the beginning of the song.
Locking markers

You can lock and unlock markers only in the Markers window. Locked markers are useful for showing “fixed” points in a song, which might correspond to specific visual events or sound effects in a film.

To lock or unlock a marker:

• Choose the “Markers” command from the Info menu to open the Markers window.

• Click in the Lock field of the marker you wish to lock. A little padlock icon will appear to indicate that the marker is locked.

• Click on the padlock to unlock the marker.

To lock or unlock all of the markers in a song:

• Click on the “Lock All” button at the top of the Markers window to lock all markers in the song.

• Click on the “Unlock All” button at the top of the Markers window to unlock all markers in the song.

Moving locked markers

If you attempt to perform any operation affecting timing (such as a Conductor/Tempo Map change, Fit Time, or Insert Measure) on a measure containing a locked marker, a Locked Marker warning dialog will appear asking you whether the marker should stay where it is in real (i.e., SMPTE) time, or move with the music as if it weren’t locked.
To allow a locked marker to move with the music:

- Click the “Move with music” button in the warning dialog. The marker’s Measure numbers will stay the same but its Time numbers will change. This would be appropriate if, for example, the marker is a musical one called “horn theme”.

To keep the marker locked in time:

- Click the “Stay with time” button in the warning dialog. The Measure numbers will change while the Time numbers stay the same. This would be useful if the marker denotes a visual event in a film or video like an explosion.

You can also specify at that time whether markers will always stay with time or move with music.

To let locked markers always move with the music:

- Click the “Always move with music” button if the markers are primarily music-based.

To keep locked markers always fixed in time:

- Click the “Always stay with time” button in the dialog. This is appropriate if you are working primarily with markers that are real-time based.

Clicking either button also tells the program not to show this dialog every time you try to move a locked marker.

*Note: The “Always....” buttons affect all songs for the duration of your Master Tracks Pro session. To remove this condition you must exit Master Tracks Pro and start it up again.*
Making temporary tempo changes (Offset tempos)

The tempo scroll bar in the Conductor window allows you to make temporary changes in the tempo, even while a song is playing. This tempo change is called an “offset tempo”. You can see the current offset tempo setting in the top of the Conductor window, while the “stored” tempo setting for the song is shown at the bottom. If a tempo change occurs in the Tempo Map while there is a tempo offset, the new tempo will be offset as well, by the same factor.

To change the offset tempo with the scroll bar:

• Drag the scroll box to a new value

OR

• Click anywhere in the scroll bar itself. The scroll box will move rapidly toward that location, causing a corresponding rapid change in the offset tempo setting.

OR

• Click one of the arrow controls at either end of the scroll bar to change the offset tempo in 1-beat-per-minute increments. Click-holding on an arrow causes the offset tempo to count up or down.

Note: The offset tempo scroll bar only functions when the program is in Internal sync mode. If you are using “Ext” or “MTC” sync, the scroll bar will have no effect.
To remove a tempo offset (resetting to the original stored tempo):

- Click in the Beat value field in the lower right of the Conductor window. The tempo will jump back to the stored tempo with no offset.

**Song Play Lists and Song Sets**

Master Tracks Pro allows several sequence files, or “songs”, to be open at a time. Master Tracks Pro’s Song Play List enables you to make a list of open song files in any order, then play through the list without stopping. The list can then be saved to disk as a “Song Set”.

**The Song Play List window**

The Song Play List window allows you to reorder the list of currently open songs, play the list, save it to disk as a Song Set, or open an existing Song Set. The window retains the Playlist even after it is closed, unless you close any of the individual song files or open new ones.

![Song Play List - None](image)

The left side of the window also lets you define a Wait Event. When a song in the list finishes playing, Master Tracks Pro can either immediately begin playing the next song or pause until the
specified Wait Event. This is particularly useful in live performance situations, where it is usually desirable to be able to manually trigger playback of a song.

*Note: When the Song Play List window is open and “Any computer key” is selected as the Wait Event, all Master Tracks Pro keyboard shortcuts for transport control are deactivated. Closing the Song Play List window or selecting a different Wait Event reactivates them.*

To open the Song Play List window:

- Check that all songs you will want in the Play List are open.
- Choose the “Song Play List” command from the Songs menu to open the Song Play List window.

*Note: Pressing the Enter key closes the Song Play List window.*

To reorder the songs in a Play List:

- Click on the name of the song you want to move. The pointer will turn into an arrow with the words "MOVE TO" beneath it.
- Place the arrow over the position in the list where you want the song to be and click again. The other songs in the list will move up (if you are moving the song lower in the list) or down (if you are moving the song higher in the list) accordingly.

To select a starting point for playing the Play List:

Playback can be started from any song in the list. Master Tracks Pro continues playing through the list from that point to the end, where it stops.

- Double-click the name of the song in the list from which you want playback to begin. The song name will become highlighted. The list will always begin playing from the song whose name is highlighted.
Wait Events

When Master Tracks Pro reaches the end of a song in the Play List, it can continue without stopping and begin playback of the next song, or it can wait for a specified period of time or a signal from you. If it is told to wait, the signal to continue is called the “Wait Event”.

A Wait Event can be: a pause from 0 to 999 seconds long, a key on your computer keyboard, or a specified MIDI note or controller message. The Wait Event can also apply to starting playback of the list.

Note that this setting will be global for the entire Play List—the program will always wait the specified number of seconds, or wait for the designated notes or controller, before proceeding to the next song, regardless of where in the Play List it happens to be.

To set playback to proceed through the list without stopping:

• Click the radio button marked “No wait event”.

To set a period of time as the Wait Event:

• Click the radio button next to the box marked “Seconds”. The value in the box will become highlighted.

• Enter a value between 1 and 999 seconds into the Seconds box.

To use a computer keyboard as the Wait Event:

• Click the “Any computer key” radio box. Now, pressing any key on your computer keyboard will cause the Play List to continue.

Note: When “Any computer key” is selected, all Master Tracks Pro keyboard shortcuts for transport control are disabled.
To designate a MIDI note as the Wait Event:

• Click the radio button marked “Note”. The value in the box will become highlighted.

• Enter a note name from the computer keyboard.

OR

• Play the desired note on your MIDI keyboard. The note name will appear in the box.

To designate a MIDI Continuous Controller event as the Wait Event:

• Click the radio button marked “Controller #”. The value in the box will highlight.

• Enter the number of the MIDI Continuous Controller you want to use as the Wait Event.

OR

• Move the desired controller. The controller number will appear in the box.

To apply the Wait Event to starting playback of the first song:

• Click in the “Wait before first song” check box. When playback of the list is initiated, playback will not actually begin until the Wait Event is received. Click again to uncheck the box and allow playback to begin as soon as it is initiated.

Playing the Play List

To start playback of the Play List:

• Click Play in the Play List window
OR

- Press the Tab key until the Play button is highlighted, then press the Space Bar to begin playback.

Playback will begin immediately from the highlighted song (unless “Wait before first song” has been checked, in which case playback begins when the Wait Event is received) and the Play button will change to say “Stop”.

To pause playback of the list:

- Click the Pause button at the bottom of the window.

- Click Play again to resume playback from where it stopped.

To stop playback of the list:

- Click the Stop (Play) button at the bottom of the window. The button will change back to saying “Play”. Clicking Play again restarts playback from the highlighted song.

- You cannot use a song more than once in a Play List. If you want to play a song twice, save it under a different name (use Save As...), then re-open the original version. Both versions will now be on the Play List and can be arranged as you wish.

- If you create a tempo offset while a song is playing in the Play List, the offset will be remembered for that song only. When the next song plays, the previous offset is removed and the new song plays with any tempo offset that may have been created for it. When you return to the first song, its tempo offset will be active again.

- Do not use songs with a looped track in a Play List. The song will play, but it will loop continuously and never finish. This prevents you from moving to the next song on the list.
Saving and Loading the Play List as a Song Set file

Once a Play List has been created, you can save it to disk, just like any other file, using the “Save Song Set” command. The Song Set is just a list and does not actually contain the sequences in it. They must be saved individually.

When you load a Play List from disk with the “Open Song Set” command, all of the sequences on the list are opened automatically, in the correct order.

*Note:* For the “Open Song Set” command to work properly, all of the sequences must be in the same directory as the Song Set itself. If any sequences are not in the directory, they will not load, and you will get an error message (other sequences which are in the folder will load, however).

To save a Play List as a Song Set file:

• Click the “Save Set” button. A standard Windows file save dialog will appear.

• Enter a name for the Song Set, using the “.mpl” extension, and save to the desired location.

To open a Play List from a Song Set file:

• Click the “Open Set” button. If there is already a Play List open, a confirmation dialog will appear which offers you the opportunity to save changes to the current list before closing it.

• Use the standard Windows open file dialog that appears to locate and open the desired Song Set file. If there are open songs which are not used in the new Play List, Master Tracks Pro will close them, offering you the opportunity to save changes before it does.
Since a sequencer’s most basic task is recording and playing back the occurrence of MIDI events in time, it requires some sort of clock or timing reference on which to base its operation. It is often desirable to have several devices share the same timing reference so that they operate synchronously. Synchronization is always a master/slave system with a single master that generates the timing reference and any number of slaves that lock their operation to it. Master Tracks Pro is capable of employing any of three timing sources, operating as master (generating and transmitting the sync signal) or slave (locking to an outside sync source):

- **Internal**: the program plays from the computer’s internal clock, and all transport commands (start, stop, rewind, etc.) are handled by the computer. External sync signals are unnecessary and are ignored.

- **External**: the program operates from MIDI commands: clocks (for timing reference), Song Position Pointer, or SPP (for locating), and start, stop, continue (for transport control). These commands are generated by other sequencers, drum machines, and tape-to-MIDI converters/synchronizers such as the Roland SBX-80 or the J.L. Cooper PPS-1 and PPS-100 (in “FSK” mode).

When the program is in “External” mode, the Record function is still toggled from the program, although the tempo, play, stop, and continue functions, and, often, the rewind and fast-forward functions as well, are under the control of the external device.

- **MIDI Time Code**: the program reads MIDI Time Code (MTC) data, as generated by devices such as the Music Quest MQX-32M or the J.L. Cooper PPS-1 and PPS-100 (in “MTC” mode). MTC
is a translation into MIDI messages of SMPTE Time Code, the standard professional timing reference for machine synchronization in audio and video studios. For this reason it has become a more common means of synchronization than MIDI clocks and Song Position Pointer (which predated MTC).

As with External synchronization, the play, stop, continue, rewind and fast-forward functions are all under external control, although the Record function is toggled from the program.

*Note: The synchronization source cannot be changed while a sequence is running.*

Perhaps the greatest difference between using External sync or MTC comes in how tempo is dealt with. The discussions below on using these types of sync detail these differences.

To use External or MTC sync:

• Connect the device providing sync to your MIDI interface.

• Choose a port from which to receive sync in the MIDI Setup dialog.

• If using MTC, select the Start Time (if desired) and SMPTE format in the Sync Setup dialog.

• Select the sync source in the Sync Setup dialog.

• Enter Record or Play mode.

• Start the sync source.
Choosing a port for receiving sync

Before either MIDI clock/SPP or MTC synchronization can be used, you must specify the port from which Master Tracks Pro should expect the sync signal to come. A sync signal must be received through a MIDI interface, so this process basically consists of choosing which MIDI interface will be used for this purpose. This step is required, even if you only have a single, simple interface.

Note: To ensure the greatest timing accuracy, it is recommended that the sync signal not share a port with your master keyboard/controller. A typical setup would have the keyboard on one port and the sync signal on another.

- Choose the "MIDI Setup" command from the Setup menu to open the MIDI Setup dialog.

- Click the arrow at the right side of the box marked "Receive Sync Driver Selection to make the drop-down menu appear."
Select the desired port from the menu. The menu will then collapse again, displaying the selected port. Click "OK" to confirm your choice.

Selecting synchronization

The synchronization source used by Master Tracks Pro can be selected in two places:

- The "Sync" button in the Transport window. This is the quickest and most convenient place to switch between Master Tracks Pro's three possible sync sources.

- The Sync and Timer Setup dialog contains not only the ability to switch between sync sources, but also to specify additional details of synchronization, such as the SMPTE format and start time and the port to which Master Tracks Pro-generated sync signals will be sent.

To select a synchronization source with the "Sync" button in the Transport window:

- Click on the "Sync" button to switch the sync source. The default setting is INT (Internal). Successive clicks will change it to EXT (External), then MTC (MIDI Time Code), and back to INT.

When set to EXT or MTC, the button will have the appearance of having been "depressed" and the color of the text will change to blue for EXT and red for MTC.
To select a synchronization source from the Sync and Timer Setup dialog:

- Choose the "Sync Setup" command from the Setup menu to open the Sync and Timer Setup dialog.

- Click the radio button for the desired sync source in the box marked "Sync Source". Click "OK" to confirm your choice.
Using External sync

If Sync is set to EXT in the Sync and Timer Setup dialog or Transport window, the program accepts a time base reference from an external MIDI source, in the form of MIDI clock messages. The source can be another sequencer, a MIDI drum machine, a tape-sync-to-MIDI converter, or a SMPTE-to-MIDI converter such as the Roland SBX-80 or Fostex 4050.

In EXT sync mode, Master Tracks Pro requires a MIDI Start command, MIDI clocks, and possibly a MIDI Song Position Pointer (as provided by FSK-to-MIDI devices or SMPTE-to-MIDI converters like the Fostex 4050 or Roland SBX-80) to start playing or recording.

MIDI clocks only occur 24 times per quarter-note, so Master Tracks Pro interpolates its 240 clocks per quarter-note from the incoming MIDI clocks. Note that MIDI clocks are referenced to quarter notes, which means that the clock rate varies with tempo. Thus, MIDI clocks are a relative sync reference.

Master Tracks Pro's Play, Stop, and locating functions are now taken over by the external MIDI source. When the program receives a Song Position Pointer command, followed by a Continue message and a string of Clocks, the Measure Counter automatically locates to the point specified by the SPP message and the sequence starts to play. When either a Stop command is received or the clocks stop, the program stops.

Note: If the synchronizer does not send Song Position Pointer, you will have to reset the external source back to the beginning of the song each time you start, and set Master Tracks Pro's Measure Counter to 0 as well, or else each device will have no way of knowing where the other is.)

When a sequence is running under EXT sync, you can edit any data except Conductor and Tempo Map data.
To Record or Punch a track while in EXT:

- Check that the tape or other external sync source is stopped.
- Set up the Record and/or Punch parameters (enable tracks, set In and Out times, etc.). [Chapter 4: Recording]
- Click on Record.
- Start the tape or external sync source.

If you want to hear what an edit sounds like without running the external source, take Master Tracks Pro out of Ext Sync mode and put it in Int Sync mode. Put it back into Ext Sync mode when you want to run it with external timing again. (The sequencer must be stopped every time you change the synchronization mode.)

Tempo changes and EXT sync

When synced to MIDI clocks and Song Position Pointers, all tempo and meter changes are under the control of the external synchronizer, and the Tempo Map in the sequence is ignored. If you have tempo changes in a sequence you want to preserve, you have to enter them into the synchronizer — consult the synchronizer’s manual for the best way to do this.

Transferring the Tempo Map to an external synchronizer:

Some synchronizers have a “learn” function which allows them to record a tempo map as it comes into them. To use this function:

- Connect a MIDI cable from the your interface’s MIDI Out to the synchronizer’s MIDI In.
- Set Master Tracks Pro to INT sync
- Enable Master Tracks Pro to transmit sync.
• Set the synchronizer to record the incoming tempo information.

• Start the sequencer.

Again, see the synchronizer’s manual for more instructions.

**Using MIDI Time Code sync**

MIDI Time Code (MTC) is an addition to the MIDI specification that allows direct synchronization of MIDI devices, like sequencers, to SMPTE Time Code without converting it into MIDI Clocks and Song Position Pointer commands.

Under MTC sync, Master Tracks Pro’s Play, Stop, and locating functions are taken over by the master time code source. Once MTC sync has been enabled and the Play button clicked, the program automatically locates and starts to play whenever it receives an MTC frame number that corresponds to any point within the sequence. If it receives an MTC number that is before the sequence’s starting point or after its end, it displays the number in the “Current Time” indicator, but otherwise does nothing.

**About SMPTE Time Code**

SMPTE Time Code is the standard form of synchronization in recording studios, video production studios, and audio-for-video post-production facilities. It is a stream of digital bits coded onto an audio signal that can be recorded on tape, and it serves two functions: synchronization and locating. In these facilities, time code information is used to synchronize tape machines and digital audio workstations to each other, and to automate editing, among many other tasks.

SMPTE Time Code is recorded, or "striped" on a track along the entire length of each tape that must be synchronized. (Some professional facilities use Vertical Interval Time Code, or VITC, which is encoded into the video signal itself rather than recorded
on a track.) Each spot on a striped tape, then, can be identified by a unique time code number based on the location’s elapsed time: hour, minute, second, and frame. (Since SMPTE Time Code was originally devised for television and film, it uses the video and film structure of frame rates to subdivide seconds). Time code is an absolute time reference.

A synchronizer achieves synchronization by comparing the time code address from the slave machine(s) to that of the master and sending instructions to the slave(s) to compensate for any difference. When the time code addresses coming in from the master and the slave(s) are identical, the devices are synchronized. This system allows synchronization to be maintained, even when there are speed variations in the master (which is common in tape machines).

The number of frames per second (fps) is determined by the time code format. There are five formats defined in the SMPTE standard: 24 fps (standard for film), 25 fps (European television), 30 fps (North American black-and-white television, sometimes known as "non-drop frame" or NDF), 29.97 fps (NTSC, used for North American color TV), and 29.97 “drop frame” (also known as 29.97DF and sometimes, erroneously, as 30DF). 29.97DF is a "kludged" version of regular NTSC 29.97 fps with certain frames left out to make up for timing discrepancies inherent in the medium. The purpose of 29.97DF is solely for the convenience of having the time code correspond to actual elapsed time, and it is not heavily used.

About MIDI Time Code

SMPTE Time Code cannot be run through a MIDI cable, because it goes too fast and is electrically incompatible. But there are devices that can convert SMPTE into MTC, which is a series of MIDI commands that convey the time code addresses to a MIDI device. This enables MIDI sequencers and other time-dependent devices to be part of a professional SMPTE-based system.
One of the major advantages of using MTC with a sequencer is that MIDI Time Code is tempo-\textit{independent}, unlike MIDI Clocks and Song Position Pointers. When you use a conventional SMPTE-to-MIDI Clocks-and-Pointers converter, all tempo information has to be entered into the converter’s tempo map, often a difficult and tedious process, and tempo editing has to be done by hand. The converter then sends out the tempo information, which the sequencer follows. Furthermore, many such converters, once you have created a tempo map inside them, do not allow that tempo map to be stored; if you want to use the converter for different pieces of music you have to reconstruct the tempo map for each piece.

MTC, on the other hand, sends no tempo information, just a steady stream of time code addresses. A sequencer reading MTC uses that stream as a time base to generate its \textit{own} tempos. For a program that allows complex tempo changes like Master Tracks Pro, this means that all tempo changes can be manipulated freely \textit{within the sequencer}. Master Tracks Pro’s Tempo Map is active when synced to MTC. Furthermore, a Tempo Map created within a sequence is automatically stored as part of that sequence, and is loaded with the sequence.

Plainly, Master Tracks Pro’s advanced tempo-editing functions, like the change-over-time features of the Conductor and Fit Time commands and the editing capabilities of the Tempo Map window, are of little use when the sequencer’s tempo is being determined by an outside source. All of these features, however, are usable when the program is reading MIDI Time Code.

\textbf{Selecting the SMPTE format (frame rate)}

It is \textit{very} important for proper MTC synchronization, whether Master Tracks Pro is a slave or the master, to select the correct SMPTE frame rate. When Master Tracks Pro is a slave, the frame rate should be set to match that of the master which means, of course, that you must know the frame rate used on the master.
Note: Many time code devices only list four SMPTE formats, omitting 29.97 NDF. In almost all cases, these devices will sync correctly to 29.97 NDF time code if they are set to 30 fps.

To set the SMPTE format:

- Choose the "Sync Setup" command from the Setup menu to open the Sync and Timer Setup dialog.

- Click the radio button for the desired frame rate in the box marked "SMPTE Format". Click "OK" to confirm your choice.

Note: When syncing to MIDI Time Code, if the incoming time code does not match the format selected, Master Tracks Pro will select the correct format automatically. However, if you are setting Markers or performing any other operations where location is critical, make sure that the proper format is selected in the MIDI Setup dialog.

Setting a SMPTE Start Time (sync offsets)

These parameter boxes let you set a starting time (also known as a “synchronization offset”) for the sequence when you are synchronizing the program to MTC. It is rare that you will want a musical sequence to start right at the point on a tape where the SMPTE Time Code reads zero — more likely it will read something like 1 hour, 12 minutes, 35 seconds, 14 frames. This feature allows you to determine the exact time code address at which Master Tracks Pro will start to play or record.
The Start Time is saved in the Preferences file, as well as with the sequence file, and appears automatically when you reopen the sequence.

To enter a SMPTE Start Time:

- Choose "Sync Setup" from the Setup menu to open the Sync and Timer Setup dialog.

- Enter the desired Start Time in hours, minutes, seconds, and frames. Click "OK" to confirm your entry.

![SMPTE Values](image)

Finding a Start Time when working to picture:

Videotapes made as work guides for creating sound or music often have a window on the screen that shows the time code recorded on that tape. This is referred to as "window burn". Window burn makes it easy to determine a specific Start Time that relates to the picture: simply move the video to the desired point, read the time code address in the window burn, and enter that as the Start Time.

If the videotape does not have a window burn (or if you’re syncing to audio tape), you can find out the SMPTE location of your starting point by running the tape and looking at the “Current Time” indicator in the Transport window. If the program is receiving MIDI Time Code, this indicator will show the incoming code, whether the sequencer is running or not. Stop the tape right at the point where you want the sequence to start, look at the Current Time indicator, and enter that as the Start Time. This method is not as accurate as using a window burn, but will usually be satisfactory for finding a rough Start Time, which can be adjusted as necessary through trial-and-error until it is right.
Note: The SMPTE Start Time will be the start time for the sequence even if you are not using MIDI Time Code synchronization (although it will have no effect on the actual playing of the sequence in Internal or External sync modes). When the Measure Counter is at 01:01:000, the “Current Time” indicator below it will show the Start Time, and as you play or move about the sequence, this figure will be added to the actual length of the sequence in the Current Time indicator. In addition, the Start Time will appear in the window at the top center of the Markers window, and the “time” fields of all the markers in the window will have this value added to them.

**SMPTE Dropout parameter**

Unfortunately, tape is subject to imperfections that can result in momentary dropouts in playback. When that tape is the master time code source, this translates to a brief interruption of the SMPTE (and, consequently, MIDI) time code streams. Normally, this would cause a sequencer to stop. Master Tracks Pro, however, lets you overcome tape dropouts by allowing the sequencer to continue to play for a certain period of time without incoming MIDI Time Code. During the few seconds of unsynchronized play (known as "freewheeling" or "flywheeling"), the sequencer will revert to INT sync and continue running at the tempo that was current when the dropout occurred, thereby avoiding any sudden jumps in speed. In that time interval, hopefully, the SMPTE track will reappear, and MIDI Time Code will resume. Master Tracks Pro then returns to MTC sync. Unless the dropout is serious, there will usually be no audible effects of this process.

The SMPTE Dropout parameter specifies the number of seconds that the program will attempt to freewheel in the absence of time code. Note that the sequencer will also continue playing for that many seconds after the tape is stopped. When set to "0", the program will stop immediately if MIDI Time Code stops. This setting has no effect when using Internal or External sync.

*Note: It is recommended that the SMPTE dropout parameter be left set to "0" until a problem is encountered.*
Transmitting MIDI clocks and SPP

Master Tracks Pro generates its own time base from the PC’s highly accurate internal clock when sync is set to INT, and lets you transmit MIDI synchronization commands (Start, Stop, Continue, Song Position Pointer, and clocks) corresponding to actions you take in the Transport window. For example, whenever you move the Transport to a new location in the sequence, a corresponding MIDI Song Position Pointer message is sent out.

These commands can be used to control a drum machine or another sequencer, or converted into audio (FSK) signals which can be recorded on tape and used later to synchronize the sequencer to the tape.

*Note: MIDI sync can be sent even when the sequencer is itself being synchronized to an external timing device.*

To transmit MIDI sync from Master Tracks Pro:

- Choose "Sync Setup" from the Setup menu to open the Sync and Timer Setup dialog.

- Click the check box in the area marked "Sync Out Port" which corresponds to the port to which you wish to send sync signals. Click "OK" to confirm your choice.

To disable transmission of MIDI sync from Master Tracks Pro:

- Choose "Sync Setup" from the Setup menu to open the Sync and Timer Setup dialog.

- Click any check box in the area marked "Sync Out Port" which is selected to uncheck it. When there are no boxes checked, Master Tracks Pro will not transmit sync. Click "OK" to confirm your choice.
Note: If you have no need to send MIDI sync, it is recommended that transmission be disabled. MIDI sync uses a fair amount of the MIDI data stream’s bandwidth, and can cause or exaggerate some timing problems under extreme conditions.

**Tips on using Master Tracks Pro with MTC**

To hear what an edit sounds like without running tape:

- With the tape stopped, put Master Tracks Pro into INT sync.
- Run the sequence and check the edit.
- Put Master Tracks Pro back into MTC sync to run it with tape again.

Using the Fit Time command to make a musical cue fit precisely into a visual sequence on a videotape is one of the more exciting uses of Master Tracks Pro’s MTC capability.

To use the Fit Time command to fit music to a visual sequence:

- Use the window burn to determine the starting point and exact length of the visual sequence (subtract the starting time from the time at the end).
- Set Master Tracks Pro’s Start time to the visual’s start time.
- Select the region comprising the musical cue.
- Choose Fit Time, and type in the length.
To edit data properly it is necessary to be able to manipulate the way in which it is viewed. Master Tracks Pro lets you look at your data in many different ways, which are described here.

**Scrolling**

All of the Editors (except the Event Editor), MIDI Data windows, and the Tempo Map allow you to scroll through data to accommodate the fact that it is often impossible to display an entire sequence on the screen at one time. Like any standard Windows program, scrolling is accomplished using scroll bars. All of the regular techniques are available: clicking and click-holding on an arrow, clicking in the scroll bar itself, and dragging the scroll box.

**Zoom In and Zoom Out**

Master Tracks Pro’s Zoom commands let you decide how much of the track data you can see in the Piano Roll and Notation Editors, MIDI Data windows, and Tempo Map. Like a zoom lens, the Zoom commands let you move your perspective in or out for different levels of “magnification”. You can zoom in to work on small portions of the track more precisely, or zoom out to see more notes at once. Master Tracks Pro gives you six different Zoom levels.

To zoom in or out:

- Choose the Zoom In or Zoom Out command from the Layout menu
OR

• Press the Plus (+) key on your computer’s keyboard to zoom in or the Minus (-) key to zoom out.

**Zoom level and editing resolution**

The Zoom level you choose not only affects how much of the track you can see, it also determines how precise your editing changes and additions can be. This is because the Zoom level determines the number of clocks displayed per pixel on the screen, and thus affects the resolution at which you can edit data in the Piano Roll Editor and MIDI data windows. (A pixel is the smallest dot on your computer’s screen and the minimum distance interval you can move your mouse.)

If you zoom all the way in to the highest level of magnification, each pixel represents a single clock (1/240th of a quarter note). This is the best level for precise work when you’re editing notes, pitch bend, or other MIDI data. When you zoom further out, the clocks-per-pixel ratio increases, to a maximum of 24 clocks (1/10th of a quarter note) per pixel. At the maximum zoom level, the left-hand edge of the Piano Roll or Notation Editor window may no longer be a measure boundary, because an entire measure will not fit into the window—instead, it will fall on a beat.

The setting of the Zoom level can also affect how densely MIDI data will be placed in a track. For details, see [Chapter 9: Advanced Editing, "Data Density and the Zoom Factor"].

**Note:** *If any measures in the current sequence use a smaller division of the measure than quarter notes (e.g., if a time signature is 6/8, 5/16, etc.), then all zoom levels will not be available.*
Viewing different tracks

The Editors (with the exception of the Track Editor) and MIDI Data windows display data from only a single track at a time, however, the display can be easily switched to show any track for editing.

To change the track displayed in an Editor or MIDI Data window:

• Click on the button in the Control Bar marked "Track = #" to open the Select Track Number dialog.

OR

• Press the “T” key on your computer’s keyboard to open the Select Track Number dialog.

• Type in or use the scroll bar to enter the number of the track you wish to view. Click "OK" to confirm your choice. All open Editor and MIDI Data windows will switch to the selected track.

Renaming Tracks

You can change a track’s name (or give it one if it hasn’t got one) in any window. This change will be reflected in all windows.
To rename a track in the Track Editor:

- Click in the Name box in the Track Sheet for the track you wish to name to open the Track Name dialog.

![Track Name Dialog](image)

- Type in or edit the name as desired. Click "OK" to confirm your entry.

To rename a track in any other Editor or MIDI Data window:

- Click in the Track Name box to the right of the "Channel = #" button in the Control Bar for the track you wish to name to open the Track Name dialog. (In the Event Editor, the Track Name box is next to the "Track = #" button.)

- Type in or edit the name as desired. Click "OK" to confirm your entry.

**Viewing note or event parameters**

The three note editing windows (Piano Roll, Notation, and Event Editors) allow you to see all of the information for an individual note. The simplest method is just to open the Event Editor, since its reason for being is to provide a list of each event in the sequence and all of its parameters.

The parameters it displays for all events are as follows (from left to right in the window):

Event type, start time, channel, and note name/controller number/program change number.
For notes, attack velocity, release velocity, and duration are also shown. For controller events the controller value is also shown.

To view parameters for an individual note in the Piano Roll or Notation Editors:

• Double-click on the note whose parameters you wish to view to open the Edit Note dialog. The note will become highlighted and the Edit Note dialog will display the note parameters.
"Ghost" note display in the MIDI Data windows

For greater clarity when editing controller data, Master Tracks Pro can place a non-editable grayed-out "ghost" version of the Piano Roll Editor under the contents of any MIDI Data window. This allows simultaneous viewing of controller data and the notes it will affect.

To enable or disable "ghost" note display in a MIDI Data window:

- Click the button with the icon of the Piano Roll display in the upper left corner of the Control Bar.

View Filtering

Show/Hide commands in the Layout Menu

The Layout Menu contains several commands that determine the appearance of data windows by showing or hiding certain information. These commands are global and affect all open windows at once.

The Show and Hide commands are mutually exclusive: if, for example, the marker ruler is visible, the "Hide Markers" command will be available in place of "Show Markers". Selecting "Hide Markers" would cause the markers to be hidden and the command to change to "Show Markers".
To show or hide the grid, markers, Device Names, velocity, or program changes:

- Choose the appropriate "Show" or "Hide" command from the Layout menu.

**Show/Hide Grid**

This command lets you switch between two versions of the grid displayed in the Piano Roll Editor, MIDI Data windows, and Tempo Map.

In the Piano Roll Editor, the grid always displays a dotted vertical line at each measure boundary, but you have two choices when it comes to the horizontal lines that represent pitch: you can display a horizontal line for every “white key,” or you can hide the full grid and display lines only at the C and F keys of every octave.

In the MIDI Data windows, the grid displays horizontal lines at 40, 80, and 120 "units" of value.
The reduced grid gives a less cluttered screen, while the full grid provides more help in precise placement of notes or data. Which grid you use is a matter of convenience and personal style.

Show/Hide Markers

This command lets you display or remove the marker ruler from the Editors (except the Event Editor), MIDI Data windows, and Tempo Map. The marker ruler is discussed in [Chapter 2: Getting to Know Master Tracks Pro, "The user interface"].

With markers hidden, the data areas of the windows expand to show slightly more data. Note that when markers are hidden, they are still active: you can still Tab and Shift+Tab to them. Markers always appear in the Markers window regardless of the Show/Hide setting.

Show/Hide Device Names

When Device Names are showing, the abbreviation specified for each device is appended onto the beginning of the Program Name field in the Track Editor window. Hiding Device Names will make the Name field look less cluttered and allow room for longer program names.
Show/Hide Velocity

This command affects only the Piano Roll Editor. When velocity is showing, the attack velocity value of each note is indicated by a vertical line at the beginning of the note. The height of the line gives a rough indication of the velocity value. (To see the exact velocity value of a note use one of the methods described in the section below entitled "Viewing note parameters".)

Show/Hide Program Changes

This command also affects only the Piano Roll Editor. When program changes are showing, they are visible at the bottom of the Piano Roll Editor window.

View filtering in the Event Editor

Since the Event Editor shows all events, it can be difficult at times to see particular information of interest. The “Filter” function lets you select which event types will be seen and which hidden. Hidden data is not erased, just temporarily removed from view. If you have controller data on a track, for example, and only want to look at or work on notes, you can hide the controller data. If you just want to see program changes to make sure they’re correct, you can hide the notes. If there is something strange going on in a track, and you don’t know what it is, just look at one data type at a time until you find it.
Note: It is important to note that operations performed on the data in the Event Editor only affect data which is visible. If a data type is hidden, it will not be affected by a Cut, Copy, or other operation in this window. This makes it easy to work only on pitch bend data, for example, without affecting anything else. If you hide data for the sake of viewing, check the Filter function before performing edit operations to ensure that you are operating on all the data you want to.

To filter events viewed in the Event Editor:

- Click the “Filter” button in the Control Bar to open the Event Filter dialog.

![Event Filter Dialog](image)

- Click in the check boxes for the different types of data to select the items you want to see or hide. When a box for an event type is checked it means all data of that type will appear on the Event List. Boxes with no check mark indicate that type of data will be hidden. Click "OK" to confirm your choices.

**Viewing in the Notation Editor**

The Notation Editor has several unique display parameters that define how notation appears. None of these affect MIDI data in the track in any way, only how it looks.
The Change Key Signature command in the Change menu allows a key signature change to be inserted for any measure or region. Key signatures can only be inserted at measure boundaries. The Change Key Signature dialog is unusual in that it allows the region to be specified in the dialog itself, in addition to selecting it before choosing the command.

To change the key signature of a measure or region:

- Select the measure or region in which you wish to change the key signature. (This may also be done after the next step.)

- Choose "Change Key Signature" from the Change menu to open the Change Key Signature dialog.

- If desired, redefine the measure or region in which you wish to change the key signature by typing the measure numbers into the numeric boxes in the "Select Range" portion of the dialog.

- Use the scroll bar in the "Select Key Signature" portion of the dialog to select the desired key signature. The scroll bar steps through the Circle of Fifths from Cb Major (7 flats) at the bottom up to C# Major (7 sharps) at the top.

OR
• Use the Tab key to step through the boxes and buttons in the dialog until the scroll bar is active.

• Use the up and down arrow keys on your computer keyboard to select the desired key signature.

• Click OK to confirm the setting and close the dialog.

**Notation Editor Setup**

The Notation Editor Setup dialog sets the pitch below which notes are assigned to appear on the lower (bass clef) staff. The pitch designated as the split point and those above are assigned to the upper (treble clef) staff. The Octave View parameter allows transposition of the notation (it does NOT transpose the MIDI data) of a particularly high or low passage in order to make it appear on the staff, which is easier to read than if the passage is written with many ledger lines. Finally, it is possible to set whether or not the initial key and time signature are displayed.

To open the Notation Editor Setup dialog:

• Click the "Setup" button in the Notation Editor's Control Bar.
To set the split point for a track in the Notation Editor:

- Type in the pitch you wish to use as the split point as the note name followed by the octave (e.g. "D4"). Use the "#" symbol if you need an accidental.

OR

- Use the scroll bar to select the pitch you wish to use as the split point.

To set the Octave View for a track in the Notation Editor:

- Type in the number of octaves by which you wish to transpose the notation. The available range is +2 to -2 octaves.

OR

- Use the scroll bar to select the octave transposition you wish to apply to the notation.

To enable display of the initial key and time signatures:

- Click in the "Show" check box in the "Initial Key and Time Signatures" portion of the dialog. When the box is checked the initial signatures will be displayed.

Locating for editing

There are several ways to locate to the spot in the sequence where you wish to edit.

To locate to an edit point in any Editor or MIDI Data window:

- Scroll to the desired area.

OR
• Use one of the locating techniques for playback. [Chapter 5: Playback and Track Setup, "Setting the playback point"]

OR

• Enter the location into the Measure Counter.

OR

• Locate to a previously placed marker. [Chapter 5: Playback and Track Setup, "Markers"]

Locating with the GoTo button in the Event Editor:

The Event Editor offers one other method of locating: the GoTo button.

• With the Event Editor open, click the GoTo button in the Control Bar.

  ![Goto Event window]

  • Enter the location to which you wish to jump. Click the "OK" button to confirm your choice.

About selecting data for editing

Master Tracks Pro offers a variety of ways in each of the Editor and MIDI Data windows and the Tempo Map of selecting data for editing. It is possible in Master Tracks Pro to select anything from entire tracks down to individual events. An area selected for editing
which is greater than a single event is called a "region". Although an entire selected track technically could be considered a region, the term is generally applied to areas smaller than that. In the Track Editor, regions must can only begin and end on measure boundaries, but in other windows they can begin and end on any clock. In addition to selecting regions, the data selected can be further narrowed by setting rules in the Change Filter which determine what will be selected.

As with most other operations, the Track Editor and Event Editor differ significantly from the other Editors and MIDI Data windows in selecting abilities, although most editing operations are available in all of the windows.

The Current Position indicator

For many operations, you need to be able to locate notes precisely in the data area both in terms of time and pitch. In the Piano Roll and Notation Editors, MIDI Data windows, and the Tempo Map, that guidance is provided by the Current Position and Pitch (or, in the MIDI Data windows, Value) indicators in the Control Bar.

For many editing commands, the measure and beat markings in the measure ruler at the top of the window will give you all the information you need to locate the end points of your region. For more precise work however, you can use the Current Position indicator in the Control Bar to begin and end the region at exactly
the right point. The Current Position indicator displays the time value at the current position of the pointer, in measures, beats and clocks.

The pitch/value indicator performs the same function for the vertical axis, allowing you to place the pointer at a precise pitch or controller value.

Since all editing operations in these windows occur on clock boundaries, the precision with which you can define the beginning and end of a region depends on the Zoom level. At the highest magnification, zoomed all the way in, you can define the region by individual clocks (1/240th of a quarter note). When you’re zoomed all the way out, on the other hand, the resolution is much coarser, and the smallest movement of the mouse represents 24 clocks, or one-tenth of a quarter note.

**Selecting in the Song Editor portion of the Track Editor window**

The Song Editor portion of the Track Editor window is the best suited of all the Editors and MIDI Data windows for selecting and editing MIDI data in large regions. The smallest unit available for editing in the Song Editor is a measure, and all edits are done on multiples of whole measures. The edits you make in the Song Editor affect *all* types of MIDI data at once. Commands such as Cut in the Edit menu or Channel in the Change menu affect controller data, sustain pedal, pitch bend, program changes, and so forth, as well as note information.

**Selecting in the Event Editor**

The Event Editor’s list orientation also offers some unique capabilities. Like all of the other Editors (except the Song Editor) and MIDI Data windows, it is easy to select individual notes or events in the Event Editor. Unlike those other windows, the Event Editor
lets you see all types of events simultaneously, yet freely and arbitrarily decide which will be selected. The Song Editor selects all MIDI data in whole measure chunks, the MIDI data windows select only the type of events shown in that window, the Notation and Piano Roll Editors can select all data or notes only. The Event Editor, in contrast, allows you to pick and choose. You could, for example, select all events in a given time period, then deselect two particular program changes. The Filter feature described above puts this flexibility into a broader context by allowing you to choose to hide some event types altogether.

**Selecting in the Notation and Piano Roll Editors**

The selecting capabilities of the Notation and Piano Roll Editors fall somewhere between those of the Song Editor and the Event Editor. You can choose, in the Notation and Piano Roll Editors, to select all MIDI data or only notes with the Edit Mode Select button. This button can be set independently in the Notation and Piano Roll Editors.

**To select all types of MIDI data in the Notation or Piano Roll Editor:**

- Click the leftmost button in the Control Bar. The button will change from an icon with an arrow and two notes (in blue) to an arrow and the word "ALL" (in red).

**To select notes only in the Notation or Piano Roll Editor:**

- Click the leftmost button in the Control Bar so that the icon shows an arrow and two notes (in blue).
Note: Remember that the data selected is the data that will be edited. Therefore, the Edit Mode Select button also affects which data will be edited.

Selecting in the MIDI Data windows and Tempo Map

The MIDI Data windows and Tempo Map use most of the same selecting techniques as the Notation and Piano Roll Editors. The primary differences are that the only data that can be selected (and, in turn, edited) is the type of data shown in that window (velocity, program change, controller, etc.), and that regions can only be selected along the horizontal axis. In the case of a controller window, only data from the controller number shown is affected.

Selecting all data in a sequence

The Song Editor is the only window in which all data in a sequence can be simultaneously selected.

To select all data in a sequence:

• With the Track Editor as the active window, choose "Select All" from the Edit menu.

OR

• Press Ctrl-A on your computer keyboard.

Selecting an entire track

To select an entire track for editing in the Song Editor:

• Click on the track number at the left hand edge of the Song Editor.
To select several adjacent entire tracks in the Song Editor:

- Click and hold over the first track number in the group, and drag the mouse up or down in the track number field to the last track you wish to select.

OR

- Click on the track number of the first track you wish to select.
- While holding down the Shift key, click on the track number of the last track you wish to select.

To select an entire track in any other Editor, MIDI Data window, or the Tempo Map:

- Choose "Select All" from the Edit window or press Ctrl-A.

*Note: In the Event List Editor, only visible (non-"filtered") events are selected.*

**Selecting a region for editing**

Regions can be selected in any Editor, MIDI Data window, or the Tempo Map. When a region is selected, it appears on the screen highlighted in inverse video. The technique for selecting a region is
the same for the Song, Piano Roll, and Notation Editors, subject to the limitations discussed above for selecting in each of the windows. Note in particular that the Song Editor is the only place where it is possible to select data on more than one track.

To select a region for editing:

- Choose the arrow pointer from the second line of the Control Bar, or press the “A” key on the PC’s keyboard.

- Move the pointer into the data area of the window, above and to the left of the first note, measure and track (in the Song Editor), or event you wish to include in the region (not on it).

- Click and hold the mouse button, and drag the pointer down and to the right, so it is both past and below the last note, measure and track, or event you wish to include. As you drag, the selected area will become highlighted.

If all the measures you want to select aren’t visible on the screen, you can scroll the screen simply by dragging to any edge of the window. The window will scroll and the selection highlight will move with it. This technique, known as “hot scrolling”, can be used to scroll the Track Editor window, even if you don’t want to
select that particular block of measures. In that case, when you’re through scrolling, simply click again, and the selected block will be deselected.

You may continue to adjust the region as long as the mouse button is held down.

- Release the mouse button to complete the selection.

OR

- Click just before the first note, event, or measure you wish to select.

- Position the pointer just after the first note, event, or measure you wish to select. If you want to select a range that is larger than what you can see in the window, click on one corner and use the scroll bars to move to the second point.

- While holding the Shift key, click the mouse. The selected area will become highlighted.

You have now defined a rectangular region that has horizontal boundaries (time) and vertical boundaries (pitch or value). Any notes or other data within those boundaries will be included in the editing operation you choose next from the Edit or Change menu; data outside the boundaries will not be affected.

The region does not have to be selected from upper-left to lower-right in the manner described — that was just an example. You can define it by selecting any corner of the rectangle you like and moving up or down, and left or right.

*Note:* In the MIDI Data windows and the Tempo Map regions are selected along the horizontal axis only; dragging up or down has no effect.
To select a region in the Event Editor:

- Click in the Event column on the first event you want to included in the region, hold the mouse button, and drag the pointer down until it is below the last event you wish to include. As you drag, the selected area will become highlighted. (You may instead drag up from the last event to the first event, if you wish.) Like the other windows, the Event Editor will “hot-scroll” when you get to the top or bottom and there is more data beyond.

- Release the mouse button to complete the selection.

OR

- Click just before the first event you wish to select.

- Position the pointer just after the last event you wish to select. If you want to select a range that is larger than what you can see in the window, use the scroll bars to move to the second point.

- While holding the Shift key, click the mouse. The selected area will become highlighted.
Modifying a region boundary

A region can be extended or contracted. This can be useful if the region is first defined at low resolution, such as in the Song Editor or zoomed out, and is then in need of fine trimming.

To extend or contract a region:

• While holding the Shift key, click at the desired new start or end point for the region.

Selecting individual measures

Selecting an individual measure in the Song Editor:

• Use the region selection techniques described above to create a "region" one measure long.

Selecting an individual measure in the Piano Roll and Notation Editors, MIDI Data windows and Tempo Map:

• Click in the Measure Ruler on the measure you wish to select.

Selecting a group of adjacent measures in the Piano Roll and Notation Editors, MIDI Data windows and Tempo Map:

• Click and hold in the Measure Ruler on the first measure you wish to select.

• Drag to the last measure you wish to select.

OR

• Click in the Measure Ruler on the first measure you wish to select.

• While holding the Shift key down, click in the Measure Ruler on the last measure you wish to select.
Selecting measures across all tracks

To select one measure in all tracks (Song Editor):

• In the Song Editor, click in the measure ruler just to the right of the number or vertical mark of the measure you wish to select.

To select adjacent measures in all tracks (Song Editor):

• Click and hold in the measure ruler over the first measure you wish to select and drag left or right to select the entire group.
To select all events in a track at a given time (Event Editor):

- In the Event Editor, click on any event. All other visible events occurring at that time will be selected.

To select all the pitches in a track within a period of time (Piano Roll and Notation Editors):

- In the Piano Roll or Notation Editor, double-click and drag from the beginning of the time frame you wish to select to the end. (Alternatively, you may start at the end and drag back to the beginning.)

Selecting an individual note (Piano Roll and Notation Editors)

Selecting an individual note in the Piano Roll or Notation Editor is the same as selecting an individual measure: use the region selection techniques described above for a "region" that is one note long. There are other methods in which a note is selected and edited in one step. These are covered in the "Viewing note or event parameters" section above.

Deselecting and reselecting

If you make a mistake in selecting a region, simply select it again.

To deselect a selected area:

- Click anywhere in the active window outside the selected area.

Note: Edit menu commands will only affect notes in the selected region if those notes begin within the region. If the beginning of a note falls within the selected region, the entire note will be altered by the command you use, even if the end of the note isn’t included in the selected region. It may be necessary to zoom in to accurately see if the beginning of a note is within the region boundary.
However, a note in the selected region that is tied over from an earlier measure is recognized by commands such as Cut, Copy, and Clear if the region begins precisely on the measure boundary. In this case, the region will include that portion of the note that starts at the measure boundary — but not the portion that precedes the measure. See [Chapter 8: Basic Editing, "Dealing with tied notes in editing operations"] for further discussion of this.

The Change Filter

Normally, all data within a selected region is affected by a command chosen from the Change menu. But data which is affected by the operation can be restricted by the Change Filter. The Strip Data function [Chapter 10: Menu and Window Reference, "The Strip Data command"] goes a certain distance towards being able to isolate specific types of data for editing; the Change Filter goes much further, and lets you do so without removing the data from its context. It provides a way to narrow editing commands so that they work only on very specific musical events.

Each check box in the Change Filter dialog engages a parameter that must be matched for an event to be selected. When a parameter's check box is selected, only data within the range specified in the boxes to the right of the item are affected by the Change command. You can engage as many of the parameters as you like.

Once the parameters in the Change Filter are set up, they stay that way until you specifically alter them or exit Master Tracks Pro. This is true even if you disable the Change Filter or cancel the edit operation from which you called the filter up.

The Change Filter parameters can be saved as part of the Preferences file, so that the dialog opens with the same parameters every time you run the program.
To open the Change Filter dialog:

- Choose "Change Filter" from the Edit menu.

OR

- With any Change menu dialog (except Conductor, Thin, Fit Time, or Scale Time) open, click the button marked "Change Filter".

![Change Filter dialog]

To make the Change Filter active:

- With any Change menu dialog (except Conductor, Thin, Fit Time, or Scale Time) open, click the check box marked "Use" next to the "Change Filter" button.

Here are explanations of the parameters:

**Pitches**

The first parameter in the Change Filter dialog is Pitches, specified as a range from a bottom note (in the left parameter box) to a top note (in the right parameter box).
Being able to isolate data by pitch is extremely useful and has many applications. One obvious one is quantizing the snare drum on a track (if the drum’s note is C#4, set both Pitch parameters to C#4), and leave the other drums alone.

To specify the high and low limits of pitch range:

- Type in note names from your computer's keyboard (always use “#”s for accidentals)

OR

- Type in MIDI note numbers (0-127)

For example, a Transpose command would normally involve all pitches on a track. If you just wanted to transpose pitches in the octave C3 to C4, you could do it as follows:

- Choose "Transpose" from the Change menu to open the Transpose dialog.

- Click on the “Change Filter” button in the Transpose dialog.

- Click in the check box marked “Pitches from” in the Change Filter dialog.

- Enter "C3" in the left range box and "C4" in the right so that the statement says "Pitches from C3 to C4". Click OK to confirm your choice.

**Durations**

The range of durations can be set anywhere between 1 and 9999 clocks (240 clocks = 1 quarter-note). Limiting durations can be useful in a number of ways. If your keyboard technique isn’t perfect and you occasionally hit two keys instead of one, chances are the wrong notes will be very short, say around 20 clocks, and
you can eliminate them, leaving longer notes alone, by setting the Durations parameters in the Change Filter to 1 and 25, and using Strip Data in the Cut mode.

If you have a string part that alternates staccato and legato, and you want to bring out the long notes without making the whole track louder, you can use the Velocity command, increasing all notes by 150%, but specifying in the Change Filter only durations between, say, 180 and 1000.

**Velocities**

The Velocities parameter refers only to note-on velocities, and can range from 1 to 127. Sorting notes out by velocity is another good way to eliminate keyboard mistakes. Strip out all the notes with velocities below 20, for example. It also has expressive uses: you can exaggerate accents on a track, for example, by increasing note velocities by 125% *only* if they exceed 80 to begin with.

**Channel**

This item is a MIDI channel filter, useful when dealing with multichannel tracks (which are unassigned in the Track Editor window). You might have a multichannel track as a result of importing a Type 0 MIDI File, or recording a guitar controller in normal (i.e., not Multi-Track) record mode. The Channel parameter enables you to work only on notes within the track assigned to the specified channel, making it possible to work with a multichannel track without having to strip each channel’s data and paste it onto another track.

**Measures**

This parameter uses two radio buttons, rather than a check box, to let you specify that the edit operation will not apply to every measure, but only to some alternate measures (every third measure, every fourth, etc.). The default setting is “All measures”.
The beginning of the editing region is considered to be in the first selected measure, whether the entire measure or just part of it is selected—measure number 2 begins at the next measure boundary.

To engage the Measures filter:

• Click the button marked "Every # measures"

• Type in the desired number of measures to increment.

This feature could be used, for instance, to break up a melody line between two instruments by Stripping off (in Cut mode) every second measure and Pasting it to a different track. Another example: Humanize the fills on a drum track, but leave the rest of the track in strict quantized rhythm, by applying the Humanize function only to every fourth measure.

Rhythmic placement (Beats and sub-beats)

The final parameter in the bottom half of the Change Filter dialog restricts the action of a Change command to particular beats or fractions of beats within a measure.

To enable the rhythmic placement filter:

• Click the check box marked "Start times within..."

Each one of the little circles that looks like a note-head is actually a radio button. By clicking in it you are telling the program that if it finds a note occurring at this rhythmic location in the measure, it should perform the edit operation on it. Notes occurring elsewhere in the measure are left alone.

The window allows you to specify rhythmic locations in measures up to nine beats long. These locations can be on beats, or on sub-beats—either 1/4-beats (sixteenth notes, assuming that a quarter note is a beat), or 1/3-beats (triplet eighth notes). If you apply this filter to a measure that’s, say, four beats long, then any instructions
you give for notes occurring on beats 5 through 9 are ignored. If your measure is more than nine beats long, you can only address up through beat 9.

The text box in the “Start” line lets you specify an overall tolerance for the locations. If this box says “0”, then only data occurring precisely on the designated locations will be included in the operation. Numbers larger than 0 mean that the events can be a little “off”, either before or after the location by the specified number of clocks, and still be included. To decide what number to put in the window, it helps to keep in mind that a quarter note is 240 clocks, therefore a sixteenth note is 60 clocks, and a triplet eighth note is 80 clocks. To keep everything in perspective, if you turn on all the sixteenth note radio buttons and set the window to 40 (half the distance between two sixteenth-notes), all of the data in a measure will be included in the operation.

Here’s an example of how this parameter can be used: you have a passage of eighth notes in 4/4 time over several measures, and want to accent certain notes in the passage, which fall on the downbeat and the “and” of 3.

- Click on the first sixteenth note in the group labelled “1” and the third sixteenth in the group labelled “3”.

- Enable the filter by clicking the "Start times within..." check box.

- Choose the "Velocity" command from the Change menu and set it to increase the specified notes by 130%.

Another use for this filter would be if you only wanted to quantize notes occurring on beats, leaving the notes between beats un-changed. Or the converse: make the rhythm a little more fluid by humanizing the beats within the bar, but leaving the downbeat right on zero.

You can click on as many radio buttons as you want, even all of
them. You can mix 1/4-beats and 1/3-beats freely, even within the same beat.

Keep in mind that this filter by itself does not actually quantize notes within the specified window, it merely makes them available to a Change operation.

The beat restrictions can be useful when working with non-note data as well. To help avoid MIDI “choke” on beats, when lots of things tend to happen at the same time, you can Strip all Channel and Key Pressure within 5 clocks of every beat. Or, you can create a certain kind of expressive gesture by doubling (increasing by 200%) the modulation on only the fourth beat of every bar. You can create a percussive track out of a continuous sound by setting Controller #7 (MIDI Volume) to 127 on the first 16th note of every beat, and setting it to 0 on the second 16th-note.

Combining filters

Remember that all of these filter parameters can be used together, so you could specify that an edit operation will only affect notes between C#5 and B7, at least 40, but no more than 600 clocks long, with a velocity between 62 and 90, recorded on channel 12, and occurring within 4 clocks of the third sixteenth note of the second beat in measures divisible by 7! (You will certainly come up with more practical combinations.)
Edit Undo

The Undo command acts as it does in virtually all other Windows programs, allowing you to cancel the last operation performed. In Master Tracks Pro, it will reverse the effect of any Edit or Change menu command, or cancel the last Record or Punch pass. Undo also works for data drawn in any of the MIDI Data windows, but not the Piano Roll, Notation, or Event Editors. When something is drawn in a data window, the Undo command will read “Undo Insert Data”. By choosing it, the last insertion you made by clicking and releasing the mouse (which could be a single event or a sweep) is cancelled.

To Undo an operation:

- Choose "Undo" from the Edit menu.

  The Undo command on the menu will change to reflect the operation that Undo will affect. If the last alteration you made was a Paste, the menu command will read “Undo Paste”, and so on.

OR

- While holding down the Ctrl key, press "Z" on your computer keyboard.

OR

- While holding down the Alt key, press the Backspace key on your computer keyboard.
If you change your mind about an Undo and want to “Un-Undo” it, the program lets you “Redo” an alteration. You can toggle as many times as you like back and forth between Undo and Redo to compare the way something sounds before and after an operation.

Undo only applies to the last change you made in the sequence. As soon as you use another Edit or Change command, start recording a new track, or draw in new data, the previous change becomes permanent and can no longer be removed with Undo.

### Editing MIDI Data while Playing a Sequence

Master Tracks Pro allows edits to be performed while a sequence is playing. Any operation will take effect immediately. If the change is over a portion of a track that has not yet been played, you will hear the changes when the measure counter reaches that location. Obviously you won’t hear changes made in a portion of the track that has already played until the next time you play the track.

A note being sustained when an edit is performed may sound cut off, but will play for its full value the next time the track is played.

The only edit operations that you can’t do while the sequence is playing are those that involve the Tempo Map in any way, although you can change tempos on a temporary basis while playing, using an Offset tempo [Chapter 5: Playback and Track Setup, "Making temporary tempo changes (Offset Tempos)"]]. Therefore, you cannot Insert or Delete Measures while playing, nor select a measure over all 64 tracks (using the measure ruler in the Track Editor) as this would affect the Tempo Map.

### Basic Edit menu commands

The Edit menu capabilities start with standard Cut, Copy, and Paste commands like those in other Windows programs. With Cut, Copy, Paste, and a couple of supplemental commands, you
can transfer data from any location in a sequence to any other location, or even to another sequence entirely.

Some Edit commands work slightly differently in different windows. Those differences are described with each of the commands.

About the Clipboard

The Clipboard is the temporary storage location that Master Tracks Pro uses when you move or copy data within a sequence, or from one sequence to another. Data placed on the Clipboard remains there until replaced by other data; a Paste operation affects data in the destination, but the Clipboard is unchanged.

For faster performance, the Master Tracks Pro Clipboard is stored in RAM, the computer’s internal memory, not on disk. This speeds editing considerably, but carries the risk of losing the data in the Clipboard if you quit the program, lose power, or suffer a computer crash (failure) for some other reason. To save data residing only on the Clipboard, you must paste the Clipboard contents into a sequence and save the sequence using the File menu commands.

Cut

The Cut command removes MIDI data from the selected region and places it on the Clipboard.

To Cut selected data to the Clipboard:

- Choose "Cut" from the Edit menu.

OR

- While holding down the Ctrl key, press "X" on your computer keyboard.
OR

- While holding down the Shift key, press the Delete key on your computer keyboard.

Cutting The Entire Sequence

If you’ve selected the entire sequence in the Track Editor using the Select All command or with the mouse, Cut removes all data, leaving a blank sequence with no Tempo Map.

*Note: If you use the Cut command to change the Tempo Map over a region that contains locked markers, you will get a message asking you how to handle the markers. See [Chapter 5: Playback and Track Setup, "Locking markers"] for a discussion of this.*

Cutting An Entire Track

If an entire track (or more than one track) is selected in the Track Editor by clicking on the track number at the left edge of the Song Editor, the Cut command removes the track entirely.

If all of the measures in a track are selected by dragging over them in the Song Editor, Cut removes all of the measures (and data) but leaves the track itself.

If all measures in a track are selected by dragging over them in the Measure Ruler of the Piano Roll or Notation Editors, or by using the Select All command in either of those windows, Cut removes all of the data (if the Select mode is set to "ALL") and leaves empty measures in the track. If the Select mode is set to "Notes", a measure will not be displayed as empty in the Song Editor if there is any other data (such as a program change or controller data) in it.

If all measures in a track are selected with the Select All command in the Event Editor, Cut removes all visible data but leaves the measures, even if they are empty.
Cutting Measures Within A Track

If you only select a few measures within a track (or tracks), the Cut command removes the data from those measures, but leaves the measures themselves intact. However, if, in the Song Editor, you select all of the measures in a track from a point in the middle to the end of the track, the Cut command removes those measures completely, shortening the track.

**Note: This is important to know when looping tracks of different lengths.**

Cutting Measures Across All Tracks

If you use the measure ruler at the top of the Track Editor to select one or more measures across all the tracks in the sequence, the Cut command removes the measures completely, and the remainder of the sequence gets shifted to the left to fill in the gap. (This function essentially duplicates the “Delete Measures” command, described later.) This will also be the case if you select the measures within the Song Editor and scroll down so that all 64 tracks are selected. Since the measures are removed completely, the Tempo Map associated with those measures is also removed.

However, if you select measures in the Song Editor and don’t select all 64 tracks, the Cut command removes data from the selected measures and tracks, but will leave those measures intact, as well as the Tempo Map.

Cutting in the Piano Roll, Notation, and Event Editors

In the Piano Roll and Notation Editors, if the Edit Mode Select icon shows two notes, only notes are removed; controllers, program changes, or other data are left intact. If the icon says “ALL”, data of all types in that region is Cut.

In the Event Editor, Cut works on all visible data. Data hidden by the Filter feature is unaffected.

**Tip:** To change the length of a track for looping purposes, cut measures from the end. The Loop function always goes to the end of each track, whether or not there is data in all of the measures. Making sure there are no empty measures at the end of a track ensures that it will loop as soon as it reaches the end of the last measure containing recorded data.
Cutting in the MIDI Data windows

In the MIDI Data windows, the Cut command removes only the data showing in that window on the track indicated in the Track box.

In the Controllers window, Cut works only on data belonging to the controller number showing in the Control Bar. In the Key Pressure window, Cut works only on data belonging to the Pitch showing in the Control Bar.

Copy

The Copy command puts a duplicate of the data in the selected region on the Clipboard without removing or otherwise changing the source data in the track.

To Copy selected data to the Clipboard:

• Choose "Copy" from the Edit menu.

OR

• While holding down the Ctrl key, press "C" on your computer keyboard.

OR

• While holding down the Ctrl key, press the Insert key on your computer keyboard.

The types of data and selection criteria for the Copy command are the same as they are for the Cut command. If a measure or group of measures is selected in the Track Editor across all 64 tracks and copied, the Tempo Map associated with that measure or group is put on the Clipboard along with the MIDI data.
Note that when you select a region and Copy it, the region stays selected. This allows you to perform a Change operation [Chapter 9: Advanced Editing, "Using the Change menu to modify data"] on a selected region while keeping the original on the Clipboard: Copy a region, Change it, then Paste the original into a different place.

**Paste**

Paste places the contents of the Clipboard (put there by a Cut or Copy) into the sequence, beginning at the location of the blinking cursor, replacing any existing data that occupies the same measures and/or tracks.

To Paste data into a sequence:

- Choose "Paste" from the Edit menu.

OR

- While holding down the Ctrl key, press "V" on your computer keyboard.

OR

- While holding down the Shift key, press the Insert key on your computer keyboard.

Note that, unlike most of Master Tracks Pro’s editing commands, you do not select a region for the Paste command to act on, but a single point from which insertion of the data begins. If you have selected a region and try to Paste, the command will not function.

If the Clipboard contains data from more than one track (in the Track Editor), data from the lowest-numbered track in the Clipboard goes into the track marked by the cursor, and data from subsequent tracks is automatically inserted into the next tracks, in order. So, if you have copied data on tracks 4, 5, and 6, and place
the insertion point on Track 11, the data will be pasted to tracks 11, 12, and 13.

You can Paste data anywhere you like: into empty tracks, into the same tracks at a different point in the sequence, into tracks with data already on them, or into other sequences.

**Note:** Pasting is a “destructive” function: if you paste notes into a region that already contains notes, the new notes will replace the old ones. The destruction is regional, meaning that it depends on the size of the region on the Clipboard, not where the actual events are within that region. In other words, if you have copied one measure of notes and three empty measures onto the Clipboard and then Paste it onto an existing track, you will end up with one measure of notes and three empty measures, even if there were notes in all four measures before you pasted. For a non-destructive Paste, use the “Mix Data” function, described below.

**Pasting in the Event Editor**

Paste works slightly different in the Event Editor. When you choose Paste, a dialog comes up asking you where (measure, beat, clock) to paste the data. If you are trying to replicate data, the value in the box will be the location of the beginning of the last regional selection you made, which makes it easy to Paste into another track at the same spot, or into the same track at a different measure (change the measure, leave the beat and clock alone). If you are cutting and pasting, the location shown in the dialog will be the beginning of the sequence.
Pasting between windows

You cannot Paste data between different types of windows. For example, you cannot paste notes into a Pitch Bend window, or Pitch Bend into the Track Editor. You cannot even Paste controllers into different controllers: if you have controller data on the Clipboard, you can only paste it into a controller window if the Controller number showing is the same as the Controller number of the window the data came from. (You can change one type of controller data to another, using the “Continuous” command described [Chapter 9: Advanced Editing, "The Continuous command"]).

However, data cut or copied from the Track Editor can be pasted into the Piano Roll or Notation Editors, one track at a time. (If you cut or copy more than one track, only the first track will be pasted.) Any non-note data taken from the Track Editor will also be pasted into the track, regardless of whether the Piano Roll or Notation Editor is in “notes only” or “all” mode, and will appear when you open the appropriate windows.

Multiple Pasting

When you Paste a region into a window, the cursor goes to the next clock position after the region you’ve just pasted. For example, in the Piano Roll Editor, if you Paste a region 100 clocks long starting right on a beat, the cursor will end up at clock number 101. Similarly, in the Track Editor, if you Paste a two-measure section starting at measure 5, the cursor will be right at the beginning of measure 7.

This fact, combined with the fact that after a Paste operation the data on the Clipboard remains unaltered, means that you can perform multiple pastes, one after another, simply by choosing Paste repeatedly or pressing Shift+Insert a number of times.

This can be useful when you want to repeat a passage a certain number of times. Select a region that encompasses the passage,
Copy (or Cut) it, and then Paste it as many times as you want. In the Piano Roll or Notation Editor, if you want the repeats to be rhythmically consistent, make sure the region you choose is a whole number of beats long. One obvious use for multiple pastes is constructing a drum track. You can create a one or two measure pattern, copy it, then paste it the number of times needed to fill up the whole track.

Clear

Clear works similarly to Cut, except that data is not placed on the Clipboard when it is removed. This gives you an alternative way to remove portions of your sequence. It is useful when you want to remove data from your sequence, but don’t want to erase what is currently on the Clipboard.

To Clear selected data from a sequence:

• Choose "Clear" from the Edit menu.

OR

• Press the Delete or Backspace key on your computer keyboard.

Like Cut, Clear only works on data in the current window: in the Track Editor, it removes all data; in the Piano Roll or Notation Editor it removes either all data or just notes, depending on the setting of the mode icon; in the Event Editor it removes only visible data; and in the MIDI Data Windows it removes only the type of data displayed in the window.

Clear differs from Cut in that you cannot remove measures from a track with Clear, you can only erase the data within them. Therefore, if you select an entire track from the Track Editor and select Clear (or press Backspace), the track will still be there, but will consist of empty (hollow) measures, whereas if you had selected Cut, the track would have disappeared completely. If you select all 64 tracks in one measure and choose Clear, you will end up with a
measure with no data in it; had you chosen Cut, the measure would have been removed and all measures to the right would have shifted over to fill in the gap.

**Mix Data (merge)**

The Mix Data command works similarly to the Paste command, except that the data in the Clipboard is merged with the data already in the sequence. Like Paste, Mix Data needs a single insertion point, not a selected region, to work.

To merge data into a track:

- Choose "Mix Data" from the Edit menu.

**OR**

- While holding down the Ctrl key, press "M" on your keyboard.

The same restrictions on moving data among windows described above for the Paste command apply to the Mix Data command. As with Paste, data remains on the Clipboard after a Mix Data operation, and the cursor moves to the end of the region affected by the operation, so that multiple Mix Data commands are possible. You can, for example, lay a short cymbal pattern on top of a kick and snare track by copying the cymbal pattern, setting the cursor to the beginning of the drum track, and repeatedly choosing Mix Data or typing Control+M. The Mix Data command does not impose a Tempo Map over the mixed region.

**Dealing with tied notes in editing operations**

Master Tracks Pro handles notes that are tied over bar lines a little differently than you might expect. These rules are designed to make editing in the Track Editor easier, by dealing with the issue of whether the notes you want to work with begin precisely on downbeats.
Notes tied into a region

Normally, if a selected region contains notes that started prior to the beginning of the region, those notes will not be affected by the operation. However, if the selected region starts on a measure boundary, any note that starts before the region but ends within it will be placed on the Clipboard truncated to start at the region start. This means that the end time is unchanged, but the duration is shortened.

In other words, if a note starts on beat 4 of measure 1 and continues through beat 2 of measure 2 (a duration of three beats), and you select a region starting on beat 1 of measure 2 and choose Copy, the Clipboard will contain a note that starts immediately and has a duration of 2 beats. If you select the same region and choose Cut, the original note is cut off at the beginning of measure 2, and the Clipboard will again contain a 2 beat note that starts immediately.
Notes tied out of a region

A variation on this rule applies to notes that begin within a selected region and end after it. Under normal circumstances, notes like this are moved to the Clipboard in their entirety by a Copy or Cut operation. However, if the note extends past a measure boundary and the selected region does not, then the portion of the note that moves to the Clipboard is cut off at the measure boundary.

Here’s an example. A note starts at beat 3 of measure 1 and continues to beat 3 of measure 2. You select a region that starts on beat 2 of measure 1 and continues to beat 4 of measure 1. When you Copy that region, the Clipboard will contain 1 beat of silence, and then a note that is exactly 2 beats long — i.e., as much of the note as appeared in measure 1. When you Cut that region, the first part of the note is cut to the Clipboard, leaving behind only the part after the beginning of measure 2. The Clipboard again contains 1 beat of silence followed by a 2-beat note.
Remember, in the Track Editor, a selected region \textit{always} starts on a measure boundary. In the Piano Roll or Notation Editor, a selected region can start on a measure boundary if the mouse is clicked when the “clocks” indicator in the time indicator box reads “000”, or (and this is much easier) if the region is selected in the measure ruler.

\textbf{Insert Measure}

The Insert Measure command allows you to put new, empty measures into a sequence. You might use this command to insert a new section into the middle of a composition or to add a blank space or countdown at the beginning. When new measures are inserted into a track, they initially show up in the Track Editor as hollow boxes. All subsequent measures are pushed to the right. You can use the command from any Editor or MIDI Data window except the Event Editor.

To insert measures into a track or sequence:

- Place the cursor. Measures will be inserted before the cursor.

- Choose "Insert" from the Edit menu.

\textbf{OR}

- Press the Insert key on your computer keyboard.

The Insert Measure dialog will open.
• Type in the number of measures you wish to insert.

• Click the radio button marked "All tracks" to insert the measures into all tracks. The whole sequence, including the Tempo Map, will be lengthened.

OR

• Click the radio button marked "Only on track" to insert the measures in a single track. If inserting into a single track, enter the track number in the box to the right of the legend. The remainder of the selected track will be shifted right, while all other tracks and the Tempo Map remain unchanged.

• Click "OK" to confirm your choice.

*Note: Measures can only be inserted into a single track or all of them. To lengthen several tracks and leave others alone, you must insert measures into each track individually.*

When you insert measures into all tracks, the new measures assume the meter, beat, and last tempo of the measure immediately before the insertion point. Use the Conductor command from the Change menu [Chapter 9: Advanced Editing, "The Conductor dialog"] after inserting the measures to change these parameters.

**Delete Measure**

The Delete Measure command is the opposite of the Insert Measure command. It provides a convenient way to remove measures from a sequence or a single track. When you remove measures from an entire sequence, the Tempo Map for those measures is removed as well, and the sequence is shortened. The command is equivalent to selecting the measures from the Measure Ruler in the Track Editor and choosing Cut, except that the data is not placed on the Clipboard.
To Delete measures from a track or sequence:

- Select the measures you wish to delete.

- Choose "Delete Measure" from the Edit menu.

OR

- While holding the Ctrl key down, press "D" on your computer keyboard.

The Delete Measure dialog will appear.

- Confirm the number of tracks and starting point indicated in the line that says "Delete {#} measure(s) starting at measure [#]". Edit the number of measures if it is not correct. If the starting point is not correct, click "Cancel" and start over.

- Click the radio button marked "All tracks" to delete the selected measures from all tracks. The whole sequence, including the Tempo Map, will be shortened.

OR

- Click the radio button marked "Only on track" to delete the selected measures from a single track. If deleting from a single track, enter the track number in the box to the right of the legend. The remainder of the selected track will be shifted left, while all other tracks and the Tempo Map remain unchanged.
• Click "OK" to confirm your choice.

**Notes on deleting measures:**

• *Measures can only be deleted from a single track or all of them. To shorten several tracks and leave others alone, you must delete measures from each track individually.*

• *If you place the cursor but do not select any measures to delete, Master Tracks Pro will default to deleting one measure. Of course, that value can be edited in the Delete Measure dialog.*

• *If you use either the Insert Measure or Delete Measure commands in a region that contains locked markers, you will get a message asking you how to handle the markers. See [Chapter 5: Playback and Track Setup, "Markers"] for a discussion of this.*

---

**Erase Clipboard**

Since data on the Clipboard is held in RAM, this command is useful when available memory is running low and there is a large block of data on the Clipboard.

To erase the contents of the Clipboard:

• Choose "Erase Clipboard" from the Edit menu.

**Inserting, deleting, and editing notes**

Basic editing of measures can be performed in any of the editors, but to work with notes on an individual basis you must work in the Piano Roll, Notation, or Event Editors.

The Piano Roll and Notation Editors share many techniques, but the Event Editor is somewhat different in nature and so its methods are largely dissimilar. As a result, most of the Event Editor's
Capabilities for note editing are treated separately from those of the other two note editors.

Master Tracks Pro gives you two ways in the Piano Roll and Notation Editors to insert new notes in your sequence other than performing them in real time: using the mouse exclusively, or in “step-time” entry, in which the desired pitch is entered by playing the corresponding key on your MIDI keyboard.

Step-time and mouse entry are both performed with the following basic steps:

- Select a track for entry.
- Choose a rhythmic value and other note parameters for entry.
- Engage the desired entry mode (step-time or mouse) by selecting the appropriate tool in the Control Bar.
- Select the point where entry should begin.
- Enter the note.

*Note: A track does not have to be record-enabled in the Track Editor to perform step-time or mouse entry.*

Note editing can be performed graphically in the Piano Roll and Notation Editors. Direct, alphanumeric editing is the primary reason for the existence of the Event Editor, but individual notes can be edited alphanumerically in the Piano Roll and Notation Editors using the Edit Note dialog.

Editing is an interactive process that usually alternates between performing an edit of some sort and then auditioning the result. For more information on auditioning, see [Chapter 5: Playback and Track Setup].
Setting parameters for note entry in the Piano Roll and Notation Editors

The first task in the entry process is to select values for the duration (rhythmic value), velocity, MIDI channel, and articulation of the note(s) you want to enter.

To set duration (rhythmic value):

Master Tracks Pro will let you define virtually any rhythmic value for insertion. Basic values are shown in a palette in the Control Bar and can be selected individually or in combination. The tuplet feature allows more unusual rhythmic values to be defined. During step-time or mouse entry, you can switch to new note durations at any time.

Note: In the Notation Editor, the selected duration also acts as an input quantizer. This quantization is made apparent by the time indicator when the cursor is moved: it will only increment by the selected rhythmic value. When a quarter note is selected, notes can only be placed on the beat and the time indicator moves in increments of 240 clocks, when a sixteenth note is selected, the time indicator increments by 60 clocks at a time, and so forth. This function can be duplicated in the Piano Roll Editor using the Snap-to-Grid feature described below.

• Click the appropriate note icon in the note palette above the Tool palette in the Control Bar. Clicking the dot icon (to the left of the "Tuplet =" button) multiplies the selected note duration by 1-1/2.
• Select a note duration using the numeric keys on your PC's keyboard: typing “1” selects the whole note, “2” the half, “3” the quarter, etc. up to “7” for the 64th. Typing “D” adds the dot to the selected value.

OR

• Assign rhythmic values to specific MIDI keys in the Remote Control dialog. Be sure to click the "use in Step Input" box to enable the Remote Control.

*Note: Durations can be entered using Remote Control only when in step entry mode (i.e. the keyboard icon is highlighted). When the arrow, pencil, or eraser tools are selected, pressing a Remote Control duration select key will have no effect.*

**Using Remote Control to select durations for Step Entry**

The Remote Control feature allows you to define certain notes to act as control keys for selecting durations in Step Entry mode. Typically, notes at the very top or very bottom of the keyboard (or other controller's range) are used for this purpose. In addition to durations, notes can be assigned to enable the Rest and Tuplet functions, or execute a Backspace (note delete).

*Note: If you are also using Remote Control to operate transport functions [Chapter 2: Getting to Know Master Tracks Pro, "Remote Control"], be careful not to assign any of the same notes to control duration selection in step entry.*

To assign a note to select a duration for step entry:

• Choose the "Remote" command from the Setup menu to open the Remote Control Setup dialog.
• Click the "Use in Step Input" check box to enable remote duration select control.

*Note: If "Use in Step Input" is not enabled, no remote duration select controls will function.*

• Click the check box of the duration (rhythmic value) you want to be able to select remotely.

• Click in the text box to the right of the rhythmic value to select it.

• Type in the note name (A-G), followed by a "#" if an accidental is needed, and the octave number, e.g. "G#0"

OR

• Type in the MIDI note number (between 0 and 127)

OR

• Play the note on your MIDI controller.
Repeat for as many durations or functions as you wish to select remotely. Click OK to confirm your settings.

To combine durations:

If you wish, you can select a combination of rhythmic values, which will add together to make the total duration of the note you are inserting.

• Click on the first note duration you want to select

• Hold the Shift key down and click on the other note durations you wish to select. Clicking on any duration a second time deselects it.

Note: Durations can also be combined when selecting with the computer keys in the same fashion: hold the Shift key while pressing duration select keys.

Selecting tuplet durations

Tuplets occur when a number of notes of a basic value are intended to play in an amount of time usually filled by a different number of notes with the same apparent value. The most common example is triplets, which is three notes occurring in the space usually filled by two notes.

Tuplets are expressed as the ratio of the desired number of notes to the usual number of notes of that value. Triplets, for example, would be expressed as a ratio of 3:2. Master Tracks Pro allows any ratio combining numbers between 1 and 64 (1:64, 17:33, 64:6, etc.) to be defined. This ratio is then applied to the selected basic value. If a sixteenth note basic value is selected and a 5:4 ratio is defined, each note you play will be a sixteenth-note quintuplet, that is, playing five notes will fill the space of one quarter-note.

Note: To make tuplets from existing notes, use the Change Duration or Scale Time commands [Chapter 9: Advanced Editing, "Duration" and "Scale Time"].
To enable tuplet entry and define a tuplet value:

- With step-time entry enabled, select a basic rhythmic value from the note palette.

- Click the "Tuplet =" box in the Control Bar to enable tuplet entry.

- Click the ratio box to the right of the "Tuplet =" box. A dialog will open to allow you to define the ratio.

![Change Value Dialog]

- Type in or use the scroll bar to set the ratio values in the boxes in the dialog and click OK to confirm your selections.

Notes played on your MIDI keyboard will now be step-time entered with the defined tuplet value until tuplet entry is disabled.

To disable tuplet entry:

- Click the "Tuplet =" box in the Control Bar to uncheck it, disabling tuplet entry.

To set articulation, velocity, and MIDI channel:

Articulation, velocity, and channel are all set in the same way. Descriptions of each of these parameters follow.

- Click on the appropriate button in the Control Bar.
• Type the desired value in the Change Value dialog that opens. Click "OK" to confirm your entry.

Articulation

Note: Articulation is only available in the Piano Roll Editor

Articulation refers to the percentage of the note’s duration value that is actually sounded. An eighth-note duration with 50% articulation will sound the same as a 16th note with 100% articulation. By varying the articulation setting, you can make changes in note length to define phrases as legato and staccato passages. Shorter articulations produce a more staccato effect. The range of the articulation parameter is 1% to 100%.

Note-on Velocity

Note-on velocity is usually (but not always) related to volume. Velocity values can range from 1 to 127.

Note: A note-on velocity value of 0 is defined in the MIDI specification as a form of Note-Off message, so it is not available.

Note-off Velocity

Note-off velocity indicates how fast a key is released. There are not many MIDI controllers that generate note-off velocity, nor devices
which respond to it, so unless you have one of those, it’s best to leave this parameter at 64. Check your devices’ MIDI specifications.

**MIDI Channel**

The MIDI channel button (to the right of the "Track = #" button) sets the MIDI channel of the note(s) you place as if they had been received from that channel during recording. If the track is assigned a specific channel for playback in the Track Sheet portion of the Track Editor, that channel is displayed in this box. If it is unassigned (the Chnl column in the Track Editor says “–”), this box will say “Channel=1”.

Any channel number from 1 to 16 can be entered in the dialog that opens when you click this button. Any notes entered will have the new parameter setting as their channel number. This setting will also affect which MIDI channel notes will sound on when the previewing “hand” icon is being used.

![Change Value Dialog]

*Note: The Track Sheet channel assignment overrides individual note channel settings. Therefore, this setting only determines the MIDI channel the note plays or is previewed on if the track is unassigned.*
Inserting notes with a mouse

- Click on the pencil tool in the Control Bar to select it

OR

- Press the “P” key on your computer’s keyboard.

- Move the pointer to the data area. The pointer becomes a crosshair. Position the pointer on the screen exactly where you want the new note to appear.

Use the keyboard graphic at the left of the data area and the measure and beat markings along the top to help you align the crosshair. The pitch and time indicators in the Control Bar also aid in locating the position precisely.

- When you have the correct position, click the mouse. A new note will be inserted into the data area at that position, with the duration, velocity and articulation you selected.

Quantizing note entry in the Piano Roll Editor (Snap to Grid)

One of the reasons for using mouse entry is to place notes precisely. In the Notation Editor, note placement with the mouse is always quantized to the selected rhythmic value, as described above. While the time indicator in the Control Bar allows you to place notes with precision in the Piano Roll Editor, it is useful to have a faster and simpler method of placing notes on a beat or beat subdivision. When the Snap-to-Grid feature is enabled, the Piano Roll Editor acts like the Notation Editor: notes can only be entered in increments of the rhythmic value set for Snap-to-Grid. Note that this is a separate setting, independent of the rhythmic value selected for insertion.
To set the Cursor Snap Value:

- Double-click the note icon in between the Track button and the pitch indicator in the bottom row of the Control Bar. The Cursor Snap Value dialog will open.

![Cursor Snap Value Dialog](image)

- Select a rhythmic value from the palette in the dialog. Click the dot icon to multiply the rhythmic value by 1 1/2. If you desire tuplet quantization, click the Tuplet check box and enter the ratio values in the boxes. Click "OK" to confirm your entry. The dialog will close and Snap-to-Grid will be enabled.

*Note: Rhythmic values cannot be combined in the Cursor Snap Value dialog.*

To enable and disable Snap-to-Grid:

- Click the note icon in between the Track button and the pitch indicator in the bottom row of the Control Bar to enable Snap-to-Grid. The icon will be highlighted to show that it is enabled. Click again to disable it. Note that Snap-to-Grid is automatically enabled when the Cursor Snap Value is set.
Erasing (deleting) a note

Tip: If you have trouble erasing a note, move the window (with the scroll bar) so that the note appears as close as possible to the left edge, and zoom in on it. You'll find it easier to erase notes at higher magnifications.

- Click on the eraser tool in the Control Bar

OR

- Press the “E” key on your computer keyboard to select the eraser tool.

When you move the pointer into the data area, it will become a crosshair inside a circle.

- Position the eraser pointer anywhere over the note you wish to erase and click. The note will disappear from the window.

You can also use region editing techniques to erase notes: select a region, then choose Cut or Clear from the Edit menu or press the Backspace key on your computer's keyboard.

Moving a note

In the Piano Roll and Notation Editors, an individual note can be moved somewhere else in the track, simply by dragging it.

- Click the arrow tool in the Control Bar or press "A" on your computer keyboard to select it. The pointer becomes an arrow.

OR

- In the Piano Roll Editor only, click the pencil tool in the Control Bar or press "P" on your computer keyboard to select it. The pointer becomes a crosshair.

- Place the pointer directly over the note you wish to move. (In the Piano Roll Editor, the pencil pointer should be placed in the left half of the note. The arrow pointer can be placed anywhere over the note.)
• Click and hold the mouse button and drag the note to the desired location and pitch. The pointer will drag a "ghost" image of the note to the new location. As you drag, the time indicator in the Control Bar indicates what the new start time of the note will be.

[Image: Piano Roll Editor]

• When the note is correctly positioned, release the mouse button. The note is moved to the new location.

Constrained movement

There are times you'll want to shift a note's position in time but not change its pitch, or vice-versa. To make these operations easier, Master Tracks Pro provides a way, similar to that used in many Windows graphics programs, of limiting, or "constraining", movement to either left-right motion or up-down motion. When movement is constrained to one axis, the pointer may move in the other axis, but the value in that axis will not change. If movement is constrained to left-right motion, the pitch of the note being moved will not change, no matter what up-down movement is made with the mouse.
To constrain note movement:

- Hold down the Shift key
- Move the note as described above. The note's movement will be constrained to the first drag motion you make: if you click on the note and start to drag it to the right, movement will be constrained to left-right motion (changing the note's start time). If your first movement is up or down, movement is constrained to that axis (changing pitch).

Copying a note

The ability to copy a note is useful for creating notes with the same duration, velocity, and channel attributes as one already in the sequence. The starting time and pitch of the new note, however, need not be the same as the note of which it is a copy.

- Hold down the Ctrl key.
- Move the note as described above. The “ghost note” that appears is a copy of the original note. The original note is unaffected by the operation.

Stretching or shrinking a note's duration (Piano Roll Editor)

- Click the pencil tool in the Control Bar or press "P" on your computer keyboard to select it.
- Place the pointer directly over and anywhere in the right half of the note you wish to change.
- Click and hold the mouse button and drag the back of the note to the right to lengthen it or to the left to shorten it. The note becomes highlighted, and the highlight is extended as you drag to show where the new end time of the note will be.

Tip: The Control and Shift keys can be used in combination, making it easy to build chords from a single note.
As you drag, the time indicator in the Control Bar indicates what the new start time of the note will be, and a new indicator appears to its right displaying what the new end time will be. The duration is the difference between the end time and the start time.

- When the note is the desired duration, release the mouse button. The note is redrawn to the new duration.

You can stretch a note as far as the right edge of the window. If you want to stretch it more, either Zoom out or scroll the screen so that the end of the note falls in the middle of the screen (yes, you can stretch a note that starts previous to the left edge of the window).

At the highest magnification you can shrink a note down to one pixel. It is not possible to shrink a note so much it disappears; if you drag left past the start of the note and release the mouse button, the shrink operation will have no effect.

Tip: The exact duration can be viewed in the Edit Note dialog, described below. Using the "P" and "A" keys to select the different cursors, it is possible to go quickly back and forth between the two to adjust the duration, then check its exact value.
Editing note parameters alphanumerically: the Edit Note dialog

Besides working with note data on a graphic level, Master Tracks Pro lets you deal with notes numerically, for the greatest possible accuracy. The Event Editor allows any MIDI event on a track to be edited alphanumerically, as described below, but individual notes can be edited numerically in the Piano Roll and Notation Editors using the Edit Note dialog.

To open the Edit Note dialog for a note:

- Click the arrow tool in the Control Bar or press “A” on your computer keyboard to select the arrow tool.

- Position the arrow directly over the note you want to edit and double-click to open the Edit Note dialog.

The Edit Note dialog will pop up in the vicinity of the note. You can drag the dialog to a more convenient position if you want to. To help you remember which note you’re working on, the note becomes highlighted.

The Edit Note dialog shows (from left to right): the start time (in measures, beats, and clocks), pitch (note and octave number), On and Off velocities, duration (also in measures, beats, and clocks), and MIDI channel of the note. Note that the number of measures displayed in the note’s duration is defined by the time signature of the measure in which it begins — i.e., if the note starts in a 3/4 measure and is four beats long, it will be displayed as “01:01:000” (one measure plus one beat), even if the measure it ends in happens to be a 4/4 bar.
To edit note parameters in the Edit Note dialog:

- Click on the parameter you wish to edit to highlight it. Type in or use the scroll bar at the bottom of the dialog to set the parameter to the desired value.

For pitch names, type the letter, and, if an accidental is needed, the “#” sign, then the octave number. Master Tracks Pro will beep if you attempt to enter an invalid setting. Alternatively, the Pitch value can be set by selecting the Pitch field and pressing the appropriate key on your MIDI keyboard.

You can step through the fields in the Edit Note dialog by pressing the Tab key.

- Click "OK" to confirm your settings

Note Remapping (Piano Roll Editor)

In the Piano Roll Editor, Master Tracks Pro allows you to transpose all notes in a sequence of a selected pitch in a single drag operation. This is known as “note remapping”. It is useful when you want to change the mode of a track (to go from C major to C dorian for example, you might change all the E’s to E♭’s and the B’s to B♭’s), when you have created a track using one drum machine, and want to play it on another on which the drum/note assignments are different, or simply to audition a percussion part using a different instrument (assigned to a different pitch) than the one currently assigned to the part.

To move all notes of a pitch to a different pitch:

- Click the arrow tool or type “A” on your computer keyboard to select it.

- Move the pointer to the left side of the window where the picture of the piano keyboard appears and position it on the pitch that you wish to change
• Click and hold the mouse button. You will hear that pitch sound over the current MIDI channel, and all of the notes at that pitch will be selected.

• Continue to hold the button and drag up or down to the pitch to which you want the notes transposed. As you pass over each “key” on the keyboard, you will hear it played.

• When you arrive at the desired pitch, release the mouse button. All notes of the selected pitch will be transposed to the new pitch.

Note: Remapping is a non-destructive operation. If there are existing notes at the destination pitch of a remapping operation, the remapped notes will be merged with the existing notes. In the Piano Roll Editor it will not be possible to see this, but it can be confirmed in the Event Editor. This can result in two notes of the same pitch sounding at the same time.

Also, remapping transposes every note at the selected pitch on the entire track, from beginning to end, not just the ones showing in the window. If you need to transpose notes in only part of a track, use the Transpose function [Chapter 9: Advanced Editing, "Transpose"] and the Change Filter [Chapter 7: Viewing & Selecting Data for Editing, "The Change Filter"], or select a region, copy it to a new track, remap it, and paste or mix it back into the original track.

To copy all notes of a selected pitch to another pitch:

• Hold down the Shift key.

• Remap all notes of a pitch as described above while continuing to hold the Shift key. The original notes will remain unchanged, and new notes will appear at the destination pitch.

This can be very useful for doubling individual drum sounds (putting a bass drum hit under every crash cymbal, for example), or for building chords out of individual notes.
Step-time entry from a MIDI instrument

Step-time entry from a MIDI controller is a very useful feature of most good sequencers, providing a simple and precise means of entering difficult passages. Step-time entry is available in both the Piano Roll and Notation windows.

Step-time entry is almost the same as mouse entry, with the biggest difference being that notes are entered from a MIDI controller instead of with the mouse.

In step-time entry, as in notation, duration is expressed in terms of rhythmic value (quarter, eighth, etc.).

To perform MIDI step-time entry:

• Select a track.

• Set rhythmic value, articulation (in the Piano Roll Editor only), and channel as desired. Pitch and both note-on and note-off velocity values are taken from the notes as they are played on your keyboard.

• Click the keyboard tool in the control bar to enable step-time entry.

• Click the pointer at the point at which you wish to begin entering notes.

• Play the notes on your keyboard.

Each time you play a key, a new note appears, and the cursor advances by the selected rhythmic value to the next insertion point. As you continue to insert notes, the Editor scrolls appropriately.

You may change rhythmic values at any time and continue entering pitches for as long as you like. Master Tracks Pro will stay in
step-time entry until you click the arrow in the Control Bar to exit step-time mode. However, if you click to place the insertion point, it ends the current step-time entry "pass" and starts a new one.

**Rests and corrections**

To insert a rest:

- Select the rhythmic value corresponding to the length of rest you wish to insert.

- Press the "R" key on the computer keyboard. A rest is inserted with the selected value.

To delete a note in step-time entry:

- Press the Backspace key on your computer’s keyboard to delete the last entry and move the cursor back.

*Note: You can delete as many notes as you want with the Backspace key (as long as the proper value is selected), but only within the current pass — if you reposition the cursor with the mouse, then the Backspace key will have no effect on notes entered before you moved the cursor.*

If you change tracks in the middle of a pass, then any Backspace key operations will only work on the current track, not on the previous track.

By the way, the Backspace key *always* moves the cursor back by the selected value, whether or not any notes have been recorded in that space. For example, if you want to start step-time entry a 32nd note before a downbeat, select 32nd note as the duration, place the cursor on a downbeat, then press Backspace once before playing the notes.
Step-timing chords

Chords can be step-time entered as easily as notes. Master Tracks Pro determines that two (or more) notes are to be treated as a chord if the second key is pressed before the first note is released. This means that you don’t have to play all the notes in a chord perfectly simultaneously; you can easily construct chords of any size by simply playing them very legato, and not releasing any note until the next note is played. It also means that you must be careful when entering single-note lines not to play too legato, or the program may interpret what you are playing as chords.

Step-time overdub with merge

If you start step-time entry where there are already notes in a track, step-time recording, unlike normal recording, will not erase existing notes, but will merge in the new data. In this case, the Backspace key will only affect the notes entered in the most recent step-time pass (i.e., since you last placed the cursor), not any previously entered or recorded notes.

Editing in the Event Editor

The Event Editor presents an alphanumeric list of all MIDI events occurring in a track. By hiding certain types of events and leaving others visible it provides the easiest method of selectively editing the data on a track. It is also the window that shows the most information at one time about an event. However, its text orientation means that the graphical techniques available in the other Editors do not apply.
Moving through the Event Editor

There are three ways to move through the Event Editor:

- Use the scroll bar at the right side of the window.

- Use the up and down arrow keys to step to the previous or next event. If a field is selected when you do this, that field will become selected in the event to which you step. Holding down the arrow key will cause the list to scroll continuously.

- Move to a specific spot in the sequence by clicking on the “Goto...” box in the Control Bar [Chapter 7: Viewing & Selecting Data for Editing, "Locating for editing"] and typing in the measure, beat, and/or clock to which you want to locate.
There are also three ways to select a field for editing:

• Click in the field on the line of the event you wish to edit.

• If a field is already selected, use the Tab key to step to the next field for that event and select it for editing.

• If a field is already selected, use the left and right arrow keys to step to the next or previous field for that event and select it for editing.

To insert an event:

• Click on the icon on the Control Bar of the type of event you wish to insert. The new event will be inserted immediately above, and, initially, have the same start time as, the first event showing in the window at the time (which is not necessarily the first event occurring in the list). The measure field of the new event will be highlighted; type any new data you wish into it, and/or any other fields you want to change.

The Insert Event icons in the top row of the Control Bar are as follows (from left to right): note, program change, pitch bend, controller, channel pressure (mono aftertouch), and key pressure (poly aftertouch).
To delete an event:

- Click in the “Event” column by the event you wish to delete to select it. All events occurring at this time will become highlighted.

- Press the Backspace key

OR

- Choose "Clear" from the Edit Menu.

Note: All events on a track occurring at precisely the same time are selected together and cannot be selected separately. In order to edit them independently, you must change the time for one of them. The simplest way to do this is to click on the “clocks” value and change the number by one.

To edit events:

- Click on the field you wish to edit for the event. It will highlight to show it is selected.

- Type in the new value. If the value you want to change is a pitch or Program Change, you can also enter it by playing the MIDI note or sending the program change from your MIDI keyboard. Click anywhere outside the field or press the Return key to confirm your entry.

If you change the time of an event, the list will automatically reorder itself to maintain chronological order. Note that you cannot change an event type; you must delete the current event and insert a new one to accomplish this. (For controller, pitch bend, or aftertouch data, you may select the data and use the Change Continuous command to remap it. [Chapter 9: Advanced Editing, "The Continuous command"]
Filtering events

The “Filter” function on the Control Bar lets you eliminate certain types of data from view, which lets you see others more clearly. Hidden data is not deleted, merely temporarily removed from view. Viewing data one type at a time can be a useful troubleshooting tool when there is something strange going in a track.

However, it is important to note that Edit and Change menu operations performed in the Event Editor only affect visible data. Thus, the Filter function is both a View and Edit filter. [For more information on the Filter function, see Chapter 7: Viewing & Selecting Data for Editing, "View Filtering".]

Inserting, deleting, and editing program changes

Inserting program changes

There are three ways to insert a program change into a sequence in Master Tracks Pro:

- "Perform" the program change on your MIDI controller while recording in real time.

- Insert a program change event in the Event Editor. Inserting events in the Event Editor is discussed in detail earlier in this chapter.

- Place a program change in the Piano Roll Editor.

Note: The range of program numbers used by Master Tracks Pro is 1 to 128. However, some synthesizer manufacturers number their program changes 0 to 127. In these cases, program 1 in Master Tracks Pro will call up program 0, program 2 will call up program 1, etc.

To place a program change in the Piano Roll Editor:

At the bottom of the Piano Roll Editor is a yellow triangle that
resembles the Marker Well at the top of the window, except that the triangle faces up instead of to the left. This is the Program Change Well. Placing a program change is done in the same manner as placing a marker.

- Drag a marker from the Program Change Well at the bottom of the window to the location where you wish to have a program change.

- Release the mouse button at the desired location. The Device (Choose Instrument) dialog [Chapter 5: Playback and Track Setup, "The Device dialog"] will open.
• Choose the desired program in the dialog. Click "OK" to confirm your choice.

Deleting program changes

To delete a program change:

• Delete the event in the Event Editor. This is discussed above.

OR

• Drag the Program Change Marker back to the Program Change Well in the Piano Roll Editor.

OR

• Use a Cut or Clear operation in the Piano Roll or Notation Editor (if the program is set to Cut or Clear all data).

OR

• Simply record over the program change.

Editing program changes

To edit a program change:

• Select and edit the program change event in the Event Editor.

OR

• Double-click the Program Change Marker in the Piano Roll Editor. The Choose Instrument dialog will open. Edit as desired and click "OK" to confirm your entry.
Notepad

The Notepad provides a convenient way of recording memos, track assignments, marker lists, and any other text data you might feel would be appropriate to accompany a sequence. Each sequence file has its own Notepad, which is saved and loaded with the sequence. Master Tracks Pro can place information about all the tracks and markers on the Notepad, in addition to any remarks you may enter.

*Note: Do not confuse Master Tracks Pro's Notepad with the Windows Notepad application.*

To open the Notepad:

- Choose the "Notepad" command from the Info menu.

The Notepad accepts text data like any word processor and puts it on a single “page” of unlimited length. Once entered into the Notepad, text can be manipulated in all of the usual ways, using the mouse and the commands on the Edit menu (Undo, Cut, Copy, Paste, and Clear). Text can also be imported from and
exported to other Windows applications using the Cut, Copy, and Paste commands to move text to and from the Clipboard.

The Notepad window can be resized as desired, and the window size is remembered for the duration of the session.

To place all track information on the Notepad:

• Choose the "Track Info" command from the Place Info menu in the Notepad window. The Track Sheet information (Track number, channel, initial program change number, initial controller value, and track name) for all tracks will be pasted into the window.

To place all marker information on the Notepad:

• Choose the "Marker Info" command from the Place Info menu in the Notepad window. The measure/beat/clock, time, and name of all markers in the sequence will be pasted into the window.

Tip:
The "Preferences" command in the File menu will save the size of the Notepad window and make it the default.
Using the Change Menu to modify data

While the Edit menu commands let you move or delete regions of notes, the Change Menu contains a number of commands that allow you to regionally alter MIDI data in sophisticated ways. Unlike the Edit menu commands, the Change menu commands will normally affect all notes and “continuous” data—controllers, pitch bend, and channel pressure—in the region selected, regardless of the window in which the selecting is performed. So, for example, you can change the durations of notes in a region by selecting the region in the Channel Pressure window and using the Change Duration command. An exception to this is the Scale Time command, which will be discussed shortly.

Some Change commands, like Velocity, work only on notes, while others work on both notes and non-note data. The Continuous command works only on non-note data, and the Conductor command works only on the Tempo Map, and not directly on MIDI data at all.

The restrictions on using the Change commands are the obvious ones:

- In the Piano Roll Editor, Event Editor, or any of the MIDI Data windows, you can only define a region on one track, while in the Track Editor you can define a region on as many tracks as you like.
- In the Track Editor, region boundaries must be on measure boundaries, while in the Piano Roll Editor, Event Editor, and MIDI Data windows region boundaries can be on any clock.
Included in the Change menu are commands for changing the MIDI channel of recorded notes, note durations, note velocities, continuous MIDI data (controllers, pitch bend, and aftertouch), and tempo and meter in the selected region. There are also commands for stripping different types of data out of a track, transposing pitch, and for changing the rhythmic relationships of MIDI events.

Not all commands in the Change menu are explained in this section, some Change commands are discussed elsewhere in more appropriate places. The commands that are discussed individually below are not in the order in which the commands appear in the Change menu, but according to how often they tend to be used.

To perform a Change operation:

- Select a region using one of the techniques described in [Chapter 7: Viewing & Selecting Data for Editing].

- Choose the desired Change menu command to begin the operation. All Change menu commands have dialogs for defining how the operation should proceed.

At any time, in any Change command dialog, you can click “Cancel” and return to the window from which you came, with the region still selected, but no operation having taken place.

After a Change operation is completed, the selected region stays selected, which makes it easy to go ahead and perform another operation on the same data right away. Since many of the operations complement each other, this can be a great time-saver.

Also, as with Edit commands, notes that begin before a selected region but end in it are not affected by Change menu commands, but notes that begin within the region and end after it are affected. The exceptions for tied notes do not apply.
Finally, like Edit commands, Change commands can be made while a sequence is running. The same restrictions apply to Change operations as to Edit operations. No operations can be made that affect the Tempo Map, so operations that affect all 64 tracks are not allowed. Also, the “Channel”, “Conductor”, and “Fit Time” commands can not be used when the sequencer is running.

Using the Change Filter

Many of the Change menu dialogs have an item labelled “Change Filter”. This is a special set of parameters that lets you limit what data will be affected by the Change operation. The Change Filter is discussed in [Chapter 7: Viewing & Selecting Data for Editing, "The Change Filter"].

To enable the Change Filter on a Change operation:

- Click the "Use Change Filter" check box in the Change operation dialog (if present) to enable the Change Filter.

To set the Change Filter parameters:

- Click the "Change Filter" button in the Change operation dialog (if present) to open the Change Filter dialog. Remember that the Change Filter will have no effect unless the enable box is checked.

Quantize

The Quantize command aligns the start times of all notes in the selected region to an imaginary timing “grid”. The grid divides the region into intervals of a set number of clocks. When you use the Quantize command, the command moves the start time of every note within the region so that it falls precisely at the beginning of the nearest grid interval.

There are a number of options in the Quantize dialog to customize and modify the command's behavior. The settings you make in the
Quantize window are retained until you change them or exit the program.

To quantize the notes in a region:

- Choose "Quantize" from the Change menu to open the Quantize dialog.

OR

- Press Ctrl+Q on your computer keyboard to open the Quantize dialog.

- Click the "Quantize to" check box to select it. If this box is not checked, the Quantize operation will not be performed.

- Set the options (described below) as desired. Click "OK" to perform the Quantize operation.
Quantizing entire notes or note attacks only

One of the first things to consider when quantizing is whether you want to quantize entire notes or just their start (attack) times. If you choose to quantize attacks only, the start time of the note is quantized, while the end of the note stays where it is, thereby changing the duration. This is useful if you have an event whose ending time is more important than its duration.

If you choose to quantize entire notes, the duration is maintained, and the end of the note moves right along with the beginning. This is generally more musical, and is useful when a note has a certain envelope characteristic which you want to maintain.

To quantize entire notes:

• Click the radio button marked "Entire note" at the top of the Select Options box in the Quantize dialog.

To quantize note attacks only:

• Click the radio button marked "Attacks only" at the top of the Select Options box in the Quantize dialog.

Setting the Quantization Value

The most common use of quantization is to rhythmically “correct” notes that have been played by a live performer so that they fall directly on a beat or subdivision. Another use is to set up rhythms—especially polyrhythms—that would be difficult if not impossible for a human to play, such as 13 over 7. For that reason, Master Tracks Pro lets you quantize to just about any rhythmic value imaginable.

• Enter the quantization value as a number of clocks in the box to the right of the "Quantize to" legend.

OR
• Click in the scroll bar in the rhythmic value box on the right of the Select Operation box to make it active.

• Use the scroll bar or the up/down arrow keys on your computer keyboard to select the desired rhythmic value. The number of clocks in the box to its left will change to match the displayed rhythmic value.

• Click the "Tuplet" check box if a tuplet quantization value is desired and enter the desired ratio into the boxes to the right of the "Tuplet" legend. For more information about tuplets, see [Chapter 8: Basic Editing, "Inserting, Deleting, and Editing Notes"].

Including notes ahead of and behind the beat

In a conventional quantization function, notes that lie more than 50% of the way between two points on the quantization “grid” will be quantized to the later point, while notes that are less than 50% of the way are quantized to the earlier point. If you consistently play a little ahead of or behind the beat, many notes may be quantized to the wrong beat. Master Tracks Pro’s “Include notes up to...” function lets you slide this "window of inclusion" around to help compensate for this.

To set the "Include notes up to..." value:

• Type in a value between 1 and 100 (percent) in the box to the right of the "Include notes up to..." legend.

The default “Include notes...” setting is 35%. This means that notes 35% or less ahead of the beat will be quantized back to the beat (moved later), while notes more than 35% ahead will be quantized to the previous beat (moved earlier). Another way of looking at it is that notes up to 65% late will be quantized to the previous beat.
This setting favors players who are late. Players who tend to rush and find themselves ahead of the beat should use a setting like 70%, in which case only notes more than 30% late will be quantized to the next beat.

Setting quantization intensity

Quantization can make a musical passage sound overly mechanical if it is not used carefully. One way to overcome this is with the Intensity parameter in the Quantize dialog. The Intensity parameter determines the "strength of pull" the Quantize command will exert, that is, how close to the actual quantization point the program will bring notes when they are quantized. If the Intensity is set to 100%, the notes will be quantized exactly to the quantization “grid”. If it is set to 0%, they won’t be quantized at all. If it is set to 50%, they will move halfway towards the grid.

Here’s an example. You have a note that occurs 100 clocks after a beat, and are quantizing to quarter notes. If the Intensity interval is set to 100%, the note will be moved to occur right on the beat (clock 0). If it is 70%, the note will move 70% of the way towards the beat (70 clocks in this case), and will end up 30 clocks after the beat. If it is 20%, it will occur 80 clocks after the beat. If it is 0%, it will stay 100 clocks after the beat, and so on.

To set the quantization intensity:

- Type in a value between 1 and 100 (percent) in the box to the right of the “Intensity” legend.

Swing

Swing is a rhythmic feel common to jazz, and is based on distorting the rhythmic relationship of pairs of notes having (supposedly) the same rhythmic value. The most common occurrence is a pair of eighth notes that make up one beat in 4/4 time. To "swing" the eighth notes implies that the downbeat eighth note is played for somewhat more than half the beat, while the offbeat eighth
complements this by sounding for somewhat less than half the beat. The value of a beat is unchanged, but it is not broken up symmetrically.

There are two Swing parameters: the rhythmic value that will be swung and the Swing Factor. The rhythmic value can be set to any length note from 64th to whole note (you can’t swing dotted notes). The Swing Factor refers to how the beat (or whatever value is constituted by a pair of notes at the selected rhythmic value) is broken up, expressed as the percentage of the beat consumed by the first note of the pair.

Setting Swing Factor to 50% means there will be no swing—the notes will come out exactly even. Setting it to 75% means that the first note of the pair occupies the first three-quarters of the beat and the second note the remaining 25%. In other words, with an eighth note value selected, a Swing Factor of 75% produces a dotted-eighth followed by a sixteenth. “Triplet swing” is produced with a factor of 66.7%, the default setting.

The Swing feature can be used without Quantizing, but it works better on quantized notes or notes entered in Step Time.

To use the Swing feature:

• Click the check box marked "Swing" to enable the Swing feature.

• Use the scroll bar to select the note icon for the desired Swing rhythmic value in the box to the right of the "(50.0 to 75.0)" legend.

• Type the Swing Factor percentage you want in the box to the right of the "Swing" legend. Swing Factor can be set anywhere between 50% and 75%, in increments of 1/10th of a percent.
Sliding Notes

The Quantize command’s ability to shift or slide regions slightly forwards or backwards is invaluable for creating passages that are a little ahead of or behind the beat, or to compensate for synthesizer voices with especially long or short attack times. When Slide Notes is enabled, all the notes in the track are moved the specified number of clocks to the left or the right after quantization is performed.

You can also slide notes without quantizing them. Just turn on the slide function and make sure the quantization function is turned off.

To slide notes:

- Click the "Slide Notes" check box to enable the function.
- Type in the number of clocks you want to slide the selected notes.
- Click the "left" radio button to slide the notes earlier by the specified number of clocks, or the "right" radio button to slide them later.

*Note: Slide Notes affects note data only. Pitch Bend and other controller information on a track is not moved. To move note, controller, and other data like program changes together, use the Slide Data command in the Change menu.*

Humanize

The Humanize command is more or less the opposite of the Quantize command. It is designed to make a sequence — especially one entered in step-time or already quantized — less machinelike and rigid by shifting the start time, duration, and/or velocity of each note in the selected region by a random amount that cannot exceed a specified limit. It is the randomness that adds the human factor, and the ability to set limits on how randomized
the data gets that keeps it sounding realistic. (Of course, you can choose to set it to sound unrealistic, if you like, even surrealistic.)

The Humanize command adds or subtracts a number somewhere between 0 and the maximum variation specified for each note parameter enabled. For example, if you tell the program to humanize start times to a maximum of 3 clocks, each note's start time will be advanced or delayed by 0, 1, 2, or 3 clocks. In this case, two notes with the same start time could, after humanizing start no more than 6 clocks apart (if one is advanced three clocks and the other delayed three).

To Humanize a selected region:

- Choose the "Humanize" command from the Change menu to open the Humanize dialog.

![Humanize Dialog]

- Click in one or more of the check boxes to enable randomization of start times, durations, and/or velocities.

- Enter the maximum variation allowable in the text box for each parameter enabled in the last step. For start times and durations, type in the maximum number of clocks, for velocities type in a number between 1 and 127.

- Enable and set up the Change Filter, if you wish to use it.

- Click "OK" to perform the Humanize operation.
In practice, very small values work best for achieving subtle variations in highly mechanical music. Large values produce wide and random changes that are sometimes useful, but not predictable.

A Quantize/Humanize example

Here’s a good example of how to combine commands over a selected region to achieve a musical goal. To emphasize a downbeat, drummers sometimes rush a fill at the end of a bar and leave a bit of a gap before the downbeat. To create this effect:

• Select the fill.

• Quantize it to sixteenth-notes and slide it to the left by 12 clocks.

• Humanize the start times to a maximum of 6 clocks. (Remember, the region stays selected after quantizing, so you don’t have to re-select it.)

This will give the effect of the fill being early. The timing change is subtle but apparent, thanks to the randomization.

Duration

The Duration command allows you to alter the actual duration of each note in the region, either by setting all notes in the region to the same specified duration, or by scaling the existing durations by a specified percentage.

To alter the durations of a region:

• Choose the "Duration" command from the Change menu.

• Select one of the two available methods of modifying the durations (described below).
• Enable and set up the Change Filter, if you wish to use it.

• Click "OK" to change the durations.

Setting all notes in a region to a specified duration

• Click the radio button marked “Set all values to”.

• Select a rhythmic value icon between 64th note and dotted whole-note in the scroll box on the right. The box immediately to the right of the "Set all values to" legend shows the equivalent number of clocks for the selected rhythmic value.

OR

• Double-click in the numeric box and type in the number of clocks you want the notes to be. The allowable range is 1 (1/240th of a quarter note) to 32767 (a little over 34 measures in 4/4 time).

• Click in the "Tuplet" check box to enable tuplet values, if you wish. Enter the desired values for the tuplet ratio in the numeric boxes to the right of the "Tuplet" legend. The number in the clocks box will change to reflect the tuplet value you’ve set up.

Tuplet values are relative to the rhythmic value icon showing on the right side of the dialog. For example, if an eighth note icon is
showing, “3:2” means the duration will be equal to one note in a triplet that fills the space of two eighth notes. Two eighth notes = 2 x 120 clocks = 240 clocks, divided by 3 = 80, so the duration of these notes will be 80 clocks, and the number in the clock box will be 80. If a quarter note icon is showing, “5:4” means the duration will be equal to one note in a quintuplet that fills the space of four quarter notes: 240 x 4 = 960 ÷ 5 = 192 clocks. If the tuplet you’ve created doesn’t divide into an even number of clocks, the program will round off the value to the nearest clock.

Scaling existing durations by a percentage

Scaling all duration values in the selected region by a percentage of their current values preserves the relative relationship between note durations in the region.

• Click in the radio button beside the words “Change to” to enable scaling of durations.

• Type in the percentage by which you wish the current duration values to be scaled, within the range of 1 to 9999%. The program rounds values to the nearest clock, and will not produce notes with a duration of 0. Values of less than 100% shorten notes, values greater than 100% lengthen them.

Transpose

The Transpose command changes the pitch of all the notes in the selected region up or down. The transposition is chromatic, not diatonic; that is, all notes are transposed by the same amount. Notes can be transposed by a specified interval, or set to a single pitch. Although the former is the most common application, the latter is useful when mapping one drum machine to another (although the Re-Mapping function in the Piano Roll Editor is faster), or when you want a percussion instrument, like a kick drum, to exactly follow a bass line. (This is accomplished by copying the bass line to a new track, then transposing all the notes on that track to the note corresponding to the kick drum.)
To transpose notes in the selected region by an interval:

- Choose the "Transpose" command from the Change menu to open the Transpose dialog.

OR

- Press Ctrl+T on your computer keyboard to open the Transpose dialog.

   ![Transpose Dialog]

- Click the radio button marked "Transpose notes from" to enable interval transposition.

- Type pitch values into the two boxes to indicate the desired transposition interval. These should take the form of: pitch name, followed by "#" (if an accidental is needed), followed by octave number. Valid pitches range between C-2 and G8.

OR

- Type MIDI note numbers between 0 and 127 into the boxes to indicate the desired transposition interval.

OR
• Select the first box and play a note on your MIDI keyboard. Tab to or select the second box and play the other note on your MIDI keyboard to indicate the desired interval.

OR

• Use the scroll bar at the bottom the window to select the notes that indicate the desired interval.

• Click "OK" to transpose the notes.

The notes that you enter are not important, it is the *interval* between them that determines the transposition amount. Typing E5 in the “from” box and E6 in the “to” box produces the same transposition as typing C3 in the “from” box and C4 in the “to” box: everything in the selected region will be transposed up one octave. As the dialog always opens with “C3” in both boxes, it is generally faster to think of your transpositions relative to that note where possible.

To transpose all notes in the selected region to a single pitch:

• Choose the "Transpose" command from the Change menu to open the Transpose dialog.

• Click the radio button marked "Set all pitches to" to enable transposition to one pitch.

• In the box to the right of the "Set all pitches to" legend, enter the pitch to which you want to transpose all notes in the region, using any of the pitch entry methods described above.

• Click "OK" to transpose the notes.
Channel

This command permanently changes the MIDI channel assignments of all the data in a selected region (both notes and non-note data) to a new channel number.

• Choose the "Channel" command from the Change menu.

![Change Channel dialog box]

• Type in the channel number (1 to 16) you wish to assign to the data in the selected region. Click "OK" to rechannelize the data.

Note: Remember that the Track Sheet channel setting overrides individual event channel values. Changes made by the Channel command will not be audible unless the track is not assigned to a MIDI channel in the Track Sheet, i.e. the Chnl field reads “–”. If all you want to do is change the playback channel of all data on a track, it's much easier to change the Channel number in the Track Sheet.

Velocity

Velocity can affect a patch’s volume and/or its timbre, so changing velocity is useful for adding “punches” to a track or changing the loudness of a track or passage relative to other tracks. You can bring velocity values up or down over time to create swells, crescendos, and decrescendos. Remember that changing velocity values is not the same as changing a track’s volume, as velocity often affects timbre as well as volume.
The Velocity command offers a number of ways of changing the velocity values for all notes in a selected region: setting them to a specified value, scaling them by a percentage, causing them to ramp from one value to another, or to ramp from one scaling factor to another, or offsetting them by a fixed amount. High and low value limits can be placed on the changes created by the command, and they can be applied to note-on and/or note-off velocities.

To change velocities in a region:

- Choose the "Velocity" command from the Change menu to open the Velocity dialog.

- Click the "On Velocities" check box to assign the command to affect note-on velocities and/or the "Off Velocities" check box to affect note-off velocities. When the box is checked, the indicated velocity value is affected. Note that most synthesizers do not recognize note-off velocity, so that box can usually be left unchecked.
• Click the "Limit low values to" check box and/or the "Limit high values to" check box, and enter values between 0 and 127 in their respective numeric boxes (to their right) to place a high and/or low limit on the values the change can produce, if desired. When the box is checked, the indicated limit is enabled.

This is useful for “compressing” tracks, or changing the velocity of tracks which are being played on instruments with velocity switches (they change sounds when a certain velocity is reached), which you don’t want to trigger.

• Select and configure the method used to alter the velocity values. The available methods are described individually below.

• Click "OK" to change the velocities in the selected region.

To set all velocities in the selected region to a specific value:

• Click the radio button marked "Set all velocities to" to enable the single value option.

• Type in a number between 1 and 127 as the value to which all velocities will be set.

To scale all velocities in the selected region by a percentage:

• Click the radio button marked "Change to {#}% of current values" to enable the percentage scaling option.

• Type in a number between 1 and 999 as the percentage by which all velocities will be multiplied. 100% produces no change.

Values calculated to be greater than 127 will be set to 127, and values less than 1 will be set to 1. (A MIDI note-on command with a velocity of 0 is defined as a note-off.)
To ramp all velocity values in the region by value:

This option causes the velocity values within the region to change smoothly over the course of the region from the value specified in the "from" box to the value in the "to" box.

- Click the radio button marked "Change smoothly from {#} to {#}" to enable the value ramping option.

- Type a number between 1 and 127 into the "from" box as the velocity value that will be applied to the beginning of the region.

- Type a number between 1 and 127 into the "to" box as the velocity value that will be applied to the end of the region.

If the "from" value is less than the "to" value, the result will be a crescendo, while setting the "from" value to a greater value than the "to" value produces a decrescendo.

To ramp the scaling factor through the region:

This option is slightly trickier to understand. The velocities in the selected region are scaled by percentage, but the percentage changes smoothly from one value at the beginning of the region to another at the end. The results of this are not always obvious, but it allows you, for example, to perform a crescendo without imposing a strict note-to-note velocity increase over a region. Again, the resulting velocity values will be between 1 and 127.

- Click the radio button marked "Change smoothly from {#}% to {#}%" to enable the percentage ramping option.

- Type a number between 1 and 999 into the "from" box as the percentage by which values will be multiplied at the beginning of the region.

- Type a number between 1 and 999 into the "to" box as the percentage by which values will be multiplied at the end of the region.
To offset velocities in the selected region by a fixed amount:

- Click the radio button marked "Add {#} to all values" to enable the fixed offset option.

- Type a value between -127 and 127 into the numeric box.

Note: When changing velocity over time, the value calculated for a specific note will be based on its relative position in the selected region, not its numerical order in the region. This is best illustrated by the following example: Let’s say you select a region two beats long, and specify a velocity change over that region from 50 to 100. If the first note in the region occurs right at the beginning of the region, its velocity will be 50. However, if the first note occurs halfway through the region (one beat after it starts), its velocity will be 75. This may seem obvious, but it’s an important principle to keep in mind when selecting regions in which there are areas of no data. It applies equally to changes in continuous controllers, described in the following section.

Pitch Bend Range

Bend ranges vary among MIDI instruments. If you used a particular synth module when recording a melodic line that contains pitch bend, you may find that the bend range changes when you play the sequence back using a different module. The Pitch Bend Range feature lets you alter the bend range to suit different synth modules. This method is more simple and straightforward than using the “Pitch Bend” option in the “Change Continuous Data” dialog.

- Choose the "Pitch Bend" command from the Change menu to open the Pitch Bend dialog.

- Type in the pitch bend range of the "original" synth module in the left numeric box, and the pitch bend range of the "target" module in the right box.
• Click "OK" to change the pitch bend range.

ThinNotes

The Thin Notes command removes instances of the same notes occurring within a specified time window of each other.

To remove duplicate notes with the Thin Notes command:

• Choose the "Thin Notes" command from the Change menu to open the Thin Notes dialog.

• Type in the number of clocks within which duplicate notes should be removed.

• Click "OK" to remove the notes.
Editing Meter and Tempo

Within every Master Tracks Pro sequence is a track called the Tempo Map. The Tempo Map displays meter and beat information for every measure, and tempo information for every clock in a sequence. All of the tracks in a sequence follow the meter and tempo dictated by the Tempo Map.

You can only edit tempo changes in the Tempo Map window, but you can perform tempo, meter, and beat operations on the Tempo Map using the "Conductor" command in the Change menu. (Don’t confuse this command and its dialog with the “Conductor” command on the Info menu, which merely opens or brings forward the real-time Conductor window on the screen.)

The Conductor dialog lets you set up a complex rhythm track before any notes are recorded. Since you can change meter and beat on every bar, and tempo as often as you like, you can easily create a highly accurate click track for a rhythmically complex tune. Try using the features of the Conductor dialog to create a track with wildly varying meters and tempos and listen to it with the metronome (enable the “Click” button in the Transport window).

Note: If you use the Conductor dialog to change the Tempo Map in a region that contains locked markers, you will get a message asking you how to handle the markers. See [Chapter 5: Playback and Track Setup, "Markers"] for a discussion of this.

The Fit Time and Scale Time commands are two other powerful features for dealing with timing. Fit Time alters tempo changes as necessary to fit a selected region into a specified period of time, while Scale Time moves events in a region according to a specified ratio applied to the relative timing between them.

A Tempo Map is a sequence, even if it has no notes in it. You can save it to disk and use it as a rhythmic template for other se-
quences, and you can export it as a MIDI File for use in other programs.

Note: Master Tracks Pro calculates tempos in whole numbers of beats per minute. If you import a sequence or tempo map from another source, any fractional or decimal tempo values will be rounded off to the nearest whole number. It may also happen that when you specify a Fit Time or other operation that would result in a fractional tempo, the program will alternate between two whole-number tempos over the region to achieve the desired result.

Working with the Tempo Map

To open the Tempo Map window:

• Choose "Tempo Map" from the Windows menu.

The Tempo Map shows an editable "staircase" display of tempo changes throughout the sequence. The vertical scale shows the tempo value, while the horizontal is time, as usual. A tempo change is indicated by a "step" in the horizontal line; the edit point of the change is a little arrowhead on the line. There is a tempo setting at the beginning of every measure which can be changed, but not erased.

As the pointer is moved horizontally across the Tempo Map, the Control Bar displays meter changes where they occur in the sequence. These can be edited using the Conductor dialog, but not
in the Tempo Map window itself. You can, however, place and edit markers, as well as insert and delete tempo changes.

*Note: Cut, Copy and Paste do not work in the Tempo Map window. If you wish to copy and paste the tempo map, you must do so in the Track Editor. Do not use the Mix Data command. After pasting, you can use Strip Data to remove the data (notes, etc.) if you like, leaving only the tempo map.*

**Placing tempo changes in the Tempo Map**

- Choose the "Tempo Map" command in the Windows menu to open the Tempo Map window.

- Click on the pencil tool in the Control Bar to select it.

OR

- Press "P" on your computer keyboard to select the pencil tool.

The pointer changes to a crosshair.

- Move the pointer to the location and tempo value you want. Vertical placement determines the tempo setting. The exact value is indicated by the box in the Control Bar between the Current Position box and the Meter display box.

- Click the mouse to insert a tempo change. The staircase display will change to show the new tempo change.

If you insert a tempo change in the middle of a measure, it is only effective until the next tempo change — which will be at the next measure boundary (if not sooner). If you want to change the tempo of a sequence from a point in the middle of the sequence all the way through to the end, use the "Conductor" command from the Change menu, and set the new tempo for all of the measures in question. You can then go into the Tempo Map window and make the other tempo changes earlier, if you like.
Erasing tempo changes in the Tempo Map

- Choose the "Tempo Map" command in the Windows menu to open the Tempo Map window.

- Click on the eraser tool in the Control Bar to select it.

OR

- Press "E" on your computer keyboard to select the eraser tool.

The pointer changes to a crosshair in a circle.

- Position the pointer directly over the arrowhead of the tempo change you want to erase. The erase function is very picky about position, so zoom in if you have trouble.

- Click the mouse to erase the tempo change. The staircase display will change update.

The Conductor dialog

The Conductor dialog allows you to set the meter (time signature), tempo, and beat value for a region. It can also scale or offset existing tempos in the region, as well as create accelerandos (gradual tempo increases) and ritardandos (gradual tempo decreases) with either of two methods.

You can select a region for editing with the Conductor dialog from any window, or from within the dialog itself, the only command which allows that. Since the Conductor dialog does not require a region to be selected before choosing the command from the menu, it is always available (never "grayed out").

The Conductor dialog only operates on regions that begin and end on measure boundaries. If you select a region in an Editor which starts somewhere in measure 10 and ends somewhere in measure
13, the Conductor dialog will operate from the *beginning* of measure 10 to the *end* of measure 13. If you don’t select a region before opening the dialog, the *entire sequence* is selected. Of course, the start and end measure values can always be edited.

To open the Conductor dialog:

- Choose the "Conductor" command from the Change menu.

OR

- Click on the meter in the Conductor window.
To use the Conductor dialog:

- Select a region in the Select Range portion of the dialog if you did not select one before opening the dialog or wish to edit your selection.

- Select and configure the meter and beat values, if you wish to change them.

- Select and configure a tempo change option.

- Click the "Limit low values to" check box and/or the "Limit high values to" check box, and enter values between 1 and 300 in their respective numeric boxes (to their right) to place a high and/or low limit on the values the change can produce, if desired. When the box is checked, the indicated limit is enabled.

Note: There are upper and lower limits to the tempo values that are allowed. The values of these limits depend on the beat value. With the beat set to a quarter note, tempos can never be lower than 10 or higher than 300. Any operation that would result in a lower or higher value will result in the tempo value being set to the limit. The values scale with the beat, e.g. with the beat set to an eighth note tempos can only be between 20 and 600, sixteenth note beat limits at 40 and 1200, and so forth.

- Click "OK" to perform the specified operation(s).

The results of the Conductor dialog’s actions can be viewed directly by opening the Tempo Map window.

To select a region from within the Conductor dialog:

- Type the number of the first measure you wish selected in the box to the right of the "From measure" legend in the Select Range portion of the dialog.
- Type the number of the last measure you wish selected in the box to the right of the "to" legend in the Select Range portion of the dialog.

To set the meter (time signature) and beat for a region:

- Click in the check box to the left of the "Set Meter to" legend to enable it.

- Type the number of beats you want in a measure into the top box to the right of the "Set Meter to" legend. You may have between 1 and 16 beats in a measure.

- Type the rhythmic value you want to be counted as a beat into the bottom box to the right of the "Set Meter to" legend. This value can be 1 (whole note), 2 (half note), 4 (quarter), 8 (eighth), 16 (sixteenth), 32 (thirty-second), or 64 (sixty-fourth).

Note: Do not confuse this with the beat value set in the next step, which determines how the metronome will sound but has no musical effect nor changes the data in any way.

When you change the meter in a measure, the data in and around the measure does not move, only the barline does. If, for example, measure 10 is a 4/4 measure and you change it to 5/4, then a note previously on the downbeat of measure 11 will now be on the 5th beat of measure 10, but the sequence will not sound any different.

- Use the scroll bar to select the rhythmic value you want assigned to the metronome (beat value) in the scroll box on the right side of the dialog. This setting is reflected by the beat indicator in the Conductor window.

In a 4/4 measure, a beat value of a quarter note will cause the metronome to sound once per beat, while a beat value of an eighth note will sound twice per beat. In a 6/8 measure, a beat value of a dotted-quarter will cause the metronome to sound on every third eighth note, which is standard practice.
The beat value can be set for your convenience in recording parts. If you want the metronome in a slow 4/4 measure to go twice as fast, for example, without changing the tempo of the music, changing the beat to an eighth-note will double the metronome's rate.

**Notes on setting meter and beat values:**

- You cannot select a beat value that does not fit evenly into the time signature. For example, you cannot set a beat value of a dotted-quarter note in a 4/4 measure.

- Remember that you are setting both parameters in the selected region simultaneously. If you have a passage with changing time signatures over several measures and wish to change the beat value of those measures, attempting to do it in a single operation will result in all the measures being set to the same time signature.

- When you are changing meter and/or beat, you must have one of the tempo operations selected. If you want to change the beat or meter without making any changes in tempo, select the “Change to [X]% of current values” option (as described below) and type in “100”. A change of 100 per cent is equivalent to no change at all.

To set the tempo in a region to a specific value:

- Click the radio button marked "Set all tempos to"

- Type the tempo to which you want all measures in the region set into the numeric box to the right of the "Set all tempos to" legend. The range of permissible values for tempos is 10 to 300 bpm with the beat value set to quarter note (with the beat value at eighth note, the maximum tempo is 600 bpm, and at sixteenth note, the maximum is 1200 bpm).
To scale all tempos in the region by a specific percentage:

- Click the radio button marked "Change to [#]% of current values".
- Type a number between 1 and 999 into the numeric box in the middle of the legend.

To offset all tempos in the region by a set amount:

- Click the radio button marked "Add [#] to all values".
- Type the number you wish added to all tempos in the region. Use negative numbers for negative offsets.

To ramp all tempos in the region by value:

This option causes the tempos within the region to change smoothly over the course of the region from the tempo specified in the "from" box to the tempo in the "to" box. This option causes a tempo change to be inserted on every beat in the selected region.

- Click the radio button marked "Change smoothly from [#] to [#]" to enable the tempo ramping option.
- Type a number into the "from" box as the tempo that will be applied to the beginning of the region.
- Type a number into the "to" box as the tempo that will be applied to the end of the region.

If the "from" value is less that the "to" value, the result will be an accelerando (speeding up), while setting the "from" value to a greater value than the "to" value produces a ritardando (slowing down).
To ramp the scaling factor through the region:

This option works the same as in the Velocity dialog: the tempos in the selected region are scaled by a percentage, but the *percentage* changes smoothly from one value at the beginning of the region to another at the end. This is useful for achieving an acceleration or deceleration over a period of time in which you have already made tempo changes, and don’t want to lose them. This operation will maintain the proportionality of those tempo changes while creating an overall speedup or slowdown.

This option causes a tempo change to be inserted on every beat in the selected region.

- Click the radio button marked "Change smoothly from \{#\}% to \{#\}%" to enable the percentage ramping option.

- Type a number into the "from" box as the percentage by which the tempo at the beginning of the region will be multiplied.

- Type a number into the "to" box as the percentage by which the tempo at the end of the region will be multiplied.

*Note: With the exception of the fixed offset and fixed scaling options, tempo operations performed by the Conductor dialog will replace existing tempo changes in the selected region.*

*The "Set all tempos to" option inserts a tempo change at the start of each measure; the "Change smoothly" options insert one on each beat. If you want tempo changes to occur on places other than on a beat, you must enter them manually in the Tempo Map window.*
Fit Time

The Fit Time command lets you stretch or squeeze a given section of music so that it fits exactly into a particular amount of time. It works by proportionally scaling all the tempos in the Tempo Map for the selected region, so that the relationships between any existing tempo or meter changes in the region are preserved. This changes the overall timing, without losing the feel—accelerandos, ritards—of the music.

Unlike the Conductor dialog, Fit Time will work on a region that starts or ends anywhere within a measure, not just on measure boundaries. It will create tempo changes at the beginning and end of the region (regardless of whether they fall on a beat) as well as on any other beats it deems necessary.

*Note: If you use Fit Time to change the Tempo Map over a region that contains locked markers, you will get a message asking you how to handle the markers. See [Chapter 5: Playback and Track Setup, "Markers"] for a discussion of this.*

To fit a region to a specified period of time:

• Choose the "Fit Time" command from the Change menu. The dialog that opens shows the time of the selected region in hours, minutes, seconds, and frames.

![Fit Time dialog](image)

• Type in the length of time in which you want the region to play, entering the hours, minutes, seconds, and frames values in the appropriate boxes. Be sure that the number of frames you enter is
consistent with the frame rate (SMPTE format) selected in the Sync Setup dialog [Chapter 6: Synchronization]. Click "OK" to execute the Fit Time operation.

The Tempo Map over the selected region will be recalculated to conform to the new time. The notes themselves and the barlines stay where they were; only the Tempo Map is affected.

The “Fit Time” command works similarly to the Conductor dialog’s “Change smoothly by percent” feature: it leaves existing tempo changes in place, just changing their values proportionately to make the region play in the specified amount of time. The Fit Time command may, however, add additional tempo changes, either at the beginning of the region selected, or on beats within it.

Using the Fit Time command

Fit Time is a remarkably useful feature for film and video work. It works equally well whether you are using internal sync or MIDI Time Code. Unfortunately, the internal Tempo Map is ignored when syncing to MIDI clocks and SPP, rendering the Fit Time function ineffective.

Fit Time's effects can be subtle or gross: it can be used to advance or delay a single note or to change the timing of an entire piece. It could be considered the function that most sets apart Master Tracks Pro from a conventional tape recorder: you cannot change the timing of a musical passage on tape to fit a visual cue without altering its pitch and the sound of the orchestra, but that is precisely what Fit Time accomplishes.

You can also use Fit Time to create a blank sequence, with just Tempo Map information, in preparation for writing a film soundtrack. If you know, for example, that you want to cover a scene that lasts 14 seconds and 10 frames in four measures of music, you can select the first four measures of a blank sequence, choose Fit Time and type in 14 seconds and 10 frames, and end up with a Tempo Map containing the correct tempo for a four-
measure piece exactly 14 seconds and 10 frames long. You may never have to use a clickbook or calculator again.

Although it has many uses, Fit Time also has its limits. Don’t try to squeeze or stretch a section a ridiculous amount. Remember that only tempos between 10 and 300 quarter-notes per minute are allowed, so trying to make a two-second region last for 60 minutes will definitely not work.

Scale Time

The Scale Time feature changes the timing of events in a selected region according to a specified ratio, without changing the Tempo Map. If the ratio you specify is “1 to 2”, the start time of each event in the region is moved so that it is twice as far from the beginning of the region as it was, with the effect that the passage now plays at half speed with respect to the rest of the sequence. If the ratio is “2 to 1”, time is "compressed", and the events in the region play at double speed. A ratio of “10 to 317” slows the music by a factor of 31.7. The Tempo Map controlling the sequence, however, is not affected in any case.

You can also specify whether note durations in the region will be affected by the Scale Time operation, in addition to start times.

To scale time in a region:

• Choose the "Scale Time" command from the Change menu.

• Type any two positive integers (no zeroes or negative numbers) into the boxes by the "Scale time from" legend to specify the desired ratio. If the number in the "from" box is smaller than the one in the "to" box, time is "expanded", a larger number in the "from" box results in time "compression".

• Click in the check box marked “Scale note durations” to enable scaling of the length of each note in the region by the specified ratio, if you wish. Click "OK" to perform the scaling operation.
If you expand a region with Scale Time and there is data already in the track after the region you are expanding, the expanded data will overlap and be merged into the existing data. If you shrink a region, the end of the region will be left empty; data from subsequent measures will not be “pulled in” to fill the gap.

Unlike most other Change menu commands, the effect of Scale Time depends on the window which is active at the time the command is selected. If you select the command from the Track Editor or Event Editor, all data in the selected region is acted upon. If it is selected from the Piano Roll or Notation Editor, non-note data is affected only if the window is in “ALL” mode, otherwise only notes are affected. If Scale Time is selected while in any of the MIDI Data windows, only the data displayed is affected. Notes and other data are untouched in this case.

Scale Time is an excellent way to set up polyrhythms with existing material. If you have an eighth note melody and you want to stretch it out to dotted eighths while maintaining a constant rhythm underneath, select the melody and scale it with a ratio of 2 to 3. If you want a rhythm track to suddenly run at triple-speed for one measure, select a measures’ worth of the track, and scale it with a ratio of 3 to 1. (You’ll have to copy the resulting third of a measure and paste it twice to fill out the bar.)
The MIDI Data windows and controller editing

The Piano Roll and Notation Editors offer a number of elegant methods of editing note data, but only rudimentary abilities to edit other data, such as controllers. The MIDI Data windows provide the same elegance to entering pitch bend, continuous controllers, and velocity that the Piano Roll and Notation Editors do for notes. The Event Editor, in contrast, has somewhat less elegance, but better precision, and displays all of the MIDI data on a track simultaneously for easy comparison and editing.

The "Change Continuous" and "Thin Continuous" commands from the Change menu offer still more ways of manipulating controller data. The Change Continuous command performs much the same kinds of regional editing for controllers as Change Velocity and Change Conductor do for velocity and tempo. The Thin Continuous command has a more utilitarian purpose, providing a way to remove data you think is extraneous (or at least expendable) to lessen possible clogging of the MIDI data stream.

Non-note MIDI data can be recorded on a track in real time from a keyboard or controller, just like notes (except in Step-Time Entry, which records only note data), entered with the mouse, as in the Piano Roll Editor, or inserted with the Paste and Mix Data commands.

The MIDI Data windows

The MIDI Data windows are a graphic editing environment for gestural data, such as controllers, that are easier thought of (and edited) as shapes than as individual events, like notes. In a MIDI Data window, a gesture can be simply drawn as a shape and then edited.

The select-by-drag techniques described in [Chapter 7: Viewing & Selecting Data for Editing] work in the MIDI Data windows, the
notable difference being that the entire vertical area is selected whenever you drag in a MIDI data window.

**Note:** When you make an edit in one of the MIDI Data windows, only the type of data shown in that window is affected. For example, if you Cut two measures’ worth of pitch bend from a track, only the pitch bend data is cut. Any notes or other controllers remain intact. You also cannot move data from one type of window to another. For example, you cannot Copy a measure of pitch bend and Paste it into a channel-pressure window. You can, however, move MIDI data from one track to another. (You can also use the Continuous command, discussed below, to remap data from one type of controller to another.)

A MIDI Data window can display information as a series of vertical lines (called "skyline" mode) or a sequence of points ("point" mode).

To toggle between Skyline and Point modes:

- Press any character key (i.e. NOT Tab, Space, Backspace, etc.) on your computer keyboard to switch back and forth between modes.
Entering MIDI data in a MIDI Data window

To insert individual MIDI events or modify existing ones:

- Select the pencil tool in the Control Bar. The pointer will then become a crosshair.

- Use the Channel box in the Control Bar at the top of the window to select the MIDI channel for the new event, if the track you are working on has no channel assignment in the Track Editor.

- Move the pointer to the position in the data area where you want the data event to go. Use the time indicator in the Control Bar to locate the exact time in the track where you want to insert the event and the value indicator to position the pointer vertically to the correct value.

- Click the mouse. If you are in Skyline mode, a vertical line will appear, extending from the bottom of the window (or 0 level) to the height representing the data value. In Point mode, a single point will appear where you clicked.

To draw a controller gesture as a shape:

- Hold down the mouse button and drag the pointer to draw a curve on the data area. In Skyline mode, the graph will appear to be filled in with solid black under the curve you draw. In fact, a series of consecutive events has been inserted, each of which is individually editable.

This makes it easy to add smooth pitch bend or modulation wheel changes. You can draw a data curve in either the forwards or backwards direction. If you double back and draw over your curve, the last value entered will take precedence.

Choosing “Undo” from the Edit menu will cancel the last data insertion, whether it was an individual event or a sweep.
Changing and Erasing data

To change an event that is already part of a track:

- Insert a new event at the same point in the sequence as the one you want changed. When you do, the old event will be erased.

To erase an event:

- Click on the eraser tool in the Control Bar. The pointer will become a crosshair within a circle.

- Move the pointer directly over the event you wish to erase and click. The event line or point will disappear.

To erase a series of events:

- Drag the eraser over a series of events with the mouse button down and “wipe” them all out.

Note: The eraser does not have to be over the actual event to erase it. Putting the eraser pointer at any point on the screen and clicking the mouse will erase any event that occurs at the time indicated by the pointer’s horizontal position. Therefore, to “wipe” out a block of data, you do not have to trace over every individual event with the eraser. Merely set it at a point corresponding to the beginning of the area you want to erase, hold the mouse button, and sweep it to the end of the area you want to erase. All events during the time period you’ve swept over will be erased (You can, of course, also delete selected data with the Clear command or the Backspace key).

Data density and the Zoom Factor

The Zoom level you use in a MIDI Data window not only determines the screen resolution, but also the density of the data as it is being entered. If you enter data on a screen with 24 clocks per
pixel resolution, then you can enter only 10 events per quarter note. If you enter data on a 1 clock per pixel screen, 240 events can be entered during each quarter note.

High resolution MIDI events (particularly controllers) tend to sound more natural, but they can use up much of the MIDI stream’s available bandwidth, causing delays or “choking” if the data gets too thick. Determining the correct resolution for a particular musical purpose sometimes requires a little experimentation, but finding a good compromise is usually not difficult. (The “Thin Data” feature discussed below facilitates this.)

Note that changing the resolution of the screen will not affect data that has already been placed in the track. Data placed in a high resolution track (e.g., 2 clocks per pixel) can be edited in a lower resolution track (e.g., 12 clocks per pixel). If such editing is done with an Edit or Change menu function, the resolution of the data will not change. However, if it is done with the pencil or eraser, the new data will now have the resolution to which the current window is set.

The Windows

The MIDI Data windows are nearly identical in appearance; the Controllers window is shown below as an example. Where there are features unique to a particular window, it is noted in the window’s description.
The Pitch Bend window

Pitch bend data can take either positive or negative values. A pitch bend value of 0 indicates no bend. Therefore, the Pitch Bend window has a horizontal dotted line running through the middle of the data area marking the zero point. The area above the line represents positive pitch bend values. The area for negative values below the line is marked with a “–”. Positive values range to 127 and negative values go down to –128.

The Channel Pressure window

Channel Pressure, also known as aftertouch, affects all notes on a given MIDI channel. It has a range of 0 to 127.

The Key Pressure window

Key Pressure, also known as polyphonic aftertouch, affects individual MIDI notes. This window has an extra parameter in the Control Bar called “Pitch”, which lets you specify the note to which the key pressure event will be assigned.

To change the Key Pressure note:

• Play the note to which you wish to assign Key Pressure on your MIDI keyboard. You do not have to click anywhere.

OR

• Click on the Pitch box to open the Select Pitch dialog.

• Use the scroll bar to select the desired pitch
OR

- Type in the desired pitch value as a pitch name followed by the octave. If you are entering pitches from your computer's keyboard, accidentals can only be entered as sharps.

OR

- Type in the desired pitch value as a MIDI note number from 0 to 127.

Key Pressure has a range of 0 to 127.

The Modulation window

Modulation refers to the “Mod” wheel (or lever) found next to the Pitch Bend wheel on many synthesizers. Modulation wheel is actually MIDI Controller #1, and you can also edit or create Modulation data in the Controllers window described next. Like other controllers, it has a range of 0 to 127.

The Controllers window

The Controllers window has an extra parameter, “Ctrl Number”, in the Control Bar that lets you specify the number of the controller whose data you want to edit. Controller #1 is usually modulation wheel, #7 is usually volume, #64 is sustain pedal, and so on. You can work on the data for each controller individually. When you change the Ctrl Number setting, only the data pertaining to that numbered controller is displayed. Any editing you do, whether with the pencil and eraser or with the Edit and Change menus, will affect only the controller that is currently displayed.

To change the controller number in the Controllers window:

- Click on the Ctrl Number box to open the Select Controller Number dialog.
• Use the scroll bar to select the desired controller number.

OR

• Type in the desired controller number.

If the controller number you select has a standard assignment, the assignment will be displayed.

Consult the owner's manual of your MIDI device to see to which controllers it responds. A list of standard MIDI controller numbers appears at the end of this manual.

**The Tempo Map Window**

The Tempo Map window, discussed above, shows beat value, time signature and tempo. The tempo is represented by a horizontal line moving through the measures. Tempo changes can be inserted on any clock with the pencil pointer and erased with the eraser. Tempo changes are indicated by a small x in the tempo line. To erase a tempo change, place the eraser pointer's crosshair over the x and click. The tempo indicators on the bar lines cannot be erased, but they can be changed with the pencil pointer.
The Thin Continuous Data command

The Thin Continuous Data feature allows you to reduce the density of continuous MIDI data (pitch bend, pressure, and/or controllers), saving memory and also keeping the MIDI data stream from “choking”.

The bandwidth of MIDI is not unlimited — it allows about 1000 commands to be sent each second, and when you are using a lot of continuous data on several tracks it is quite possible to exceed that bandwidth. The result is that data gets to its destination late, and tempos slow down and speed up seemingly randomly, or notes sound out of time or even get lost completely. If continuous data is used conservatively, the chances of this happening are much reduced, and this command can help.

To thin continuous data:

- Select the "Thin Continuous Data" command from the Change menu to open the Thin Continuous Data dialog.

- Click one or more check boxes in the Select Data portion of the dialog to select the kinds of continuous data that will be affected by the operation.

- Click the check box(es) for one or both of the selection criteria in the "Erase Data with" portion of the dialog.

- Click "OK" to thin the selected data.

To thin Pitch Bend, Modulation (controller #1), Channel Pressure, or Key Pressure, simply click the appropriate check box.
To thin all controllers:

- Click the "Controllers" check box in the dialog. DO NOT click the "Only Controller #" check box.

To thin a specific controller:

- Click both the "Controllers" and "Only Controller #" check boxes and enter the number of the specific controller you want thinned.

Selection criteria for thinning

The Thin Continuous Data command offers to ways to select controller data for thinning within the selected region: by the proximity of events to each other, and by value.
The "Times closer than {#} clocks" option creates a "window" within which controller events of the specified type will be removed. Specifying 1 clock essentially changes nothing, unless two events happen to occur at the same time, in which case one of them will be eliminated. Specifying 10 clocks, however, will cause all controller events of the selected type(s) within 20 clocks (ten on either side) to be erased. This thins the density of controller data over time.

The “Values closer than {#}” value determines how the data “jumps” from one event to the next. Specifying a higher number causes the resolution of the data to become relatively coarse, and more step-like than continuous. Specifying 1 will mean only redundant data—that is, commands that occur twice in a row with the same value—will be eliminated.

The thinning operation has some “intelligence” programmed into it; it doesn’t just wipe out data blindly. In any region being thinned, the operation will always maintain the first data value, the last value, and the highest and lowest values, and if the values go up and down repeatedly, it will maintain all of the peaks and all of the lowest dips.

Generally speaking, entering lower numbers for the selection criteria will produce results that have a less audible effect on the music, which is desirable. Higher numbers have more of an effect on the data density, and will therefore help more to prevent choking, but the effect may be more audible. A certain amount of experimentation is sometimes necessary. Start with lower numbers, and if you still have problems, increase them gradually.

To set selection criteria:

• Click in the "Times closer than {#} clocks" and/or “Values closer than {#}” check boxes to enable those criteria.

• Enter the number of clocks or the desired value in the text boxes.
The Continuous command

The Continuous command in the Change menu allows you to select data from MIDI controllers (including modulation wheel), Pitch Bend, or Channel or Key Pressure (aftertouch) and modify it in the same ways as the Change Velocity and Change Conductor commands do for velocity and tempo information, respectively. You can also use this command to “map” data from one MIDI controller to another. You can remap and change data values at the same time.

Note: Operations in the Continuous window will not create controller data on a track; it will only alter data that is already there, either recorded or pencil entered. If there is no data there to begin with, these operations will have no effect. Also, as with the Velocity command, a controller’s resultant value after a Continuous “change over time” operation depends on its position within the selected region, not whether it is the first event to occur.

To change or remap continuous data in a region with the Continuous command:

- Choose "Continuous" from the Change menu to open the Change Continuous Data dialog.

- Select the type of continuous data you wish to change or remap in the "Select Data Type" portion of the dialog.

- Click the "Change Data Values" check box to enable changing of the selected data type in the region and/or the "Map Data Type To" check box to enable remapping.

- Set up the change or remapping options in the appropriate portions of the dialog.

- Click the "Limit low values to" and/or "Limit high values to" check boxes to enable limits on the values that result from the
dialog’s operations. Enter the limit values in the appropriate numeric boxes.

- Click OK to perform the change or remap operations.

Note: No operation in this box will take place unless at least one of the boxes labelled “Map Data Type To” or “Change Data Values” is checked. Selecting a radio button or entering a controller number in a box does not by itself enable an operation.

Selecting a continuous data type to modify:

- Click one of the radio buttons in the "Select Data Type" portion of the dialog to select Pitch Bend, Modulation, Key/Channel Pressure (both are affected by this choice), or "Controller #" to modify a specific controller not listed.
• If you click "Controller #", enter the number of the MIDI controller you want to modify.

**Changing controller data values**

**To set the selected data type in a region to a specific value:**

• Click the radio button marked "Set all values to"

• Type the desired value into the numeric box to the right of the "Set all values to" legend. The range of permissible values is 0 to 127, except for Pitch Bend, which can range from -128 to 127.

**To scale all values in the region by a specific percentage:**

• Click the radio button marked "Change to {#}% of current values".

• Type a number between 1 and 999 into the numeric box in the middle of the legend.

**To offset all values in the region by a set amount:**

• Click the radio button marked "Add {#} to all values".

• Type the number you wish added to all controller events in the region. Use negative numbers for negative offsets.

**To ramp all values in the region by value:**

This option causes the values within the region to change smoothly over the course of the region from the value specified in the "from" box to the value in the "to" box.

• Click the radio button marked "Change smoothly from {#} to {#}" to enable the controller data ramping option.
• Type a number into the "from" box as the value that will be applied to the beginning of the region.

• Type a number into the "to" box as the value that will be applied to the end of the region.

To ramp the scaling factor through the region:

This option works the same as in the Velocity and Change Conductor dialogs: the controller values in the selected region are scaled by a percentage, but the percentage changes smoothly from one value at the beginning of the region to another at the end. This allows you, for example, to exaggerate or make less prominent a controller move without interfering with its basic action or making it excessively smooth. It's especially useful for MIDI-controlled mixing, in which you want to achieve an overall effect over a period of time without tampering with the smaller motions within that time.

• Click the radio button marked "Change smoothly from {#}% to {#}%" to enable the percentage ramping option.

• Type a number into the "from" box as the percentage by which the value at the beginning of the region will be multiplied.

• Type a number into the "to" box as the percentage by which the value at the end of the region will be multiplied.

Mapping one controller to another

Remapping continuous data is the process of changing continuous data events of one type into another. Only the controller number or type of data is changed; the value and time of each event are unaffected.

Remapping is useful if you have a master MIDI instrument that generates one kind of controller information, and a synthesizer that responds to a different kind. For example, you may have a MIDI
wind driver that generates lots of Breath Controller data (Controller #2), and a synthesizer that doesn’t read Breath Controller, but responds to Channel Pressure. By mapping the Breath Controller data to channel pressure, you can take advantage of the wind driver’s expressive capabilities with this particular synthesizer.

- Be sure the source data type is selected, as discussed above, in the "Select Data Type" portion of the dialog.

- Click in the check box labelled “Map Data Type To” to enable remapping.

- Click on the radio button in the "Map Data Type To" portion of the dialog for the type of data you want the events mapped to. If you choose the "Controller #" option, enter the number of the specific controller to which you want the events mapped.

### The Slide Data command

Slide Data allows all MIDI data in the selected region to be moved earlier in time (left) or later (right) by a specified number of clocks.

To move data with the Slide Data command:

- Choose "Slide Data" from the Change menu to open the Slide Data dialog.

- Type the number of clocks that you wish to move the data into the numeric box.

- Click the Left radio button to move the data earlier in time, or the Right button to move it later. Click OK to move the data.
The Strip Data command

The Strip Data command in the Change menu provides a way to select some or all types of data in a selected region and cut or copy them. Data types can be selected for use one at a time or in combination. Once the data is on the Clipboard, it can be pasted anywhere in a sequence, in another sequence, or nowhere at all (if the objective was simply to remove it).

Strip Data can be configured to cut or copy Note, Pitch Bend, Modulation, Program Change, Channel Pressure, or Key Pressure data. It can also select data from a specific controller, specific channel, or a specific range of notes.

![Strip Data](image)
To cut or copy information with the Strip Data command:

- Choose the "Strip Data" command from the Change menu to open the Strip Data dialog.

- Click the "Cut" or "Copy" radio button in the "Select Operation" portion of the dialog to select a cut or copy operation.

- Click one or more of the check boxes in the "Select Options" portion of the dialog and enter appropriate values to indicate what data should be affected by the cut or copy operation. Data types with unchecked boxes will not be affected by the operation.

- Click "OK" to perform the Strip Data operation.

To strip data in a selected region only on a specific channel:

- Click the "Only on channel" check box to enable channel filtering.

- Type a channel number between 1 and 16 into the numeric box to the right of the legend.

Note: This will deal with individual data items as they were recorded. In other words, a track’s Channel assignment in the Track Editor will have no bearing on what data is affected by this command.

To strip data from all controllers in a selected region:

- Click the "Controllers" check box to enable controller filtering. DO NOT click the "Only controller #" check box.
To strip data only from a specific controller in a selected region:

- Click the "Controllers" check box to enable controller filtering.
- Click the "Only controller #" check box.
- Type the number of the controller you wish to strip into the numeric box next to the "Only controller #" legend.

To strip all note data in a selected region:

- Click the "Notes" check box to enable note filtering. DO NOT click the "Only notes between" check box.

To strip note data only within a specific range in a selected region:

- Click the "Notes" check box to enable note filtering.
- Click the "Only notes between " check box.
- Type pitch values into the two boxes to indicate the desired pitch range. These should take the form of: pitch name, followed by "#" (if an accidental is needed), followed by octave number. Valid pitches range between C-2 and G8.

OR

- Type MIDI note numbers between 0 and 127 into the boxes to indicate the desired note range.

OR

- Select the first box and play a note on your MIDI keyboard. Tab to or select the second box and play the other note on your MIDI keyboard to indicate the desired note range.
Using Strip Data

The Strip Data command has many uses. Here are just a few:

- Create keyboard “splits” by stripping different ranges of notes from a track and pasting them to other tracks.

- Remove controller information from one instrument and make it apply to a different one.

- Change a single multichannel track into a multitrack sequence by stripping the data from the single track one channel at a time, and pasting it to other tracks.

- Use it to conserve memory and keep MIDI data flow down by removing unnecessary controllers from tracks (like aftertouch recorded from a DX7).

Remember that the various items in the Strip Data dialog can be combined, so that you could, for example, only take out pitch bend on channel 4, or take out notes above middle C and sustain pedal (controller #64), leaving everything else.

Note that some of the action of the Strip Data command is duplicated in the MIDI Data windows. For example, if you want to remove pitch bend from a track, you can do it with Strip Data, or you can open the Pitch Bend window, select a region, and choose Cut or Clear.

Strip Data is especially useful when you want to work on more than one track at a time, or when you want to remove more than one type of data at a time.

The action of the Strip Data command can be further enhanced by the Change Filter [Chapter 7: Viewing & Selecting Data for Editing, "The Change Filter"].
Menus

File

New (Ctrl+N)

Opens a new sequence. The windows that appear are determined by the configuration saved in the Preferences file [Chapter 3: Basic File Operations, "Customizing the program with Preferences"].

Open (Ctrl+O)

Opens an existing file. Master Tracks Pro can read .mts (MasterTracks Sequence) or .mid (Standard MIDI File) files. [Chapter 3: Basic File Operations, "Opening an existing file"]

Close

Closes the currently active sequence. [Chapter 3: Basic File Operations, "Closing files"]

Close All

Closes all sequences. [Chapter 3: Basic File Operations, "Closing files"]
Save (Ctrl+S)

Saves the currently active sequence. [Chapter 3: Basic File Operations, "Saving files"]

Save As

Saves the currently active sequence as a new file. This file may have a different name, different location, or different file type. Master Tracks Pro can save files in .mts (MasterTracks Sequence) or .mid (Type 0 or Type 1 MIDI file) formats. [Chapter 3: Basic File Operations, "Saving files"]

Revert to saved

Discards all changes in the currently active sequence since the last save and reopens the last saved version of it.

Preferences

Saves the following to the file "prefer.mtp" in the Master Tracks Pro directory on your hard disk:

• A “snapshot” of the current positions and sizes of any open windows on the screen.

• In the Edit menu: Change Filter settings.

• In the Layout menu: Show/Hide Grid, Show/Hide Markers, and Zoom resolution.

• In the Options menu: Follow Playback and Multi Track Record.

• In the Setup menu: Remote Setup, MIDI Setup, Sync Setup, Click Setup, Chase Controllers, and Record Filter parameters.

• In the Device List: the default device.
• In the Transport window: Auto, Thru, Metronome, Count In, and Sync settings.

• In the Track Editor: the Measure Ruler numbering scheme (every third bar is numbered, or every fourth bar, etc.).

Notation Print Setup

Sets the number of measures per system in printing of the track currently shown in the Notation Editor. Also allows a two-line text header for the printout to be written. [Chapter 7: Viewing & Selecting Data for Editing, "Viewing in the Notation Editor"]

Print Notation (Ctrl+P)

Prints all or only specified measures of the track currently showing in the Notation Editor. Offers several standard printing options. [Chapter 3: Basic File Operations, "Printing from the Notation Editor"]

About Master Tracks

Brings up a screen showing the registered user and registration ID number. [Chapter 3: Basic File Operations, "About Master Tracks"]

Exit (Ctrl+E)

Quits Master Tracks Pro. [Chapter 3: Basic File Operations, "Exit"]
**Edit**

**Undo (Ctrl+Z or Alt+Backspace)**

Undoes the last record or editing operation performed. [Chapter 8: Basic Editing, "Edit Undo"]

**Cut (Ctrl+X or Shift+Delete)**

Removes the selected region or event from the track and places it on the clipboard. [Chapter 8: Basic Editing, "Basic Edit menu commands"]

**Copy (Ctrl+C or Ctrl+Insert)**

Copies the selected region or event to the clipboard without affecting the data in the track at all. [Chapter 8: Basic Editing, "Basic Edit menu commands"]

**Paste (Ctrl+V or Shift+Insert)**

Inserts the data on the clipboard at the current insertion point. Data from the clipboard will be pasted over existing data. [Chapter 8: Basic Editing, "Basic Edit menu commands"]

**Clear (Delete)**

Removes data in the selected region without affecting data on either side of the selected region. [Chapter 8: Basic Editing, "Basic Edit menu commands"]

**Mix Data**

Merges data on the clipboard with existing data starting at the current insertion point. [Chapter 8: Basic Editing, "Basic Edit menu commands"]
**Insert Measure (Insert)**

Inserts the specified number of measures starting at the current insertion point. Data after the insertion point is moved later by the number of measures inserted. [Chapter 8: Basic Editing, "Insert Measure"]

**Delete Measure (Ctrl+D)**

Deletes the specified number of measures starting at the current insertion point. Data after the deleted measures is moved earlier by the number of measures inserted. [Chapter 8: Basic Editing, "Delete Measure"]

**Select All (Ctrl+A)**

Selects all data in the active window for editing. [Chapter 7: Viewing & Selecting Data for Editing]

**Change Filter**

Opens a dialog that enables rule-based selection of data for editing. [Chapter 7: Viewing & Selecting Data for Editing, "The Change Filter"]

**Erase Clipboard**

Clears all data from the Clipboard, reclaiming memory. [Chapter 8: Basic Editing, "Erase Clipboard"]
Change

Channel

Opens a dialog allowing selected data to be assigned to a specified channel. [Chapter 9: Advanced Editing, "Using the Change menu to modify data"]

Duration

Opens a dialog allowing the duration of selected notes to be set to a specified value or scaled. [Chapter 9: Advanced Editing, "Using the Change menu to modify data"]

Velocity

Opens a dialog offering a variety of methods of altering the velocity of selected note data. [Chapter 9: Advanced Editing, "Using the Change menu to modify data"]

Continuous

Opens a dialog offering a variety of methods, similar to those offered in the Change Velocity command, for altering continuous controller, pitch bend, and aftertouch data. Also allows remapping of controller data. [Chapter 9: Advanced Editing, "The Continuous command"]

Pitch Bend

Allows redefinition of maximum pitch bend range. Used for adapting a track written while playing one synthesizer to play back correctly on a different one. [Chapter 9: Advanced Editing, "The MIDI Data windows and controller editing"]
Conductor (Ctrl+U)

Opens a dialog allowing tempo and meter to be defined in a selected region. Also offers a variety of methods, similar to those offered in the Change Velocity and Change Continuous commands, for altering tempo and meter in the sequence. [Chapter 9: Advanced Editing, "The Conductor dialog"]

Strip Data (~ or `)

Selectively cuts or copies data in the selected region. Allows definition of what types of events will be affected. [Chapter 9: Advanced Editing, "The Strip Data command"]

Thin Continuous Data

Enables reduction of the quantity and density of controller, pitch bend, or aftertouch data. [Chapter 9: Advanced Editing, "The Thin Continuous Data command"]

Thin Notes

Removes duplicate notes in the selected region occurring within a specified amount of time of each other. [Chapter 9: Advanced Editing, "Using the Change menu to modify data"]

Transpose (Ctrl+T)

Enables transposition of notes in the selected region. Also allows setting all notes in the region to be set to a single note. [Chapter 9: Advanced Editing, "Using the Change menu to modify data"]

Humanize (Ctrl+H)

Slightly randomizes data in the selected region that meets the specified parameters. [Chapter 9: Advanced Editing, "Using the Change menu to modify data"]
Quantize (Ctrl+Q)

Allows start times and/or durations of notes to be snapped to a rhythmic grid. Also allows a track to be slid earlier or later by a specified amount or to be given a "swing" feeling. [Chapter 9: Advanced Editing, "Using the Change menu to modify data"]

Slide Data

Slides all data in the selected region earlier or later by a specified amount. [Chapter 9: Advanced Editing, "The Slide Data command"]

Fit Time

Fits the selected region into a specified amount of time by scaling tempos. [Chapter 9: Advanced Editing, "Editing Meter and Tempo"]

Scale Time

Scales, by a specified ratio, the amount of time the selected region takes to play. This is accomplished by applying the ratio to the time between note starts. [Chapter 9: Advanced Editing, "Editing Meter and Tempo"]

Key Signature

Adds a key change in the Notation Editor. Only the appearance of the notation is affected; no MIDI data is changed. [Chapter 7: Viewing & Selecting Data for Editing, "Viewing in the Notation Editor"]
Windows

The commands in the Windows menu open the indicated window and make it active.

Track Editor (F1)
Notation Editor (F2)
Piano Roll Editor (F3)
Event Editor (F4)
Master Fader (F5)
Pitch Bend (F6)
Channel Pressure (F7)
Key Pressure (F8)
Modulation (F9)
Controllers (F11)
Velocity (F12)
Tempo Map
Songs

Song Play List

Allows a series of open sequences to be played in a specified order. Also allows playback of the next song in the list to be triggered by a specified event. [Chapter 5: Playback and Track Setup, "Song Play Lists and Song Sets"]

Open Song Set

Opens a Song Play List that has been previously saved to disk as a Song Set. [Chapter 5: Playback and Track Setup, "Song Play Lists and Song Sets"]

Save Song Set

Allows a Song Play List to be saved to disk as a Song Set. [Chapter 5: Playback and Track Setup, "Song Play Lists and Song Sets"]

Select open sequence

Not actually a command on the menu. The bottom of the Songs menu lists all open sequences. Selecting a sequence from this list makes it active for recording, playback, and editing. The active sequence has a check mark next to its name.
Layout

Show/Hide Grid

A toggle which makes the system of gray lines demarcating the Piano Roll Editor, MIDI Data windows, and Tempo Map window visible or invisible. [Chapter 7: Viewing & Selecting Data for Editing, "Show/Hide commands in the Layout menu”]

Show/Hide Markers

A toggle which causes markers to be visible or invisible in any Editor (except the Event Editor), MIDI Data window, or the Tempo Map. [Chapter 7: Viewing & Selecting Data for Editing, "Show/Hide commands in the Layout menu”]

Show/Hide Device Names

When device names are shown, an abbreviation of the name of the device selected for a track is appended onto the beginning of the program name in the Track Sheet. When hidden, only the program name is shown. [Chapter 7: Viewing & Selecting Data for Editing, "Show/Hide commands in the Layout menu”]

Show/Hide Velocity

In the Piano Roll Editor, Show Velocity displays the note-on velocity of each note as a vertical line, where the height of the line indicates the velocity value. Hide Velocity removes the indication. [Chapter 7: Viewing & Selecting Data for Editing, "Show/Hide commands in the Layout menu”]

Show/Hide Program Changes

Makes program change markers visible or invisible in the Piano Roll Editor. [Chapter 7: Viewing & Selecting Data for Editing, "Show/Hide commands in the Layout menu”]
**Zoom In (+)**

Causes the active window to display a more detailed view by showing less time in the same size window. The Zoom setting also effects several editing functions. [Chapter 7: Viewing & Selecting Data for Editing, "Zoom In and Zoom Out"]

**Zoom Out (-)**

Causes the active window to display a broader view with less detail by showing more time in the same size window. The Zoom setting also effects several editing functions. [Chapter 7: Viewing & Selecting Data for Editing, "Zoom In and Zoom Out"]
Options

Follow Playback

When selected (indicated by a check mark next to the command), causes the display in a graphical editing window (all Editors except the Event Editor, MIDI Data windows, and the Tempo Map) to scroll to follow playback, keeping the part of the sequence currently playing visible. [Chapter 5: Playback and Track Setup, "Playback"]

Multi Track Record

Allows recording of multichannel data onto separate tracks. [Chapter 4: Recording, "Multi Track Record"]

Key Wait

Causes Master Tracks Pro to wait after playback or record mode has been entered for any MIDI note before actually initiating record or playback. [Chapter 4: Recording, "Setting up to record"]

Punch In

Enables punch-in recording. [Chapter 4: Recording, "Punch-in"]

Auto Rewind (,)

When selected (indicated by a check mark next to the command), causes Master Tracks Pro to return to the beginning of the sequence every time recording or playback is stopped. [Chapter 4: Recording, "Setting the location to start recording"]

Click (m)

When selected (indicated by a check mark next to the command), enables a bar of countoff before recording or playback. [Chapter 4: Recording, "Setting up to record"]
Count (/)

When selected (indicated by a check mark next to the command), enables metronome click. [Chapter 4: Recording, "Setting up to record"]

Thru

When selected (indicated by a check mark next to the command), enables incoming MIDI data to be routed back out over the port and channel to which the record-enabled track or the Thru Setup dialog is set. [Chapter 4: Recording, "Setting up to record"]

PlayMCI

When selected (indicated by a check mark next to the command), enables MCI events listed in the Markers window to be played. [Appendix D: Using MCI]

MCI Close All on Stop

When selected (indicated by a check mark next to the command), causes all MCI files to be closed when playback is stopped. [Appendix D: Using MCI]
Setup

Sysex

Opens Master Tracks Pro’s System Exclusive bulk dump/load dialog. [Chapter 4: Recording, "Sysex"]

Remote

Allows specified MIDI notes to control basic transport functions and/or step entry values. [Chapter 2: Getting to Know Master Tracks Pro, "Basic Transport Functions: the Transport window and Remote Control setup"], [Chapter 8: Basic Editing, "Using Remote Control to select durations for Step Entry"]

MIDI Setup

Allows assignment of physical MIDI interfaces to Master Tracks Pro’s ports, including assigning a port for recording and a port for receiving sync.

Note: This dialog must be properly configured before Master Tracks Pro can be used. However, before the MIDI Setup window can be used, MIDI drivers for your interface must be correctly installed and configured in the Windows Drivers control panel.

There are three assignments performed in the MIDI Setup dialog: assigning physical interface ports to Master Tracks Pro’s “logical” ports for playback, designating a physical port from which to record, and designating a physical port from which to receive synchronization. In all cases, the physical ports are represented in the dialog by the software drivers that "talk" to them. (Drivers are small programs that act as "go betweens", translating to and from the generalized needs of application programs and the specific abilities of a piece of hardware, such as a MIDI interface card.)

Assigning physical ports to logical ports allows an instrument to be addressed in Master Tracks Pro in terms of a port and MIDI
Master Tracks Pro supports up to 16 ports, each of which can carry data for 16 MIDI channels, independent of the data being carried by any other port, for a total of up to 256 separate channels of MIDI data. Most commonly, only ports A and B are used, for 32-channel operation, but this limitation depends only on the MIDI interface you are using.

To open the MIDI Setup dialog:

- Choose "MIDI Setup" from the Setup menu.

To assign a physical MIDI interface port to a Master Tracks Pro logical port for playback:

- In the Select Out Port Assignments portion of the dialog, click the arrow at the right side of the text box marked "Driver Selection" for the Master Tracks Pro port you want to assign. A drop-down menu appears listing all of the installed MIDI Out drivers. This includes any drivers that have been installed for sound cards' onboard synthesizers, and the Windows MIDI Mapper, as well as interface ports.
• Click on the driver you wish to select. The menu will disappear and the selected driver will now show in the text box.

• Assign all the ports available from your interface to Master Tracks Pro ports in this fashion, then assign the receive ports as described next.

To assign a port for receiving MIDI data to record:

• In the Select In Port Assignments section of the dialog, click the arrow at the right side of the text box marked "Record Port Driver Selection". A drop-down menu appears listing all of the installed MIDI In drivers.

• Click on the driver for the interface port you wish to use for recording. The menu will disappear and the selected driver will now show in the text box.

To assign a port for receiving synchronization messages:

• In the Select In Port Assignments section of the dialog, click the arrow at the right side of the text box marked "Receive Sync Driver Selection". A drop-down menu appears listing all of the available MIDI In interface ports.

• Click on the driver for the interface port from which you will be receiving sync. The menu will disappear and the selected driver will now show in the text box.

Sync Setup

Enables selection of sync source, SMPTE format for syncing to MIDI Time Code, SMPTE Start Time (sync offset), Sync Out port, and timer resolution.

All Sync Setup functions except timer resolution are discussed in [Chapter 6: Synchronization]. Please refer to that chapter for SMPTE and sync configuration procedures.
Note: Sync source, SMPTE format (if MTC is selected as the sync source), and the MIDI Setup dialog’s Receive Sync Port must be selected before Master Tracks Pro can synchronize to an external source.

Timer resolution optimizes Master Tracks Pro’s performance to the clock speed of your computer. In general, the higher the timer resolution, the more accurate playback will be, especially at tempos greater than 125 beats per minute. However, setting the timer resolution on High or Extra Hi on a "slower" computer could overtax the processor and cause some detrimental side effects such as slower screen redraws and slower disk access. Running in Standard mode rather than Enhanced mode will help to minimize these effects. (See your Windows User’s Guide for more information about Standard and Enhanced modes of operation.) Master Tracks Pro defaults to the Medium setting. We suggest the following settings:

Pentium (all speeds): High or Extra Hi

486 (all speeds) High or Extra Hi
386-33 High or Extra Hi
386-25 High
386-20 Medium or High
386-16 Low or Medium

Click Setup

Assigns either the internal speaker or a MIDI note to be played for the metronome click. Port, channel, duration, and velocity can also be set. [Chapter 4: Recording, "Click"]
Thru Setup

Allows the selection of the port and channel over which incoming MIDI data will be "echoed" back out. Overrides the Thru setting created by the record-enabled track. [Chapter 4: Recording, "Monitoring (Keyboard Thru)"

Chase Controllers

When selected (indicated by a check mark next to the command), enables Master Tracks Pro to set controllers to their last value when starting playback in the middle of the sequence. [Chapter 5: Playback and Track Setup, "Chasing controllers"

Record Filter (Ctrl+R)

Enables selective filtering of incoming MIDI data so that only certain types of events are recorded. Also allows quantizing on record. [Chapter 4: Recording, "Filtering MIDI data and quantizing while recording (Record Filter)"

Punch Setup

Allows In and Out times to be set for punch-in recording. [Chapter 4: Recording, "Punch-In"]
Info

Memory

Brings up the Memory window showing the amount of available memory and how much memory is currently being used by the score and clipboard. [Chapter 4: Recording, "Checking available memory: the Memory window"]

Markers

Brings up the Markers window which allows viewing, creation and editing of text markers and MCI events. [Chapter 5: Playback and Track Setup, "Markers"]

Notepad

Enables Track Sheet and Marker information and text notes to be attached to the sequence. [Chapter 8: Basic Editing, "Notepad"]

MCI Status Log

Shows the status and recent history of MCI events triggered by Master Tracks Pro. [Appendix D: Using MCI]

Transport

Brings the Transport window to the front and makes it active. [Chapter 2: Getting to Know Master Tracks Pro, "Basic Transport Functions: the Transport window and Remote Control Setup"]

Conductor

Opens or brings to the front the Conductor window (NOT the Change Conductor dialog). [Chapter 2: Getting to Know Master Tracks Pro, "The Conductor window"]
BigCounter

Opens the Big Counter window. [Chapter 2: Getting to Know Master Tracks Pro, "The Big Counter"]
Windows

For overview discussions of all the windows, see [Chapter 2: Getting to Know Master Tracks Pro].

Transport

This window controls basic transport functions for Master Tracks Pro: Record, Play, Stop, Rewind, Fast Forward, Locate to Head or Tail of Sequence. It also contains the Measure Counter and Current Time Indicator, showing current position in the sequence, as well as several important function toggles: sync source, punch-in mode, click and countoff enables. [Chapter 2: Getting to Know Master Tracks Pro, "Basic Transport Functions: the Transport window and Remote Control Setup"]

Conductor

The Conductor window displays the current meter and tempo while a sequence is playing. It also enables temporary tempo changes (Offset Tempos) to be made, and, by clicking on the meter display, offers access to the Change Conductor dialog. [Chapter 2: Getting to Know Master Tracks Pro, "The Conductor window"]

Track Editor

The left side of the Track Editor, called the "Track Sheet" contains setup parameters for each of Master Tracks Pro’s 64 tracks: track number (also used to rearrange track order in the window), play-enable, record-enable, solo, loop, track name, output MIDI channel, initial program change (accesses Device dialog), initial/automation controller number, initial controller value/recordable fader. Just above the Track Sheet is a display showing the current value of the Master Fader ("Master Volume=#\% ").
The right side of the Track Editor, called the "Song Editor" displays the contents of each track as a line of blocks, each block representing one measure. A filled block indicates there is MIDI data in that measure, an empty block indicates there is none. Regions of measures across one or more tracks can be selected for recording, playback, and edited, and markers can be placed and edited.

**Notation Editor**

The Notation Editor displays the note events contained in one track as music notation. Data can be recorded in real time for a keyboard or other MIDI controller, entered in step-time, or using the mouse. Notes can be selected and edited in detail; non-note data can be edited only in a very basic way. Notation shown in the window can be printed out. Markers can be placed and edited. A Control Bar at the top of the window provides access to the basic editing modes and track and channel settings.

**Piano Roll Editor**

The Piano Roll Editor displays the note events contained in one track in a graphical representation resembling a punched-hole piano roll, where each "hole" represents a note. The capabilities and techniques used in the Piano Roll Editor are mostly identical to those used in the Notation Editor, with the exceptions that the Piano Roll Editor includes the ability to place program changes in the same fashion as markers, and the ability to specify an Articulation value for each note.

**Event Editor**

The Event Editor displays all MIDI events in a chronological list format. This format obviously does not offer graphical editing, but it allows all data (note and non-note events) to be viewed and edited with equal ease and precision. It is also possible to filter the types of events shown and, consequently, affected by an edit.
operation. Events can be inserted and deleted, and regions of events can be selected and edited.

**MIDI Data windows**

There are six MIDI Data windows: Pitch Bend, Channel Pressure, Key Pressure, Modulation, Controllers, and Velocity. Each of these functions nearly identically and offers graphical editing of a single type of non-note data. The Controllers window can be set to display and edit any MIDI Continuous Controller.

Individual events can be inserted, deleted, and edited, but, even more powerfully, controller gestures can be drawn and edited as shapes using the mouse. [Chapter 9: Advanced Editing, "MIDI Data windows and controller editing"]

**Tempo Map**

The Tempo Map is virtually the same as another MIDI Data window, except that it shows and edits tempo changes in the sequence, rather than any gestural information. Tempo changes can be edited in the Tempo Map or altered by the Change Conductor or Fit Time commands. [Chapter 9: Advanced Editing, "Editing Meter and Tempo"]
## Appendix A: Keyboard Shortcuts

### Transport controls

<table>
<thead>
<tr>
<th>Action</th>
<th>Keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start/Stop</td>
<td>Spacebar</td>
</tr>
<tr>
<td>Record</td>
<td>Enter key</td>
</tr>
<tr>
<td>Scroll to previous measure</td>
<td>Left arrow</td>
</tr>
<tr>
<td>Scroll to next measure</td>
<td>Right arrow</td>
</tr>
<tr>
<td>Go to Beginning of sequence</td>
<td>Home</td>
</tr>
<tr>
<td>Go to End of sequence</td>
<td>End</td>
</tr>
<tr>
<td>Goto dialog (locate)</td>
<td>Period (.)</td>
</tr>
<tr>
<td>Next Marker</td>
<td>Tab</td>
</tr>
<tr>
<td>Previous Marker</td>
<td>Shift+Tab</td>
</tr>
</tbody>
</table>

### File menu

<table>
<thead>
<tr>
<th>Action</th>
<th>Keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>New</td>
<td>Control+N</td>
</tr>
<tr>
<td>Open</td>
<td>Control+O</td>
</tr>
<tr>
<td>Save</td>
<td>Control+S</td>
</tr>
<tr>
<td>Print Notation</td>
<td>Control+P</td>
</tr>
<tr>
<td>Exit</td>
<td>Control+E</td>
</tr>
</tbody>
</table>

### Edit menu

<table>
<thead>
<tr>
<th>Action</th>
<th>Keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>Undo/Redo</td>
<td>Alt+BkSpace or Control+Z</td>
</tr>
<tr>
<td>Cut</td>
<td>Shift+Delete or Control+X</td>
</tr>
<tr>
<td>Copy</td>
<td>Control+Insert or Control+C</td>
</tr>
<tr>
<td>Paste</td>
<td>Shift+Insert or Control+V</td>
</tr>
<tr>
<td>Clear</td>
<td>Delete</td>
</tr>
<tr>
<td>Mix Data</td>
<td>Control+M</td>
</tr>
<tr>
<td>Insert Measure</td>
<td>Insert</td>
</tr>
<tr>
<td>Delete Measure</td>
<td>Control+D</td>
</tr>
<tr>
<td>Select All</td>
<td>Control+A</td>
</tr>
</tbody>
</table>

### Change Menu

<table>
<thead>
<tr>
<th>Action</th>
<th>Keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>Conductor dialog</td>
<td>Control+U</td>
</tr>
<tr>
<td>Strip Data</td>
<td>~ or ‘</td>
</tr>
<tr>
<td>Transpose</td>
<td>Control+T</td>
</tr>
<tr>
<td>Humanize</td>
<td>Control+H</td>
</tr>
<tr>
<td>Quantize</td>
<td>Control+Q</td>
</tr>
</tbody>
</table>

### Windows Menu

<table>
<thead>
<tr>
<th>Action</th>
<th>Keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>Track Editor</td>
<td>F1</td>
</tr>
<tr>
<td>Notation Editor</td>
<td>F2</td>
</tr>
<tr>
<td>Piano Roll Editor</td>
<td>F3</td>
</tr>
<tr>
<td>Event Editor</td>
<td>F4</td>
</tr>
<tr>
<td>Master Fader</td>
<td>F5</td>
</tr>
<tr>
<td>Pitch Bend</td>
<td>F6</td>
</tr>
<tr>
<td>Channel Pressure</td>
<td>F7</td>
</tr>
<tr>
<td>Key Pressure</td>
<td>F8</td>
</tr>
<tr>
<td>Modulation</td>
<td>F9</td>
</tr>
<tr>
<td>Controllers</td>
<td>F11</td>
</tr>
<tr>
<td>Program Change</td>
<td>F12</td>
</tr>
<tr>
<td>Close active window</td>
<td>Alt+F4</td>
</tr>
</tbody>
</table>

### Layout menu

<table>
<thead>
<tr>
<th>Action</th>
<th>Keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>Zoom In</td>
<td>+</td>
</tr>
<tr>
<td>Zoom Out</td>
<td>-</td>
</tr>
</tbody>
</table>

### Options menu

<table>
<thead>
<tr>
<th>Action</th>
<th>Keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>Auto Rewind</td>
<td>comma (,)</td>
</tr>
<tr>
<td>Click</td>
<td>m</td>
</tr>
<tr>
<td>Count</td>
<td>backslash (/)</td>
</tr>
</tbody>
</table>
Setup menu

Record Filter .................. Control+R

Piano Roll and Notation Editors and MIDI Data windows

Arrow pointer .................. A
Eraser pointer .................. E
Pencil pointer .................. P
Next Marker .................... Tab
Previous Marker .............. Shift+Tab
Duration ....................... 1 thru 7
                         and D (for dotted)
Rest ........................... R
Step Entry ........................ K
Track Number .................. T
Delete Last Note .............. Backspace
Controller Number ........... C
                         (Controllers window only)

In the MIDI Data windows, any other letter, number, or punctuation key will toggle the Data windows between “skyline” display mode and “point” display mode.

The following key combinations can be used to toggle the listed Track Sheet functions on and off while the Piano Roll or Notation Editor is the active window. These commands only affect the track that is currently being displayed in the Piano Roll or Notation Editor.

Play .......................... Shift+P
Record .......................... Shift+R
Solo .......................... Shift+S
Loop .......................... Shift+L
Appendix B: Standard MIDI Controllers

The MIDI Specification allows for 128 different Continuous Controllers, numbered from 0 to 127. Although theoretically any of these Controllers can be used for any musical purposes, instrument and software manufacturers have agreed that some of them are to be considered reserved for certain specific functions. The list of these functions appears below. Any Controller numbers not listed are not assigned specific functions.

Controller #1: Modulation Wheel
Controller #2: Breath Controller
Controller #4: Foot Controller
Controller #5: Portamento Time
Controller #6: Data Entry Slider
Controller #7: Volume
Controller #8: Balance
Controller #10: Pan
Controller #11: Expression
Controller #64: Damper Pedal (Sustain)
Controller #65: Portamento
Controller #66: Sostenuto (Middle Pedal)
Controller #67: Soft Pedal
Controller #69: Hold
Controller #91: Effects Depth
Controller #92: Tremolo Depth
Controller #93: Chorus Depth
Controller #94: Celeste (Detune) Depth
Controller #95: Phaser Depth
Controller #96: Data Increment
Controller #97: Data Decrement
Controller #122: Local Control (Off=0, On=127)
Controller #123: All Notes Off
Controller #124: Omni Mode Off
Controller #125: Omni Mode On
Controller #126: Mono Mode On
Controller #127: Poly Mode On
Appendix C: Passing Filenames on the Command Line

Master Tracks Pro allows you to pass a data filename to the program (for example, WIN PRO4 BACH.MTS). The file is then loaded automatically when the program runs. If the file has the .MID extension, it is assumed to be a standard MIDI file and is therefore imported as such when the program runs.

This feature also allows you to create custom Program Items (“icons”) in the Program Manager that contain the filenames of songs that you work with often (choose “New” from the File menu). Then all you have to do is double-click on the icon to run the program and load the data file.

The following options can be used with a filename that appears on the command line.

/P ....... Play: Start playing the file immediately after loading

/E ....... Exit: Exit the program automatically when playback is done.

/N ...... Non-Active: Run the application in the non-active state as an icon running in the background.

/O ...... Output Only: When the application is started with this option, all attempts to open a MIDI In port will be ignored and MIDI In will not function. This option is useful to avoid warning messages on systems that have no MIDI In port.
Appendix D: Using MCI

MCI stands for Media Control Interface. MCI is Microsoft’s standard protocol for controlling various multimedia devices with Windows 3.1. Current MCI drivers allow for the control and playback of the following media types: .WAV audio (all formats), CD (Red Book) audio, MIDI sequences, Pioneer laser disk players, and MacroMind Director, Autodesk Animator, or Gold Disk Animation Works animation. Support will also be available for AVI and DVI digital video and additional drivers will eventually be available from Microsoft and third party developers.

Master Tracks Pro and MCI

Master Tracks Pro uses “command-strings” to communicate with the MCI system. Command-strings are text-based messages that contain simple commands like open, play, and close from the MCI command set. The commands and various modifiers (like paths and devices) are assembled into command-strings which can be sent directly to the MCI system for execution. Let’s say, for example, you record the song “Old MacDonald” complete with a .WAV audio vocal. When you play the sequence you send a command-string to the MCI system to open the .WAV audio file so it can be played:

open C:\PRO6\OLMCDONL.WAV

You would then send subsequent command-strings to play, stop, and close the file. If you don’t have access to documentation on the MCI command set, the MCI Help file is included on the disk with Master Tracks Pro.

Adding MCI Commands to Your Sequence

You add command-strings to a Master Tracks Pro sequence in one of two ways: by placing a marker in the Track or Step Editor windows or by adding a marker to the marker list.

When you place a marker in the Track or Step Editor, the Enter Text dialog appears so you can either name the marker or add an MCI event in that location. There is a button in the dialog that reads “Add MCI Event”. Click on this button and the Add MCI Commands dialog appears.
You can also access the Add MCI Commands dialog from the Markers window. Choose Markers from the Info menu and then click on the Add MCI button when the Markers window appears.

The Add MCI Commands dialog lists the most commonly used commands for playing and recording. It also displays the location in your sequence where the MCI command will be added. You can either type directly into the box at the bottom of the dialog or use the various radio buttons, check boxes, and combo boxes to assemble a command-string. All the options that represent MCI commands verbatim begin with lowercase letters. Clicking a command’s radio button causes that command to be entered automatically in the text box at the bottom of the dialog. For example, to duplicate the command shown above:

- Click the radio button labelled “open” under Commands For Playing. The word “open” appears in the text box at the bottom of the dialog.

- Click the Filename check box under File/Device Reference.

- Click Browse. Use the dialog that appears to locate the file you want to open. Highlight the file and click Open. The path and filename now appear in the Filename and command-string text boxes.
• Click the Alias check box. Enter an alias in the Alias combo box. It appears in the command-string. Aliases are important because each command-string is limited to 96 characters. After you assign an alias to a filename, you use the alias in subsequent commands and, therefore, use fewer characters. The Alias combo box remembers the last 16 aliases you used and displays them on its drop-down list.

• Click Add Event to place that command at the location displayed under Time. You can add several events without exiting the dialog. The Add Controls box tallies the number of events you add.

The Add MCI Commands dialog is provided as a shortcut and as an aid to help you assemble MCI command-strings. It is by no means foolproof. You still need to familiarize yourself with proper MCI command syntax and you must ensure that the commands are sent in the right order. The MCI Help file should be able to help answer any questions you might have about MCI and its implementation.

About .WAV Audio

Waveform (.WAV) audio is the standard digital audio file format defined by Microsoft for Windows 3.1 and the Multimedia Extensions. You may be unfamiliar with the technical aspects of digital audio, but if you have a CD player or a computer game with recorded sound effects you’re familiar with what it sounds like. .WAV audio files are created with the help of special hardware that samples and then digitizes analog, “real-world” sounds. This hardware could be an inexpensive sound card with digital audio capabilities or a dedicated audio card designed for high quality audio. With a microphone or other input device, these audio cards sample the input signal at a regular, periodic rate. Each of these samples is then described in numeric terms. This is called digitizing. The circuitry that digitizes the audio is called an Analog-to-Digital Converter (ADC). Once a sample has been digitized, it can be stored in your computer’s memory or on a hard disk.

Okay, so you’ve turned your best tortured blues-howl into a series of numbers sure to bring a tear to the big, ever-staring eye of your computer. How do you get them back out in a form the rest of us can appreciate? Your audio card has another circuit on it called a Digital-to-Analog Converter (DAC). The DAC spits the numbers back out at the same rate they were sampled at and, in the process, turns them back into analog signals. These signals can then be amplified through your stereo or other monitoring system.
There are 12 formats of .WAV audio. The different formats are determined by a combination of three parameters:

- **Word size**: 8-bit or 16-bit
- **Sample rate**: 11.025 kHz, 22.05 kHz, or 44.1 kHz
- **Number of channels**: mono or stereo

If you’ve heard the digital audio produced by both computer games and a CD player, you may have noticed a discernible difference in the quality of the audio. That’s because most computer games use 8-bit mono sound sampled at a rate of either 11.025 kHz or 22.05 kHz. (1 kilohertz [kHz] is equal to a rate of 1000 times per second.) CD’s, on the other hand, use stereo, 16-bit samples played at a rate of 44.1 kHz. Generally speaking:

greater word size+higher sample rate=better audio quality

There is a trade-off, though. 16-bit, 44.1 kHz, stereo audio uses up memory a lot faster than 8-bit, 11.025 kHz, mono audio. Experiment with the different formats to see which one best suits your needs.

Your choice of an audio card may limit your choice of formats. A low-end card may only sample in 8-bit mono format with a maximum sample rate of 22.05 kHz. On the other hand, a pro-level card may be able to digitize audio at CD-quality. The quality and number of ADC’s and DAC’s can also affect the sound quality. In general, 1 DAC per output is better than 1 DAC for 2 (stereo) outputs. Some audio cards also include a high quality Digital Signal Processing chip, such as the Motorola 56000, to speed up processing.

Your choice of an audio card should be determined by the output quality you need and by the resources at your disposal (i.e., what can you afford?). A vocal or voice-over recorded with 8-bit resolution at 22.05 kHz may be perfectly adequate for demos or presentations. Use a decent microphone and a compressor or limiter (to minimize clipping distortion), add a little reverb, and it will sound even better.
Recording a .WAV Audio File

To record .WAV audio you’ve got to have a microphone (for vocals and acoustic sounds), hardware for digitizing the audio, the appropriate driver installed for recording and playing digital audio, and sufficient hard disk space for the recorded data. Many sound cards, such as Creative Labs’ Sound Blaster Pro™ and Media Vision’s Pro AudioSpectrum™ are capable of recording and playing digital audio.

About Sync

Before you begin recording, there are a few things you should know about Master Tracks Pro and .WAV audio. When you record a .WAV audio file from within Master Tracks Pro you should be sure you’re completely satisfied with your sequence. Your sequence and .WAV audio are not synced in the technical sense. That is, audio playback is started at a specific point in the sequence but there is no shared time reference between the audio and MIDI data. Therefore, if you change your sequence after recording the audio, the illusion of sync may be lost. In other words, you might have to re-record the audio. You should also make sure that your window configuration is essentially the same, or at least similar, for recording and playback. The Transport window counters, Follow Playback, and anything else that causes all or part of the screen to be redrawn or updated has an effect on the “sync”. Whether or not the Windows screen saver is on also seems to have an effect on the timing. (This is probably true for other screen savers, too.) It is also important that playback occurs using the same hardware that you recorded the audio with. If you want to distribute copies of your sequence and the accompanying .WAV audio it’s probably easiest to record it to a 2 track audio tape for distribution.

Now that you’ve been cautioned, it should be said that you can get very good results from adding .WAV audio to your sequences. If you take care and heed the precautions above, the “sync” can be surprisingly good. It’s great for making quick sketches and demos if you don’t have access to a multi-track recorder.

We have used a couple of different methods for recording .WAV audio with a Master Tracks Pro sequence. These are by no means the definitive methods. You need to experiment and find out what works best for you and your hardware.

The first method involves recording your .WAV audio in a single pass. In other words
you’ll have one large file that plays back with your sequence. The second method uses multiple, smaller files that are recorded to specific sections of your sequence. The MCI commands you use for either method are virtually identical. The second method simply repeats the commands using multiple filenames (and aliases).

This illustration shows the Markers window with all of the MCI commands necessary to record a single .WAV audio file.

open new type waveaudio alias eieio

This command-string opens a new file, assigns a file/device type (waveaudio), and gives the new file an alias (eieio). The Microsoft .WAV audio driver defaults to 8-bit resolution with an 11.025 kHz sample rate. You can change the resolution (word size) and sample rate using the MCI set command. See the MCI Help file for more information.

record eieio

When the MCI system receives this command recording begins.

stop eieio

This command stops recording.

save eieio C:\PRO6\OLMCDONL.WAV
This command saves the file to a specific volume (drive C) and directory (PRO6), and gives it a filename (OLMCDONL.WAV).

close eieio

This command closes your new .WAV file. Master Tracks Pro can send a close command automatically if you stop in the middle of recording (i.e., before the stop and close commands are sent). Simply choose MCI Close All On Stop in the Layout menu so a check mark appears next to it.

You monitor the success or failure of your MCI commands with the MCI Status Log. Open the log from the Info menu. The Log will tell you whether or not your commands were successfully executed. You can open the Log before playing a sequence and monitor its progress, or open it afterwards and check the results. If the Log returns an error, it will usually give you some clue as to what went wrong.

To test a MCI command repeatedly, open the Markers window, click on the command to highlight it, and click the Send MCI Now button. If the MCI Status Log is open, you can check the result. If you get an error message, keep changing the command until you get the desired response. If you click Add MCI while a command is highlighted in the Markers window, the Add MCI Command dialog will open with that location already entered in the Time fields. You can “mute” an MCI command by clicking on its marker type in the Marker window. That changes the type from MCI to TEXT. Click on it again to change it back to MCI. If you don’t want to send any MCI commands, choose Play MCI from the Layout menu to remove the check mark and disable Master Tracks Pro’s communication with the MCI system.

To move a command-string, change its location in the Markers window or drag its marker in the Track or Step Editor window. MCI markers are displayed in blue and TEXT markers are displayed in red.
Playing a .WAV Audio File

This illustration shows the Marker window with the commands needed to play a single .WAV audio file from Master Tracks Pro.

```
open C:\PRO6\OLMCDONL.WAV alias eieio
```

This command-string specifies the path and filename of the desired .WAV audio file, assigns it an alias (eieio), and opens it.

cue eieio output

The cue command loads the first part of the .WAV file into memory. This enables .WAV audio playback to start immediately when the play command is sent.*

```
play eieio
```

This command begins playback of the .WAV audio file.

```
stop eieio
```

This command stops playback of the .WAV audio file. If you don’t send a stop command, the file will play to its end and then stop automatically.
close eieio

This command closes the .WAV audio file. If you stop playback before the stop and close commands are issued, Master Tracks Pro will close the file automatically if MCI Close All On Stop is enabled in the Layout menu.

We have used two different methods for creating a sequence file to play .WAV audio. The first is to record the audio and then replace the record commands with the play commands. In theory, you should be able to replace the record command with the play command and get playback to start in sync. In reality, you may have to tweak the start time. Another method you can use involves creating two separate sequence files: a record file and a playback file. That way, if you decide you want to re-record the audio you can simply open the record sequence and record the audio again. Then use "Save As" and change the MCI commands to create a new playback file (you can then remove the MCI save command).

The methods for recording and playback outlined in this document are merely suggestions. Use them as a jumping off point for developing the methods that work best for you. You may not need quite so much control over the output, especially with other (non-.WAV audio) types of media. You could, for example, leave out the cue and stop commands in the preceding example. A more extreme short cut allows you to use a single play command:

```
play C:\PRO6\OLMCDONL.WAV
```

In this case, the file is automatically opened before playback and is closed when playback is complete.

*At the time of this writing, the cue command is not yet recognized by the .WAV audio MCI driver. What this means is that the first time you play your sequence all the way through, the audio will start late because of the load time from the hard disk. On subsequent plays, the audio should have a consistent start time.

We have had some success with sending the open and play commands followed almost immediately by a pause command to cue the digital audio. Then a resume command is sent to begin playback of the audio. This may provide more accurate control over the
playback start time. However, the distance (beats, clock ticks, whatever) between the MCI command markers seems to have some effect on when the audio begins playing. If you use this method, you’ll have to experiment with different marker locations to get things to sync up.

We are hopeful that the cue command will be implemented in future versions of the .WAV audio MCI driver.